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Introduction 

 

The radio frequency spectrum is a natural resource that is available equally in every country.  

However, it is a resource limited by technology and management capability.  In addition to 

radiocommunication systems that use the spectrum as a function of geographical location and 

time, there are also non-communication uses such as ISM (Industrial, Scientific and Medical) 

equipments. Electromagnetic waves provide a wireless interface to facilitate communication in 

variety of terrestrial and space radio services, including aeronautical, maritime, space, radio 

navigation, broadcasting, cellular mobile, microwave systems. As the number of implemented 

radiocommunication networks increases, the congestion of radio spectrum usage grows 

accordingly. Without some form of management, the transmission of radio signals in the same 

frequency bands, time and geographical locations by independent networks is certain to increase 

the probability of interference. Interference-free operation of multi-channel frequency-agile 

networks cannot be envisaged without an intelligent spectrum management system. Even 

diversification provided by an intelligent spectrum management system in an advanced 

radiocommunication network will offer only a limited capability to guarantee transmission 

quality. In the case of long-range communications in international airspace and waters, such as 

aeronautical and maritime communications, spectrum management is a much more sensitive and 

complicated task compared to the short-range applications. Coordination of spectrum utilization 

by terrestrial stations around national borders is another spectrum management task which needs 

special care. Harmonized decisions on usage of frequency bands with neighbouring countries are 

necessary to increase the efficiency of spectrum utilization and speed up the frequency 

coordination process.  From the market perspective, economic delivery of radiocommunication 

services and international roaming requirements cannot be achieved except by harmonized 

utilization of spectrum. A massive loss of national resources and also delay in the introduction of 

popular telecommunication services in the national market may occur by having different 

national regulations or uses for internationally harmonized bands. In such cases, urgent action to 

harmonize national regulations and spectrum use with the global situation would encourage the 

growth of the telecommunication industry in the country concerned. 

At the international level, the International Telecommunication Union (ITU), as a special agency 

of the United Nations (UN), assists global harmonization of relevant telecommunication 

activities, including spectrum management. At the national level, member administrations are 

responsible for coordinating their telecommunications activities with each other directly or 

through the ITU to develop international telecommunication regulations that satisfy national 

interests as well as meeting the requirements of international trends. 

Nowadays, efficient administration of the increasing number of spectrum users is possible only 

by using advanced administrative-technical tools. By means of an automated spectrum 

management system (ASMS), the responsible authorities may perform a variety of EMC 

calculations, handle different scheduled administrative procedures and store the records of all 

national spectrum users in an electronic data base. Some of the capabilities of an ASMS include: 

issuing licenses, notification of frequency assignments to the Radiocommunication Bureau (BR), 

providing periodic reports, interference resolution, supporting coordination with other 

administrations, charging frequency usage, etc. Moreover, an advanced ASMS facility may be 

connected to remote monitoring stations to perform monitoring missions and identify 

unauthorized spectrum utilization as well as quickly resolving cases of harmful interference. 
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The ITU’s Radiocommunication (ITU-R) and the Telecommunication Development (ITU-D) 

Sectors developed, jointly, the BASMS and WinBASMS computer software programs to support 

national spectrum management. These programs, released in 1995 and 1997 respectively, are in 

accordance with the requirements specified in an ITU-R Recommendation (ITU-R SM.1048). 

The Spectrum Management System for Developing Countries (SMS4DC), the next generation of 

WinBASMS, provides increased functionality for the spectrum management activities of 

developing countries. This manual is intended to describe the key characteristics and 

functionalities of the SMS4DC software. 

Chapters 1 and 2 with Annex 1 give useful information about the overall specifications and 

installation and customization of the software. Chapters 3 and 4 provide detailed information 

about the user interface of the software and about the functions of the menu and toolbar items. 

Chapters 5 and 6 contain a step-by-step description of the main procedures of the SMS4DC 

software. 
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Chapter 1. SMS4DC Software Specification 
 

 

1.1. Background 

The purpose of the SMS4DC software is to provide Developing Countries with a tool to 

efficiently and effectively manage the radio spectrum, primarily for broadcasting, fixed and land 

mobile radio services and therefore to accelerate the development of wireless technology in these 

countries. 

The first spectrum management software developed by ITU-R and ITU-D, the Basic Automated 

Spectrum Management System (BASMS), was released in 1995. It used the FoxPro language and 

operated on a MS-DOS platform. The later (1997) Windows version (WinBASMS) offered three 

languages (English, French and Spanish (Russian is also available on special request)) and was 

available, free of charge, to developing countries. WinBASMS was designed for ease of use and 

maintenance by a single user and supported most functional requirements defined in the ITU 

Handbook on National Spectrum Management. WinBASMS was installed and training courses 

given in several administrations through the ITU/BDT technical assistance missions on frequency 

management and radiocommunication development. Now, WinBASMS is outdated and, due to 

several limitations in its utilization, is no longer recommended. The limitations that have been 

identified include the following features or functions that are not provided: 

• Simplified implementation of propagation models, particularly those given by 

recommendation ITU-R P.1546; 

• Simplified calculation procedures within the interference calculation process and the 

frequency assignment process; 

• Inclusion of information from monitoring or a spectrum monitoring database; 

• Provision of a multiple user networking capability; 

• Inclusion of a digital terrain database and associated operational programs; 

• Security features; 

In 2002, Radiocommunication Study Group 1 approved Recommendation ITU-R 1604 

“Guidelines for an upgraded spectrum management system for developing countries” calling for 

improvements/upgrades to WinBASMS to meet the further needs of developing countries. 

Accordingly, a voluntary group of experts met on several occasions with the objective to draft 

specifications for this upgrade.  

Documents prepared for Resolution 9 of the World Telecommunication Development Conference 

(WTDC), Istanbul, Turkey 18- 27 March 2002 and WTDC-98, included general objectives of an 

upgraded version of WinBASMS. Recommendation ITU-R 1604 contains these objectives and 

are reflected in this report. 

The responsibility for assisting, monitoring and reporting on the progress of this aspect of the 

programme was given to the ITU-R and ITU-D joint group dealing with WTDC-02 Resolution 9.  

Within the framework of this group, a detailed technical specification was prepared which covers 

the objectives of an Enhanced Basic System and the essential requirements of an advanced 

system. The consolidated technical specification was presented to the BDT at the end of 2004 for 

implementation. Based on these finalized technical specifications, new software, named 

“Spectrum Management System for Developing Countries” (SMS4DC) was developed and 

released. 
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1.2. Objectives of SMS4DC software 

The need to upgrade the existing WinBASMS was addressed in ITU-R Recommendations 

SM.1370-1 and SM.1604. The general objectives for the system are given in the World 

Telecommunication Development Conference, Istanbul, Turkey 18-27 March 2002 and WTDC-

98 Resolution 9 documents and include: 

1) The establishment of a computerized operational structure that enables the smooth 

execution of administrative tasks, frequency allocation, spectrum analysis and 

monitoring, 

2) A single user capability, 

3) Improved dynamic engineering modules, 

4) Extensive training from the ITU to identify the technical requirements, operational 

procedures and human resource requirements, 

According to the guidelines defined in the various documents mentioned above, the key features 

of the Upgraded WinBASMS software for spectrum management include: 

– Administrative function. This function is implemented on a relational database 

management system that ensures the integrity and consistency of the administrative 

data. It provides user screens that perform all administrative tasks including: 

frequency application records, frequency assignment records, licensing records, 

interference records, frequency measurement records and spectrum fee records. For 

the time being, the program is available in the English language. In due course, it 

will be extended to the French, Spanish and Russian languages. 

– Engineering analysis function. This function provides enhanced analysis tools for 

processing proposed frequency assignments requested by applicants. It also 

provides the capability to calculate interference between one or more transmitters 

and a victim receiver under specified conditions.  

Moreover, the group of experts that developed WinBASMS and gave training in its use identified 

over thirty software modifications that were required in the WinBASMS program in order to 

improve the functioning of the software in the new upgrade. In addition to these, many other 

modifications came from suggestions from over fifty developing countries that attended the eight 

WinBASMS seminars held by the BDT. In particular, four modifications were recommended that 

would improve: 

– Propagation loss prediction for interference problems; 

– Improvement of engineering calculation capability; 

– The addition of an antenna database from an antenna manufacturer. 

 

A standard three dimensional geographical world-map (GLOBE-DEM recommended) should be 

integrated and used for any applicable technical calculation. The area- and line-calculation results 

should be displayed on a map. More features are explained in the next Section. 
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1.3. Features of SMS4DC software 

Taking into account the detailed specification required by the ITU, the following features have 

been implemented in the SMS4DC software: 

I. Utilities and Administrative features 

a) geographical map based utilization of Administrative functions, 

b) use of a relational database management system, 

c) generation of the electronic notices T01, T02, TB1, TB2, TB3, TB4, TB5, T11, 

T12, T13, T14, G11, G12, G13, G14, GA1, GB1, GS1, GS2, GT1, GT2 and G02 

d) BR IFIC database import interface, 

e) security features to access the database, including auditing and six-level security 

which enables a system administrator to define users with different access levels 

and which logs actions performed in a log-file, 

f) recording frequency applications, frequency plans, frequency assignments and 

allotments, licensing information, technical details, interference and frequency 

fees, 

g) identifying the priority and necessity of data items required for registration of 

stations in an electronic data base, 

h) consideration of regional and international frequency allocations tables in 

frequency assignment, 

i) consideration of (national) frequency plans designed for each frequency band in 

frequency assignment, 

j) multi-user capability of software utilization in a local area network, 

k) user-friendly data entry masks with on-line data validation mechanisms, where 

applicable, 

l) local and global administrative-technical data base, 

m) capability to show selected stations on map, to search for a station in a map and to 

zoom in/out and to scroll maps,  

n) inclusion of an electronic library of antenna patterns and equipment specifications 

necessary to perform technical calculations. Antenna patterns may be customized 

and two/three-dimensional demonstration of radiation diagram is provided. 

o) electronic library of frequency plans, 

p) electronic data base for microwave links, 

q) spectrum fee data base and capability to provide customized fee calculation 

model, 

r) capability to integrate customized formats for reports and licenses, 

s) capability to switch the user language interface into the English, French and 

Spanish languages, 

t) ability to track coordination requests or responses to received coordination 

requests, 

u) ability to export the calculation results of SMS4DC to GoogleEarth™ 

v) ability to communicate bidirectionally with ARGUS monitoring software 

developed by R&S company 
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w) ability to communicate bidirectionally with ESMERALDA monitoring software 

developed by Thales company 

x) ability to export data as Comma Separated Values files 

 

II. Technical features: 

a) implementation of ITU-R propagation models P.1546, P.1812, P.529, P.530, 

P.370, P.525 as well as other relevant ITU-R recommendations such as P.452, 

P.453, P.526, P.527, P.676, P.836, P.837, P.838 and P.841 for various types of 

implemented radio services, 

b) implementation of GE84, GE89, GE06 and ST61 regional plans and 

bilateral/multilateral agreements on international frequency coordination data 

exchange for different services, 

c) utilization of a three dimensional digital terrain map (GLOBE-DEM with 30 

seconds resolution) in propagation model implementation, 

d) utilization of clutter maps available in IDWM (coasts, seas, oceans, super 

refractivity regions, ground conductivity and etc) in the implementation of 

relevant propagation models, 

e) capability to integrate three dimensional digital terrain maps with other, better, 

resolutions, 

f) capability to integrate raster maps and vector maps, 

g) frequency coordination calculations and integration of IDWM routines, 

h) on-line display of mouse pointer geographical coordinates and active area-variable 

such as height, field strength value etc. 

i) field-strength calculations using different propagation models within a selected 

area (coverage area), along a profile, along a polygon, at given points and 

generation of contours. The calculation results can be overlaid on a background 

map. 

j) calculation of network coverage and the best server, 

k) interference calculation around the selected terrestrial transmitters and victim 

receivers, 

l) interference calculation between Geostationary satellite Earth stations and 

microwave stations, 

m) interference analysis for assigning frequencies to stations in given locations using 

relevant ITU-R recommendations, protection ratios and PSD (Power Spectral 

Density) masks of emissions, 

n) possibility to track and customize the issue of licenses for frequency utilization, 

o) determination of affected countries for conducting international coordination, 

 

The source code of SMS4DC software and other accompanied technical modules such as IDWM 

is the protected property of ITU under copyright law.  
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1.4. Structure of SMS4DC software 

The SMS4DC software, working under the Microsoft Windows operating system, has been 

developed as a single package using visual C++6.0 language and, as depicted in Figure 1.1, 

consists of a core, shell and external parts. The following Sections give a brief explanation of 

each part of the structure. 

 

1.4.1. Core of SMS4DC software 

The SMS4DC core provides a user-friendly machine interface and supplies all the tools necessary 

to perform or administrate the required technical and administrative tasks of SMS4DC software. 

The administrative and technical procedures of SMS4DC software are so designed to be 

independent, except when sharing the same shell elements such as using the database, map or 

external facilities. Therefore, the core part of the software has been enabled to employ the ITU-

developed and authorized modules, IDWM and RR App.7, to generate internationally reliable 

technical results. Moreover, importing of records from Terrestrial BR IFIC and Space BR IFIC 

databases is possible using the administrative module.  

 

Figure 1.1. Structure of SMS4DC software 
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external resources and databases. Several vector maps have been extracted from the latest ITU 

Digitized World Map (IDWM) module together with GLOBE DEM, and integrated into the 

software as a raster map, as required by the BDT specification for SMS4DC. Further 

External Database 

External Resources 

and Applications 

SMS4DC software 

Interface to the external resources 

 

IDWM 

BR IFICs 

RR App.7 

Technical & 
Administrative 

Modules 

Interface to the external databases 

 

L
IB

R
A

R
IE

S
 

M
A

P
S

 

Internal Database 

Monitoring Systems 



 
13 

specifications of the integrated geographical map features are available in Section 1.5 and the 

IDWM reference manual. 

Several libraries are integrated within the SMS4DC software and these may be expanded with 

additional information by users as part of their routine operational work. For example, regional 

and national frequency allocation tables, antenna patterns, frequency plans and spectral masks of 

emissions may be stored for software internal usage or as reference data for station establishment 

and frequency assignment. 

 

1.5. Geographical information systems of SMS4DC software 

One of the key requirements of SMS4DC software is the ability to use various types of maps for 

administrative tasks and technical calculations. Accordingly, SMS4DC software enables both 

vector and raster map facilities within the different technical and administrative modules to be 

available to any user, regardless of the user’s access level. The following Sections describe this 

feature. 

 

1.5.1. Vector maps 

The SMS4DC software employs the latest ITU Digitized World Map (IDWM) for provision of 

following vector maps: 

- political border lines, 

- coastal lines as defined in ITU-R Recommendation P.452, 

- ITU radiocommunication regions, 

- ST61 geographical areas, 

- GE84 geographical areas, 

- GE89 geographical areas, 

- GE06 geographical areas, 

Vector maps are available for use by the relevant technical modules and can be displayed 

individually or all together on the world map by choosing them as menu items in the “Option” 

popup menu. Moreover, the results of some technical calculations, such as field strength and 

coordination contours, can be saved and overlaid on topographical maps. Colour and line 

thickness of vector poly-lines are adjustable. By moving the mouse cursor over the SMS4DC 

desktop, information such as country name, ITU Region, country code, geographical coordinates 

and administration code are displayed on the status bar. The format of vector maps is explained in 

Annex 2. 

 

1.5.2. Raster maps 

The SMS4DC software uses a digital elevation model (DEM), named GLOBE (Global Land 

One-kilometre Base Elevation). The GLOBE DEM is a global data set covering from 180 degrees 

west to 180 degrees east in longitude and from 90 degrees north to 90 degrees south in latitude. 

The resolution is 30 arc-seconds (0.008333... degrees) in latitude and longitude, resulting in 

dimensions of 21,600 rows and 43,200 columns. At the Equator, a degree of latitude is about 111 

kilometres. GLOBE has 120 values per degree, giving GLOBE slightly better resolution than 1 

km at the Equator, and progressively finer resolution toward the Poles. The supported projection 

systems are Lambert and UTM and the datum should be World Geodetic System 84 (WGS84). 

The value of each pixel represents elevation in metres above Mean Sea Level. The elevation 
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values range from -407 to 8,752 metres on land. In GLOBE Version 1.0, ocean areas have been 

masked as "no data" and have been assigned a value of -500. 

Due to the nature of the raster structure of this DEM, small islands in the ocean smaller than 

approximately 1 square kilometre (specifically, those that are not characterized by at least one 

30" grid cell and/or do not have coastlines digitized into IDWM) may not be represented. The 

projection parameters are as follows: 
 

        Projection  Geographic (latitude/longitude) 

        Datum   WGS84 

        Zunits   Metres above mean sea level 

        Hunits   30 arc-seconds of latitude and longitude 

        Spheroid  WGS84 

        Xshift   0.0000000000 

        Yshift   0.0000000000 

 Cell Referencing  Each cell is nominally bound by 30" intervals of 

latitude and longitude, beginning with any whole 

degree (e.g. 0.0000 degrees) 

        Parameters  NONE other than those above 

 

The WGS84 cylindrical projection of Earth with constant angular accuracy provides values with 

varying metric accuracy with respect to latitude in such a way that the most accurate values occur 

in the Polar Regions. Figure 1.2 demonstrates a regular cylindrical or normal aspect orientation in 

which the cylinder is tangent to the Earth along the Equator and the projection is calculated 

horizontally from the axis. 

 

Figure 1.2. Projection method in WGS84 mapping format 

 

 

 

 

 

 

 

 

 

The metric accuracy of DEM along meridians (all latitudes) and Equator is 926.62 m if the earth 

radius is taken to be 6371 km. 

Due to performance enhancement of the application, the original big tiles of GLOBE-DEM are 

cut into smaller tiles which are only applicable by this application and are provided in the 

package of the system.  

For efficient manipulation of terrain digital map in SMS4DC, the big tiles of GLOBE DEM were 

cut into 72×36 tiles, each tile in a matrix of 600×600 points in a binary file (600×600×2 Bytes), 

to prevent unnecessary loading of whole map to computer memory. The numbering method of 

tiles is displayed in Figure 1.3.  
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Figure 1.3. Numbering method of GLOBE map tiles 

 

 

 

 

 

 

 

 

 

 

 

All files are stored in one directory. The reference characteristics of tile groups, such as: directory 

of tile files, number of tiles, coordination of lower-left corner of first tile, map resolution, 

machine format, are stored in a text file, named “GLOBE.TXT”. This file is located in the 

TEXTS sub-directory of the SMS4DC working directory. Integration of other map data in the 

system requires assistance by developers but does not need the application to be re-compiled or 

re-developed. For the time being, in order to introduce other raster maps, users are able to change 

the content of this text file, except for the projection systems which are Lambert and UTM and 

the Datum, which is now WGS84. 

Four adjacent 600×600 DEM tiles are loaded and displayed by selecting a rectangular area using 

relevant push button on the toolbar in vector-map view. Users are able to navigate along DEM in 

two levels. At the first level, navigation along four loaded tiles is possible by horizontal and 

vertical scrollbars. At the higher level, users can pan through tiles toward the North, South, West 

and East directions using relevant push buttons in the toolbar of the DEM view of the desktop. 

Geographical coordinates and interpolated height of the mouse location are displayed on the 

status bar. More map based features of SMS4DC software are described in Chapter 3. 

 

1.6. Database structure of SMS4DC 

The administrative and technical database of SMS4DC software is constructed under the 

Microsoft Access platform in a relational structure to give enhanced manipulation of 

administrative and technical data of stations, as well as for easy importing of data from the ITU-

BR IFIC database (terrestrial and space stations). The hierarchical relationship between 

administrative database elements is implemented using eight administrative levels. The ITU-BR 

IFIC database can be imported into the administrative database. An item in “Database” menu 

provides an interface to set-up various options for importing data from the ITU-BR IFIC 

database. Figure 1.4 displays the relationships explained above. 
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Figure 1.4. Relationship between different database of SMS4DC software and external databases 

 

 

 

 

 

 

 

Each table of the administrative database has fields of an identical nature, i.e. tables of effective 

antenna heights and emission masks. The database structure of the SMS4DC software is 

displayed in Figure 1.5. Each box in Figure 1.5 denotes a table with several data fields.  

The technical database of SMS4DC is not actually a standalone and separate hierarchal database. 

Technical information, together with all other information (administrative, etc), is kept in one 

database but separated by various logical mechanisms, which makes it possible to access 

technical information from the calculation modules. Also, the administrative module is able to 

examine details of standalone stations (that have been created in the technical module) by 

accessing the Anonymous Stations record category displayed in the “tree view” of the 

Administrative window. 
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Figure 1.5. Structure of administrative database for terrestrial and earth stations and also allotments 
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1.7. Reference materials from ITU and used in the development of SMS4DC 

The SMS4DC software incorporates: approved versions of ITU recommendations (mostly ITU-

R), BR circular letters, ITU Radio Regulations, regional agreements, spectrum management 

handbook. These are the latest versions at the time of the SMS4DC development. Also, ITU 

technical modules and WinBASMS software have been studied and incorporated in accordance 

with the SMS4DC objectives and framework. The propagation models, administrative 

procedures, electronic notices, SMS4DC software structure, database structure and GUI 

(Graphical User Interface) of SMS4DC are consistent with this reference material. Furthermore, 

the results of all technical calculations have been verified individually by comparison with 

several sample results. A list of all references is given in Annex 2. 
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Chapter 2. Program installation guide 
 

 

2.1. System requirement 

SMS4DC requires approximately 100 Megabytes of space on the hard drive. This amount of 

storage is necessary for the application and the main database only and does not include map 

files. The space required for map files depends on the size and resolution of maps. For example, a 

digital terrain model (DEM) for the whole world with the resolution of 1km needs about 1.5 GB 

of disk space. Operation of SMS4DC requires a USB hard-lock “dongle”. 

In summary, SMS4DC requires a computer system with the following specifications: 

 

Minimum Recommended 

 Pentium III processor with 1 GHz clock 

speed; 

 256 Megabytes Random Access Memory 

(RAM); 

 Hard Disk Drive with a minimum of  2 

Gigabytes free available for installation in 

case of single-user setup; or 200 MB in 

case of setup on network, 

 CD Drive; 

 SVGA Colour Monitor capable of 1024 x 

768 pixel resolution; 

 Colour Inkjet or Laser printer; 

 Graphics adapter with OpenGL support; 

 

 Pentium IV processor with 3 GHz clock 

speed or more; 

 1 Gigabytes Random Access Memory 

(RAM); 

 Hard Disk Drive with a minimum of  10 

Gigabytes free available for installation;  

 DVD Drive; 

 SVGA Colour Monitor capable of 1024 x 

768 pixel resolution; 

 Colour Inkjet or Laser printer; 

 Graphics adapter with OpenGL support; 

 

 

The minimum hardware requirements listed above assume operation under Windows 2000. The 

use of a more resource-consuming version requires a more capable hardware platform, especially 

with respect to the processor and the amount of RAM (e.g. suitable operation under Windows XP 

will be best achieved with a Pentium IV-based PC with a least 2 Gbytes of RAM). SMS4DC has 

been developed and tested for operation on systems with the following configurations: 

 Microsoft Windows Operating system Windows 2000 (SP4), Windows XP (SP2), 

Windows Vista for single-user setup or for workstation in case of setup on network; 

 Windows 2000 server edition or Windows XP server for operation on a network 

server; 

 Microsoft Office 2000, 2002 and 2007 

 Adobe Acrobat PDF reader version 8 

 Google Earth 
 

Note: The DPI settings for the Windows screen should be set to normal size (96 dpi). 
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2.2. Setup 

The SMS4DC software installation is distributed on a CD. This auto-run CD contains the 

SMS4DC package, integrated world digital map, user manuals and ITU IDWM. ITU BR IFIC 

DVD must be installed in advance to enable users to import the internationally registered data of 

assigned frequencies, necessary for frequency coordination tasks. Two types of installation are 

possible: 

 Setup for a multiple-client network 

 Setup for a single-user  

No system restart will be necessary after installation of SMS4DC package. 

 

2.2.1. Setup for a multiple-client network 

In the case of installing SMS4DC for a multiple-client network, the digital map tiles and database 

of SMS4DC can be stored on a server for common use of clients. Therefore clients connected to 

the server will be able to read digital maps and update the common database. Consequently, only 

the SMS4DC software core need be installed on the client PCs. The set-up instructions are as 

follows: 

 

Part A: Digital map and database installation on server 
 

I. Insert the SMS4DC CD in the CD-drive of the server PC. The SMS4DC CD is auto-

run, therefore Windows installShield wizard will launch automatically. Choose the 

installation language from the list of available languages that are displayed (Fig. 

2.1(a)). The InstallShield wizard will check the server PC’s operating system (Fig. 

2.1(b)).  

 

Figure 2.1. SMS4DC software InstallShield Wizard, a) language selection, b) Check the system requirements, 

c) License agreement, d) User information, e) Option to choose type of installation and (f) Custom setup 

 

 

 

 

   (a) Language selection  

 

 
 

 

                

 

            (c) License agreement 

 

    (b) Check the system requirements 
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(d) User information   (e) Option to choose type of installation 

 

 

 

 

 

 

 

 

 

 

 

(f) Custom setup 

II. Accept the license agreement (Fig. 2.1(c)) 

III. Enter the “Customer” information (Fig. 2.1(d)). 

IV. Choose the option Custom for the type of installation (Fig. 2.1(e)).  

V. In the features list of the Custom setup menu (Figure 2.1f), uncheck the first and last 

features (“Spectrum_Management_System” and “Lock”. “Databases” and “Digital 

Map” should remain checked so that the Digital Maps (2,592 files) and Databases will 

be transferred to the folders “…\BDT_Soft\SMS4DC\Globe” and 

“…\BDT_Soft\SMS4DC\DB” respectively. Click “Next” and InstallShield wizard 

will begin installation. 

VI. When the InstallShield wizard has completed installation, use Windows Explorer to 

share the folders: “…\BDT_Soft\SMS4DC\Globe” as “Read Only” and 

“…\BDT_Soft\SMS4DC\DB” as “Full Access”. 

 

Part B: SMS4DC installation on client PCs or Laptops 

 

I. Insert the SMS4DC CD in the CD-drive of the client PC. The SMS4DC CD is auto-

run, therefore Windows installShield wizard will launch automatically. Follow steps I 

to III of Part A above, but on the client PC. 
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II. On the Custom setup menu (Fig. 2.1(f)) uncheck only the feature “Digital Maps” on 

the list of features. This will install all folders of SMS4DC package, except the 

Digital Maps (2,592 files). Click “Next” and InstallShield wizard will complete the 

installation. 

III. When the InstallShield wizard has completed installation, use Windows Explorer to 

map a network drive to the folder containing the digital map files (on server). To do 

this, go to the Explorer menu item: “Tools\Map Network Drive… ” and find the 

shared \\Server\Globe folder (Figure 2.2a) 

IV. Use Windows Explorer to map a network drive to the folder containing database files 

(on server). For this purpose, go to the Explorer menu item: “Tools\Map Network 

Drive… ”  and find the shared \\Server\DB folder (Figure 2.2b) 

V. Use Windows Notepad to open the file “…\BDT_Soft\SMS4DC\Texts\Globe.txt” 

and put the mapped drive name of digital maps in front of the word “FilesPath ” e.g. 

“FilesPath  Z:\” then save the file. 

Figure 2.2. Mapping a network drive to shared folders on server 

 

 

 

 

 

 

 

 

 

 
 

(a) Mapping network drive Z: to \\Server\Globe   (b) Mapping network drive Y: to \\Server\DB 

 

VI. Use Windows Data Source Administrator to select and identify the SMS4DC 

database files. The Data Source Administrator can be found under menu “Control 

Panel\Administrative Tools\Data Source (ODBC)” (Figure 2.3(a)). Under the 

“System DSN” tab, select data source “SMS New” (name of the database file) from 

the list. Click the “Configure” button for the ODBC Microsoft Access Setup menu 

(Figure 2.3b).  Click “Select” and choose from the list the network drive which has 

been already mapped to the shared \\Server\DB folder (i.e. Y: in example of 

Figure 2.3(b)). Click on OKs to finish. 

VII. Repeat the procedure above but this time to select the data source “SRS-Notice”. 

  

file://///Server/Globe
file://///Server/DB
file://///Server/Globe
file://///Server/Globe
file://///Server/DB
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Figure 2.3. ODBC configuration a) DNS Tab of data source administrator and b) configuration menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(a) DSN Tab of Data Source Administrator           b) Configuration menu 

 

 

2.2.2. Single – user Setup 

All the elements of the SMS4DC package have to be created in the same workstation in the case 

of installing SMS4DC on a stand-alone PC. The instructions for the set-up procedure are: 

I. Insert the SMS4DC CD in the CD-drive of the stand-alone PC. The SMS4DC CD is 

auto-run, therefore Windows installShield wizard will launch automatically. Choose 

the installation language from the list of available languages that are displayed. The 

InstallShield wizard will check the stand-alone PC’s operating system. 

II. Accept the license agreement and enter the user information. Go to the next page. 

III. Choose the option Complete for the type of installation and allow the InstallShield 

wizard to complete the installation. 

 

2.3. USB Hard lock setup 

The USB hard lock driver program is normally installed automatically during the main SMS4DC 

installation. The dongle should be plugged in to an active USB port of the computer ONLY after 

the installation is finished. The Windows operating system will detect the USB hard lock as a 

new hardware, find the hard lock driver and finalize the installation. 
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2.4. Directory structure of SMS4DC 

The directory structure of the SMS4DC software in the case of a single-user setup is illustrated in 

Figure 2.4.  

 

Figure 2.4. Directory structure of SMS4DC software in case of single-user setup 

 
 

As shown above, the following folders are created during software installation: 

 BDT soft: The main folder, 

 SMS4DC: Main folder of SMS4DC software, 

 Antenna: Antenna definition files, 

 Backup: The folder containing the backup of database, 

 Bin: DLLs and executable files of SMS4DC, 

 DB: Database files which could be copied to the server, 

 Globe: DEM files, 

 Help: User manual, 

 Image_map: Background map of vector view, 

 Reports: Output report files, 

 Temp: A folder for temporary files, 

 Texts: Reference text files and HTML templates 

 

2.5. Security 

The database of SMS4DC is accessible only through the software, as the database file cannot be 

accessed directly and only authorised users may access the database through the software. 

Moreover, as described in Section 3.2., hierarchical levels of access may be setup by the system 

supervisor for each user of the system, appropriate to their designated tasks in using the 

application. Within the software applications, only users who are authorized by the supervisor or 

senior operator can edit the database. 

 

2.6. Local database migration 

The database of the SMS4DC package operates under the Microsoft Access format, which is 

compatible with the database of all other ITU software applications. Importing frequency 
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assignment records from any existing national database (database migration) may be desirable in 

order to facilitate the fast and easy preparation of SMS4DC for frequency assignment work. After 

an evaluation of the existing situation in the field, one of the following migration methods may 

be considered the most convenient and time-efficient: 

 Assistance of the SMS4DC development team to design an electronic data migration 

interface to transfer any existing electronic database to the SMS4DC database. Each case 

will require an individual interface to be designed to reformat and map fields of the 

existing electronic database to the target database while verifying logical relationships. 

This approach will make possible the transfer of numerous records and will require 

automatic generation of a log file to list all successfully transferred records together with 

a report of all failed transfers and their reasons for failure. 

 Manual migration of existing electronic/administrative data. For those cases where an 

existing database contains a relatively small number of records (i.e. less than ten thousand 

records), it is preferable to enter all data manually over a period of time. 

2.7. Customization of administrative functions 

With the support of the SMS4DC experts, the licenses, invoice and receipt templates of the 

administrative part of package can be adapted or designed to meet local needs; although, as far as 

possible, this should be included as part of the advance preparation tasks. 
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Chapter 3. Menus and Toolbars of SMS4DC 
 

 

 

 

3.1. Program start 

The shortcut icon of the SMS4DC software will be displayed on the Windows Desktop and 

SMS4DC program entry will be available in the list of Windows Programs if the software has 

been installed correctly in accordance with the instructions given in Chapter 2. The program is 

started by clicking on the SMS4DC shortcut icon on the Windows Desktop. The title screen is 

then presented, if the authorized hard-lock is discovered at a USB port; otherwise, an error 

message will be displayed to warn that the hard-lock is missing. Figure 3.1 displays the title 

screen. 

 

Figure 3.1. Title screen of SMS4DC software 

 

 

In order to access the system for any task, users must enter their User Name (User-ID) and 

Password assigned to them by the system supervisor. These Passwords and User-ID may have a 

maximum of twenty alpha-numeric characters and are case-sensitive. At the first execution of the 

SMS4DC software, the default User-ID and Password have been set to “SMS4DC”. The 

supervisor User-ID has been reserved for the system supervisor but the corresponding Password 

can be changed. The system supervisor has privileges to access the complete database and to use 

any features of software but the privileges of other uses will be defined by the system supervisor. 

The next Section explains the access levels which may be authorized by the system supervisor to 

other users. A valid User Name and Password will activate the OK push button. The software has 
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been currently developed in the English and French languages. The SMS4DC main menu is 

displayed by pushing the OK button. 

 

3.2. Definition of User-ID and Password 

Spectrum management involves several different tasks, requiring different types of expertise with 

different levels of responsibility. Therefore, each user is granted permission to access only those 

SMS4DC features and parts of the database relevant to his/her tasks and responsibilities. The 

following access levels have been implemented in the SMS4DC software: 

i. Data entry (Licensing and Billing): Privileged to read/write licensing and billing 

databases, 

ii. Engineers: Privileged to read/write the technical database, 

iii. Senior operator: Privileged to modify reference tables, 

iv. Supervisor: Privileged to read/write all the database, as well as to manage User-IDs 

and passwords, reference tables and to configure and use any features of the software, 

v. Licensing: Privileged to read/write the database of reference information (such as 

equipment specification, antenna pattern, frequency plans, etc.) and to only read other 

databases, 

vi. Read-only: Privileged to use software but with no permission to edit any database, 

Only the system supervisor, as administrator, is allowed to define and cancel User-ID and 

Password for other users through “Database–>Users” item. Figure 3.2 displays the menu of User-

ID and Password management. 

 

Figure 3.2. Menu of User-ID and Password management 

 
 

The Supervisor has the option to create a new account or modify an existing account by selecting 

either the “New” or “Modify” buttons respectively according to the following: 

 Create new account: By choosing the “New” box, the “Modify” box will turn gray. The 

Supervisor is able to define a new, case sensitive, User Name and Password (visible), 

maximum 20 characters. A blank password is not permitted. One of six access levels must 

then be selected for the new account from the relevant combo box. The newly created 

account will be enabled by default when the “Save” button is clicked; there is no need to 

activate “Enabled” check box. Duplicate User Names are not allowed. 
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 Modify an existing account: By choosing the “Modify” box, the “New” box will turn 

gray. The Supervisor is able to browse existing User Names from the User Name combo 

box and to see the corresponding access level. User Names cannot be changed. No 

password will be displayed for the selected User Name and the relevant edit box will stay 

blank. The old password will be kept intact if nothing is entered in the password edit box. 

For the purpose of keeping an audit-trail (history) of all performed actions, the Supervisor 

cannot delete the full history of any user, only disable existing accounts. Disabled 

accounts can be recovered for the same user simply by clicking the “Enabled” check box. 

Pushing the “Save” button is necessary to apply any new setting. 

 Delete an account: Users without any history of actions can be deleted by the Supervisor 

clicking the “Delete” push button. 

To enable the SMS4DC software to be operated immediately after installation, the default setting 

for both User-ID and Password is: SMS4DC. 

  

3.3. IDWM map view 

The ITU Digitized World Map (IDWM) is used to draw political boundaries of countries on the 

desktop of SMS4DC. The coastal lines and boundaries of the three Radiocommunication Regions 

are overlaid on the World vector map by default to facilitate users in the selection of smaller 

areas for further investigation. Figure 3.3 shows the desktop of SMS4DC software displaying 

political border lines and the ITU Regions, similar to the picture in No.5.2 of the Radio 

Regulations. 

 

Figure 3.3. Interactive desktop of SMS4DC software  

(Political borderlines in black, coastlines in red and ITU-R Radio Regions in white colour) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When the mouse cursor is moved across this window, the status bar will display: country names 

with corresponding code, region name (such as ATA for Antarctica), geographical coordinates, 

radiocommunication region, administration code and type of coastal area. In addition the time is 

shown on the right side of the status bar. 
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3.3.1. Option menu of IDWM map view 

The following items are provided in the “Option” menu: 

 Background map: Figure 3.4 shows this picture. 

 

Figure 3.4. Topographical coloured picture of the World as a background to the IDWM map and also a plain 

coloured view 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Background Colour: This item sets the background colour of the vector map. Blue is 

selected as the default background colour. 

 Fill Countries: This item displays each country with different or contrasting colour within 

its borderlines, as shown in Figure 3.4.  

 Political Borderline & Line Style: These items switch on/off the vector map of countries 

extracted from IDWM and change the line styles. As shown in Figure 3.3, this vector map 

is loaded to the desktop by default. If switched on, a check mark will appear to the left of 

this item in the Option menu window. 

 Coastlines & Line Style: This item switches on/off Polygons along coasts of open water 

and Caspian Sea extracted from IDWM and changes the line style as shown in Figure 3.4 

in red. If switched on, a check mark will appear to the left of this item in the Option menu 

window. 
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 Islands and Line Style: This item switches on/off Polygons of islands extracted from 

IDWM and changes the line style. Figure 3.5 shows islands displayed. If switched on, a 

check mark will appear to the left of this item in the Option menu window. 

 

Figure 3.5. Vector of islands extracted from IDWM (yellow lines) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Lakes and Line Style: This item switches on/off Polygons of lakes extracted from IDWM 

and changes the line style. Figure 3.6 shows lakes displayed. If switched on, a check mark 

will appear to the left of this item in the Option menu window. 

 

Figure 3.6. Vector of lakes extracted from IDWM (red lines) 
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 ITU-R Regions & line Style: These items switch on/off Poly lines of ITU 

Radiocommunication Regions extracted from IDWM and change the line style. Figure 3.3 

shows these Regions displayed in white. If switched on, a check mark will appear to the 

left of this item in the Option menu window. ITU-R Regions are displayed on the World 

vector map by default. 

 Coastal Zones and line Style: This item switches on/off vectors of coastal zones (as 

defined in ITU-R recommendation P.452 and extracted from IDWM) and changes the line 

style. Figure 3.7 shows the coastal zones displayed. If switched on, a check mark will 

appear to the left of this item in the Option menu window. The coastal zone code of 

mouse location is displayed at the rightmost location of status bar. 

 

Figure 3.7. Vector of coastal zones extracted from IDWM 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 Propagation Zones and line Style: This item provides sub-items to switch on/off vectors 

of different propagation zones (as defined in ST61, GE84, GE89 and GE2006 Regional 

Plans and extracted from the IDWM) and change the line style.  Figure 3.8 shows 

propagation zones displayed. If switched on, a check mark will appear to the left of this 

item in the Option menu window. The propagation zone code at the position of the mouse 

cursor is displayed at the rightmost location of the status bar. 
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 Figure 3.8. Vector of Propagation Zones defined in regional plans a) ST61, b) GE84, c) GE89 and d) GE2006 

 

 

 

 

 

 

 

 

a) ST61       b) GE84 

 

 

 

 

 

 

 

 

c) GE89       d) GE2006 

 
 

3.3.1.1. RR Appendix 7 item in Option menu 

This item calculates and draws coordination contours around a selected Earth station in 

accordance with the method explained in Radio Regulation Appendix 7, using the Ap.7/ITU-R 

SM.1448 ITU-R technical tool. The following sub-items are provided: 

 Earth Station Selection: This item selects a group of frequencies for the process of 

coordination contour calculation. If this item is selected, the dialogue box of “Earth 

Station Selection” opens. As shown in Figure 3.9a, this dialogue box provides a 

hierarchical tree-view of beam groups, starting from the country concerned, which 

enables users to select a single beam as well as all beams of all Earth stations of a country 

by a left-click of the mouse. The relevant characteristics of the selection will be copied to 

the edit boxes in the dialogue box.  

As shown in Figure 3.9b, the “Option” button allows the user to customize the default 

values of the following parameters used for contour calculation: 

BDIRPC (%): Percentage of time to be used in the calculation of the bi-directional 

coordination area for a transmitting earth station (optional). The default 

values are taken from Table 3 of Recommendation ITU-R SM.1448 or Table 

9 of Appendix 7 (WRC-2000). The value related to analogue emissions is 

chosen as default when both options, digital and analogue, are given in the 
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table.  A value of BDIRPC in the input data will override the default for all 

bi-directional contours applicable. 

TRANPC (%): Percentage of time to be used in the calculation of the coordination 

area for a transmitting earth station (optional). 

The default values are taken from Table 1 of Recommendation ITU-R 

SM.1448 or Table 7 of Appendix 7 (WRC-2000). The value related to 

analogue emissions is chosen as default when both options, digital and 

analogue, are given in the table.  A value of TRANPC in the input data will 

override the default. 

RECVPC (%): Percentage of time to be used in the calculation of the coordination 

area for a receiving earth station (optional). The default values are taken from 

Table 2 of Recommendation ITU-R SM.1448 or Table 8 of Appendix 7 

(WRC-2000). The value related to analogue emissions is chosen as default 

when both options, digital and analogue, are given in the table.  A value of 

RECVPC in the input data will override the default. 

SATEAST (deg): Eastern extreme (deg) of the operational portion of the orbital 

arc. Only to be given when space stations on a portion of the geostationary 

orbital arc are to be considered. 

SATWEST (deg): Western extreme (deg) of the operational portion of the orbital 

arc. Only to be given when space stations on a portion of the geostationary 

orbital arc are to be considered. 

INCLINATION (deg): Maximum orbital inclination (deg) for a geostationary space 

station in a slightly inclined geosynchronous orbit. 

GMIN: Antenna minimum gain for antenna pattern option 5. 

 

Figure 3.9. a) “Earth Station Selection” dialogue box and b) “Options” dialogue box 

 

 

 

 

 

 

 

 

 

  (a) Earth Station Selection dialogue box 
 

 

             (b) Options dialogue box 

 

After successful selection of an Earth station, SMS4DC generates and delivers an input 

file to the Ap.7/ITU-R SM.1448 (Ap28) ITU-R technical tool. The output of the ITU-R 

technical tool is saved in two output files: RESULT.LST and UPD.DAT. The generated 

input and two output files can be reviewed by using three relevant menu items. 
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 Draw Contour(s): This item draws, on a vector map, the Method 1, Method 2 and/or 

Auxiliary Coordination Contours for the selected groups of a selected Earth station. A 

dialogue box containing a spreadsheet of selected groups and calculation methods will be 

displayed by choosing this menu item and the user can select any group in the spreadsheet 

for contour drawing by using a left-click of the mouse on the record-select column. 

Figure 3.10 illustrates this dialogue box. A check box will be printed to the left of the 

item if any coordination contour is displayed on the vector map. Figure 3.11 illustrates 

several coordination contours around an Earth station in Geneva. 

 

Figure 3.10. Dialogue box to select coordination contours for displaying on vector map 

 
 

Figure 3.11. Coordination contours around an Earth station in Geneva 

 
 

 Style: This item opens a dialogue box to customize the colour, thickness and line style of 

the coordination contours. Users may set an individual style for each coordination 

contour. Figure 3.12 shows the relevant dialogue box. 
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Figure 3.12. Style dialogue box of coordination contours 

 
 

 View Input File: This item shows the generated input text file that feeds the Ap.7/ITU-R 

SM.1448 (Ap28) ITU-R technical tool. Figure 3.13a displays this input text file. 

 View Output File (RESULT.LST): This item shows details of calculation results 

including probably affected countries and coordination contour data, as generated by the 

Ap.7/ITU-R SM.1448 (Ap28) ITU-R technical tool. Figure 3.13b displays this output text 

file (in WordPad format). 

 View Output File (UPD.DAT): This item shows coordination information data. 

 Save Vectors: This item saves a text file of vector data in a given folder. Each 

coordination contour will be saved in a separate file in the format 

“Ap7_EarthStationName_{I or II}_{0,10,20,…60}.txt” in the Report folder. These 

vectors may be drawn on DEM using “Vector->Draw” item. 
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Figure 3.13. a) Input file and b) Result.lst output file to the Ap.7/ITU-R SM.1448 (Ap28) ITU-R technical tool 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
                 (a) Input file            (b) Result.lst output file to the Ap.7/ITU-R SM.1448 (Ap28) ITU-R technical tool 

 

In addition to the items provided in the “Option” menu, coordination contours displayed around 

an Earth station may be printed using the print item of the “File” menu. The information of each 

contour is presented above the contour picture, as shown in Figure 3.14.  

 

Figure 3.14. Print preview of coordination contours around and earth station 
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3.3.1.2. RR Appendix 7 (GIBC) item in Option menu 

This item, by using the GIBC/Ap.7 ITU-R technical tool, calculates and draws coordination 

contours around a selected Earth station in accordance with the method explained in Appendix 7 

of the Radio Regulations.  The RR Appendix 7 (GIBC) Item can be chosen from the Option 

menu of IDWM Map screen as shown in Figure 1. By choosing this item, the main screen for 

Appendix 7 contour calculations will appear then a notice can be selected from the list of existing 

Earth stations, which have been included already in SMS4DC database, by double clicking on the 

desired notice ID.  

 

 

Figure 3.APP7.1. RR Appendix 7 (GIBC) sub-menu 

 

 

Figure 3.APP7.2 shows the main screen of Appendix 7 sub menu.  
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Figure 3.APP7.2. Selection of Earth station  

 

 

After selection of network ID of an Earth Station, by pressing of “Calculation” button, the input 

data is generated automatically in SNS V7 database format, and sent to BR GIBC Appendix 7 

software. The Appendix 7 contours will be calculated and results shown in three separate lists.  

Figure 3.APP7.3 shows the calculations results, the first list shows the characteristics of selected 

Earth station in blue color. In second list the different kind of calculated diagrams will be shown 

and by selection of each diagram in second list, characteristics of relevant contour(s) are shown 

in third list. 

 

Figure 3.APP7.3. Calculations results in three separate lists  
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If “Auxiliary Contours” check box is selected in the main Appendix 7 screen, after pressing of 

“Calculation” button, the values of auxiliary contours will be asked. For Mode 1, negative values 

in decibel and for Mode2 positive values in degree can be inserted as shown in Figure 3.APP7.4.  

 

Figure 3.APP7.4. Setting Auxiliary Contours  

 
 

Figure 3.APP7.5 shows the results of coordination distance calculations for selected Auxiliary 

Contours.  

 

Figure 3.APP7.5. Coordination distances calculated for selected Auxiliary Contours 
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By selecting of each diagram form the second list, the calculated coordination distances will be 

shown in the third list and by pressing the Export Vectors button the coordination contours will 

be saved in SMS4DC format and displayed on the map. Also at the bottom of the page the list of 

probably affected countries is shown.  

It should be noted that each contour is saved in ..\SMS4DC\Texts path, with different names in 

SMS4DC format: 

Network ID_Date _Time_DiagramNumber_M_ModeNumber_ContourValue.txt 

Figure 3.APP7.6 Shows the dialog box for selection of the parameters for drawing of 

coordination contours on the map. 

 

Figure 3.APP7.6. Dialog box for drawing of coordination contours 

 

 

Figure 3.APP7.7 shows the drawn coordination contours on IDWM map 

 

Figure 3.APP7.7. An example for coordination contours on IDWM map 
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These contours can be also displayed on DEM map by using of “Vector/Draw from file “sub 

menu and also could be exported to Google Earth as well. 

It should be noted that GIBC software saves by default the calculation results in path 

“C:\BR_TEX_RESULTS\APP7” in MS Access format which this results also can be loaded by 

“Load Results” button from the main Appendix 7 calculation screen as shown in figures 

3.APP7.8A and 3.APP7.8B. 
 

Figure 3.APP7.8A. Loading the result files generated by GIBC 

 
 

Figure 3.APP7.8B. Loading the result files generated by GIBC 

 
  



 
43 

3.3.2. Vectors menu of IDWM map view  

The Vectors menu consists of the following items: 

 Draw from File: This item loads a vector file from disk and displays it on the IDWM map. 

By selection of this item, SMS4DC requires the user to select a vector file from the 

relevant location on hard disk. Then, the vector colour and fill style must be defined using 

the dialogue box. 

 Remove from Display: This item removes all user-defined vectors from display on the 

IDWM map. 

 

3.3.3. Help menu of IDWM map view 

Help menu consists of the following items: 

 About SMS4DC: A message box giving brief information about the SMS4DC software 

version and copyright; 

 Manual: This item opens the user manual for the SMS4DC software. An Acrobat reader 

must be installed for correct operation of this item. 

 

3.3.4. Toolbar of IDWM map view 

The shape of desktop menu displayed in Figure 3.3 and Figure 3.4. The following buttons are 

provided in the toolbar of the desktop menu to facilitate manipulation of the main functions: 

 

Toolbar 

Buttons 
Name Description 

 
Draw Box This button creates a variable-size rectangular box to enclose and select an area of interest 

on a vector map. After activating this button by a mouse left click, the mouse cursor shape 

is changed to . To draw a box, the cursor is positioned at the top-left corner of an 

imaginary rectangle and the left button of the mouse is pressed and held while the cursor 

is dragged diagonally down to the right-bottom corner. When the box is drawn to the 

required size, the left button is released and the box remains on the map. The “Draw Box” 

button is deactivated by a mouse left-click and mouse cursor shape returns to normal. 

Only one rectangle at a time is possible on the vector map and its position is unaffected by 

the Zoom In and Zoom Out buttons. 

After a rectangle has been drawn, the DEM push button may be used to load the desk top 

with the four adjacent DEM tiles that include the area inside the drawn rectangle. The 

vector map view transfers to a secondary window.  

 
Zoom In This button magnifies the view without affecting the aspect ratio. Two types of zooming 

method are implemented: 

- Zooming the complete desk-top view at a magnification of times two (x2) ; or 

- Creation of a variable-size box to zoom in a selected rectangular area. 

After activating this button, the mouse cursor shape changes to . Each single left click 

pans the map at the mouse cursor location to the centre of view at a magnification of 

times two (x2). To zoom-in a box area, first left click on the draw box button, then on the 

zoom-in button. Position the cursor at the top-left corner of an imaginary rectangle then 

press and hold the left button of the mouse while dragging the cursor diagonally down to 

the right-bottom corner. On release of the button, the area in the box will be magnified 

two times (x2). There is no scale limitation when enlarging the vector view. 
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Zoom Out 
Pushing this button zooms out to return the vector maps to their original size/scale. 

 
Select 

Country 

This button selects a country or geographical region from the list provided in IDWM, 

release 7.3. Figure 3.15a shows the relevant dialogue box. Users may browse the combo-

list or type the name of the required location in the edit-box. After pushing the OK button, 

the desktop is panned and zoomed in, so that a vector map of the selected area appears in 

the middle of the desktop with the country or area borderline drawn in bold. 

 
DEM This button displays the maps generated by the DEM (Digital Elevation Model). It will 

load, into the desktop, the four adjacent DEM tiles associated with either: the country 

specified at start-up (see country code in ctry.txt); or the rectangular area previously 

selected by the “Draw Box” button.  

 
Refresh This button redraws the desktop content. 

 
Print This button prepares a print preview to send an image of the desktop to the printing 

device. 

 

 

Figure 3.15. a) Dialogue box of list of countries or geographical regions 

 provided by IDWM release 7.3, b) vector map of a selected country 

 

 

 

 

 

 

 

 

 

 

 

    (a) List of countries available in IDWM 

 

 
 

           (b) Vector map of Switzerland 

 

3.4. DEM view 

The DEM view of SMS4DC desktop may be displayed by pushing the “DEM” button in the 

vector map view of the desktop after selection of a rectangular area, using the “Draw Box” 

button. Figure 3.16 shows the DEM of the area displayed in Figure 3.15b (Switzerland) 
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Figure 3.16. Sample DEM view in SMS4DC desktop 

 
 

The Country or Region name, geographical coordinates and ground height in metres (above sea 

level) at the mouse cursor position are displayed on the status bar of DEM view. 

 

3.4.1. Toolbar of DEM view 

Following table explains the buttons implemented in the toolbar of the SMS4DC desktop, DEM 

view. 

 

Toolbar Buttons Name Description 

 
Deactivation This button deactivates any activated buttons. The shape of mouse cursor 

returns to normal by using this button. 

 
Go to Geo-

directions 

One press of these arrow buttons navigates DEM one tile toward one of the 

directions: West (left arrow), North up arrow), South (down arrow) and East 

(right arrow). 

 
Draw Line This button draws a line between two points and activates functions based on a 

predefined line. Clicking this button changes the mouse cursor shape to a cross 

(+). The cross is positioned at the start point of the line and the left mouse 

button pushed and held while dragging the cross to the required end point of the 

line. When the left button is released, the line is drawn and stays on the map. 

The Great-Circle distance between two points is displayed on the status bar in 

km. The line may stay drawn on the DEM for further usage. 

 
Draw 

Polyline 

This button draws polylines and activates relevant functions based on a 

predefined polyline. Clicking this button changes the mouse cursor shape to a 

cross (+). The cross is positioned at the first point of the polyline and the left 

mouse button is clicked. The cross is moved to the next point and the left mouse 

button is clicked. Each single click on mouse left button generates a vertex. A 
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double left-click terminates poly line. The polyline may stay drawn on the DEM 

for further usage. 

 
Draw Box This button creates a variable-size rectangular box to enclose and select an area 

of interest on the DEM and activates area dependent functions. After activating 

this button by a mouse left click, the mouse cursor shape changes to . To draw 

a box, the cursor is positioned at the top-left corner of an imaginary rectangle 

and the left button of the mouse is pressed and held while the cursor is dragged 

diagonally down to the right-bottom corner. When the box is drawn to the 

required size, the left button is released and the box remains on the map. The 

mouse will be ready to create another drawing and the last depicted box will 

stay on DEM for further usage. 

 
Draw Line 

from 

Database 

This button draws a line between two stations in the database and activates 

functions based on predefined lines. Pushing this button opens a spreadsheet of 

stations from which users may select two stations by mouse left click. The 

background DEM will be panned to the location of the selected stations and a 

line will be drawn connecting them. Selection of one, or more than two, stations 

has no effect. Users may sort the list of stations displayed in the spreadsheet. An 

example is shown in Figure 3.17. 

 
Draw Box 

from 

Database 

This button draws a square box containing, at its centre, a station from the 

database and activates functions based on predefined area. Pushing this button 

opens a spreadsheet of stations from which users may select one station by 

mouse left click. The length of the box sides will be requested (in km) and 

consequently drawn after confirmation. Selection of more than one station has 

no effect. Users may sort the list of stations displayed in the spreadsheet. An 

example is shown in Figure 3.17. 

 
Draw Profile This button draws a path profile along a previously drawn line. Figure 3.18 

displays a profile along the line connecting two stations. This button will be 

active only after a line has been drawn. A Polyline drawing does not activate 

this button. 

 



 
47 

Figure 3.17. An example of drawing line from database 

 
 

Figure 3.18. A profile drawn along a line connecting two stations 
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Add Station This button adds an anonymous station from any one of the radiocommunication 

services supported by SMS4DC. A left click on this button changes the mouse 

cursor shape to a cross (+). The cross is then positioned on the map at the proposed 

location of the station. A further left click displays the station data entry mask. The 

geographical coordinates of the selected location will be loaded into the entry mask. 

If required, different coordinates can be entered by keyboard. After validation and 

confirmation of entry mask information, the details of the newly created station will 

be entered into the database. This entry may be reviewed in the Database/Licensing 

menu under the folder: Administrative Data\Anonymous Stations. Also, a station 

symbol will be displayed on the map at the given location and a tooltip (a text box 

summarizing general information about the station) will pop-up if the mouse cursor 

is positioned inside the station symbol. 

 
Move Station This button moves a station to a new location using the mouse. A left click on this 

button activates (turns grey). Then click and hold the mouse right button on the 

station to drag its symbol to the proposed new location. When the mouse right 

button is released, a message box asks the user to confirm saving the new location 

and losing the old location. If the user confirms the relocation, the database will be 

updated with the new details. Also, the effective heights of the antenna in different 

azimuths for the new location must be recalculated as the old values are no longer 

valid. At least one station must be on the map to activate this button. 

 
Add Earth 

Station 

This button adds an anonymous Earth station. A left click on this button changes the 

mouse cursor shape to a cross (+). The cross is then positioned on the map at the 

proposed location of the Earth station. A further left click displays the Earth station 

data entry mask. The geographical coordinates of the selected location will be 

loaded into the entry mask. If required, different coordinates can be entered by 

keyboard. After validation and confirmation of entry mask information, the details 

of the newly created Earth station will be entered into the database. Also, an Earth 

station symbol will be displayed on the map at the given location and a tooltip (a 

text box summarizing general information about the station) will pop-up if the 

mouse cursor is positioned inside the station symbol.  

 
Move Earth 

Station 

This button moves an Earth station to a new location using the mouse. A left click 

on this button activates (turns grey). Then click and hold the mouse right button on 

the station to drag its symbol to the proposed new location. When the mouse right 

button is released, a message box asks the user to confirm saving the new location 

and losing the old location. If the user confirms the relocation, the database will be 

updated with the new details. At least one Earth station on map is necessary to 

activate this button. 

 
Refresh This button refreshes the screen display removes any overlaid area-calculation 

results from the background DEM. 

 
Calculation 

Overlay 

This button overlays area-calculation results on the DEM. This button will be 

activated once the box drawing toolbar button has been used to select an area on the 

map.  The “Overlay Calculation” toolbar button is pushed to display a dialogue box 

containing the available area-calculation results. Users may select from the list, one 

result at a time, to overlay on the background DEM. The size and location of area, 

in which calculations have been made, must be identical to the selected area. 

Otherwise, the overlaid results will not fit the selected area correctly. 

The refresh button can be used to remove overlaid results from the DEM. 

Figure 3.19 shows a sample application of this button. 

 
Show 

Legend 

This button shows or removes legends for activated display. An appropriate legend 

is displayed depending on the type of activated display, i.e. DEM colour legend for 

DEM view; field strength colour legend for area calculation result window etc.  

 



 
49 

Figure 3.19. An example for application of “Overlay Calculation” push button 

 
 

3.4.2. Menus of DEM view 

Under the DEM view of SMS4DC software, various technical procedures and GIS utilities are 

implemented. The following menus are designed for DEM view: 

 File 

 View 

 Window 

 Help 

 Tools 

 Calculation 

 Profile 

 Database 

 Propagation Models 

 Vectors 

 Frequency Allocations 

 Coordination 

 Interference 

 Monitoring 
 

Each menu provides several items and some of these items contain various sub-items. Menus 

implemented in the menu bar depend on the type of active window. The following Sections 

describe these menus, items, sub-items and corresponding features. 
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3.4.2.1. File menu of DEM view 

The File menu consists of the Following items: 

 New: Opens a new DEM view. Each DEM view behaves independently. 

 Close: Closes the active DEM view 

 Print, Print Preview and Print Setup items: Printing item-groups to setup printer, print 

preview of active view and sending print to printing device. Print preview provides a 

snapshot of what is going to be sent for printing. Figure 3.20 shows an example of print 

preview. 
 

Figure 3.20. An example of print preview in DEM view of SMS4DC desktop 

 
 

Several simple functions of the print preview window, enable the user to browse and print 

displayed pages. 

 Exit: This item saves the last setting and quits the SMS4DC software. 

 

Moreover, a list of the four most recently opened, loaded or saved files will be available in the 

“File” menu above the item “Exit”. 

 

3.4.2.2. View menu of DEM view 

The Edit menu consists of the following items: 

 Toolbar: This item switches on or off the toolbar. A check mark to the left of this item 

will appear if the toolbar is switched on. 

 Status Bar: This item switches on or off the status bar. A check mark to the left of this 

item will appear if the toolbar is switched on. 

3.4.2.3. Window menu of DEM view 

The Window menu consists of the following items: 
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 New Window: Opening a new DEM view. Each window behaves independently. 

 Cascade and Tile items: Visual arrangement of open widows on the screen 

 List of open windows: Enumerated list of open widows. The active window is identified 

by a check mark to the left. 

 

3.4.2.4. Help menu of DEM view 

Help menu consists of the following items: 

 About SMS4DC: A message box giving brief information about SMS4DC software 

version number and copyright 

 Manual: Item to open the user manual of SMS4DC software. Acrobat (pdf) reader has to 

be installed for proper operation of this item. 

 

3.4.2.5. Tools menu of DEM view 

The tools menu consists of the following items: 

 Normalize: Changes the display range of terrain altitude in DEM view, users may modify 

the minimum and maximum threshold of terrain altitude. Points higher and lower than the 

defined altitude range will be displayed by two colours at the bottom and top of the 

legend. Figure 3.21 shows a sample application of this altitude range. The old values are 

those values which are suggested by SMS4DC, based on minimum and maximum altitude 

of points loaded into the memory from four adjacent DEM tiles. The short-key Ctrl+N is 

defined to activate this item. 

 

Figure 3.21. Application of new range of terrain altitude and normalized colour map 
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 Colour map: This item changes the colour map used in the display of terrain altitude in 

DEM view. Figure 3.22 displays the implemented colour maps. 

 

Figure 3.22. Implemented various colour maps 

 

 

 

 

 

 

 

 

 

 

 Lighten: This item increases brightness of displayed DEM. RGB value of all points is 

increased by 20 each time this item is used. 

 Darken: This item decreases brightness of displayed DEM. RGB value of all points is 

decreased by 20 each time this item is used. 

 Grid: May be used for switching on or off of the geo-grid in degrees. A check mark will 

appear to the left of the item if switched on. Moreover, the short-key Ctrl+G is defined for 

this item. 

 Grid step: Users may adjust geo-grid steps within the range of 0.01 to 10 inclusive. The 

default grid step is one degree. 

 Legend: This item switches on or off the map-colour legend. A check mark will appear to 

the left of the item and a “Show Legend” toolbar push button will be activated 

automatically by SMS4DC if the item is switched on. Reselection of item removes the 

check mark and releases the “Show Legend” toolbar push button. 

 Symbol Attribute: May be used for changing the colour and size of the station symbol 

together with the colour of the station name. Figure 3.23 shows the implementation of this 

item. 

 

Topo_0: 
 

Topo_1: 
 

Rainbow: 
 

Gray: 
 

Pink: 
 

Copper: 
 

Globe: 
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Figure 3.23. Station symbol attribute modification 

 
 

 Antenna Editor: Initiates a dialogue box to load, modify, visualize (2D and 3D), define 

and print antenna radiation patterns. The Antenna Editor is explained fully in Section 

3.4.2.5.1. 

 2D View / Contour: Item to perform specific functions on the DEM for a selected area. To 

activate this item, an area must be selected, in advance, using either the “Draw Box” or 

“Draw Box from Database” toolbar buttons. If this item is selected, a 2D view of the 

selected area will be copied to a new window and users will be able to perform several 

GIS functions such as dynamic zooming in/out, topographical contour generation, 

normalizing, colour map changing and printing. The 2D View / Contour item and its 

menus are explained fully in Section 3.4.2.5.2 . 

 3D View: Displays a 3D view of a selected area. To activate this item, an area must be 

selected using either the “Draw Box” or “Draw Box from Database” toolbar buttons. 

When this item is selected, a 3D view of the selected area will be created in a new 

window and users will be able to perform some helpful functions such as dynamic 

zooming in/out, topographical contour generation, normalizing, colour map changing, 

rotation, light source modification and colour management. The 3D View is explained 

fully in Section 3.4.2.5.3. 

 Map Layers: Provides three sub-items to select background DEM: “Tools->Map Layers-

>GlobeDEM”, “Tools->Map Layers->UserMap1” and “Tools->Map Layers-

>UserMap2”. The selected DEM (i.e. UserMap1 or UserMap2) may be identified by a 

checkmark to the left of the  item. SMS4DC employs the map “GlobeDEM” by default 

and, as an option, two additional maps may be managed by users. 
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Each map has a “description text file” which describes the map layer. These files: 

Globe.txt, UserMap1.txt and UserMap2.txt, are contain the layer descriptions of maps of 

the three sub-items and are stored in the folder “…\SMS4DC\Texts”. The format of these 

files is explained in Annex 2. 

 Google Earth Export/Display: This menu is for exporting various types of data to the 

GoogleEarth™ application. Under this menu, there are the following sub-menus: 

o Selected Station(s): Selecting this menu shows a list of all existing terrestrial 

stations on the database. After selecting the stations from the list and pressing OK, 

the output file for GoogleEarth will be generated and a screen will be shown (see 

the example below) requesting that the user specifies the path and file name for 

the KML (extension of GoogleEarth file) file and whether or not to transfer 

immediately the results for display in a GoogleEarth window.  

 

 

 
o Links: Selecting this menu item shows a list of all existing point-to-point links. 

After selecting the desired link(s) from the list and pressing OK, the output file for 

GoogleEarth will be generated and then a screen will be shown requesting the user 

to specify the path and name of the KML (extension of GoogleEarth file) file and 
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also whether or not to transfer immediately the results for display in a 

GoogleEarth window. 

 
o Selected Earth Station(s): Selection of this menu item shows a list of all existing 

Earth stations. After selecting stations from this list and pressing OK, the output 

file for GoogleEarth is generated and a screen requesting the user to specify the 

path and name of the KML (extension of GoogleEarth file) file and also whether 

or not to transfer the results immediately for display in a GoogleEarth window. 

o Receiving Area: Selection of this menu item shows a list of all existing terrestrial 

stations with a defined receiving area. After selecting stations from this list and 

pressing OK, the output file for GoogleEarth is generated and a screen requesting 

the user to specify the path and name of the KML (extension of GoogleEarth file) 

file and also whether or not to transfer the results immediately for display in a 

GoogleEarth window. 

o Service Area (FXM): Selection of this menu item shows a list of all existing FXM 

stations with a defined service area. After selecting stations from this list and 

pressing OK, an output file for GoogleEarth is generated and a screen requesting 
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the user to specify the path and name of the KML (extension of GoogleEarth file) 

file and also whether or not to transfer the results immediately for display in a 

GoogleEarth window. 

 

 
o Service Area (GE06 BC,BT): Selection of this menu item shows a list of all 

existing BC and BT stations in the GE06 Plan with a defined service area. After 

selecting stations from the list and pressing OK, the output file for GoogleEarth 

will be generated and a screen is shown requesting the user to specify the path and 

name of the KML (extension of GoogleEarth file) file and also whether or not to 

transfer the results immediately for display in a GoogleEarth window. 

o Allotment Area: Selection of this menu item shows a list of all existing GE06 

allotments in the database. After selecting an allotment from the list and pressing 

OK, the output file for GoogleEarth will be generated and then a screen is shown 

requesting the user to specify the path and name of the KML (extension of 

GoogleEarth file) file and also whether or to transfer the results immediately for 

display in a GoogleEarth window. 
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o GE06 Plan Entry: This menu item creates a KML file (for GoogleEarth) 

displaying Plan Entry Code and linked assignments and/ or associated allotment 

with the selected assignment/allotment in the GE06 Plan. All 

allotments/assignments (in conformity with GE06 Plan) in the database will be 

shown in a spreadsheet and users can select the wanted allotment/assignment, by 

using a mouse left click on the record-select column of the spreadsheet. Finally, 

the wanted assignment/allotment and its linked assignments and/or associated 

allotment with their general information are listed in a spreadsheet. Users may 

select some or all of them by a mouse left click on the record select column. 

o Converted Assignment(s): This menu item creates a KML file (for GoogleEarth) 

to display converted assignments stemmed from a selected allotment, or to display 

the source allotment of a selected converted assignment in the GE06 Plan. All 

allotments and converted assignments (in conformity with GE06 Plan) in the 

database will be shown in a spreadsheet and users may select the wanted 

allotment/assignment, using a mouse left click on the record-select column of the 

spreadsheet. Finally, the source allotment and all related converted assignments, 
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with their general information are listed in a spreadsheet. Users may select some 

or all of them by a mouse left click on the record select column. 

o Vectors: This menu item enables the conversion of all other vectors created by 

SMS4DC, to KML files which are readable by Google Earth. 

 

 
 

3.4.2.5.1. Antenna Editor in Tools menu of DEM view 

As introduced in Section 3.4.2.5, the “Tools->Antenna Editor” menu item opens a dialogue box 

to load, modify, visualize (2D and 3D), define and print antenna radiation pattern. An isotropic 

pattern will be loaded to the dialogue box by default. 

Figure 3.24 shows a sample antenna radiation pattern. The 3dB circle is also shown which may 

be used to read the +/-3dB beam width. The following information and buttons appear on the 

dialogue box: 
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Figure 3.24. Antenna Editor dialogue box 

 
 

- Antenna Name: Antenna commercial name. Any space character in the name will be 

automatically replaced by a hyphen when the pattern is saved. 

- Frequency band: Antenna working frequency band 

- Beamwidth: Antenna 3dB beamwidth in E- and H-planes 

- Polarization: The orientation of antenna’s electrical field with respect to the horizontal 

plane. Therefore, the polarization used by the antenna depends on the physical installation 

of antenna. Two types H and V are possible here which represent horizontal and vertical 

polarization respectively. 

- Gain: Antenna gain along main beam (boresight). The 2D radiation pattern in dBi (with 

respect to the isotropic antenna). Isotropic gain has been normalized to zero dB. 

- Pattern Data: Attenuation values in dBi in any angle of 2D radiation pattern in both E- 

and H- planes. The angles provided in the table, under the heading “φ/θ”, are for 

information only and do not coincide with the displayed angles around the H-plan pattern. 

In the case of the H-plan pattern, the angles around the pattern are the elevation angles if 

main beam is horizontal. 

A marker is displayed at the point of the radiation pattern where its value is selected by a 

mouse left-click in the data table. Also, arrow keys may be used to browse the data table. 

Attenuation levels in the selected row are copied to the two edit boxes below the table and 
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can be edited. Attenuation values must be in the range zero to fifty dB. The radiation 

pattern will be modified simultaneously by editing the attenuation values. 

- E- and H-plane push buttons: Push buttons to show 2D E- and H-plane radiation patterns 

in dialogue box. 

- 3D: Push button to draw 3D radiation pattern in a new window. Several features are 

provided for this view which has additional explanation in the item “3D” of the “Option” 

menu. 

- “Set All to Value” push button: Sets all attenuation levels for all angles of the active 2D 

radiation pattern to a given value between zero and fifty. The radiation pattern and data 

table are modified simultaneously by entering a value in this edit box. 

- “Omni” push button: To provide an omni radiation pattern to the current radiation plane 

with zero dB attenuation level. The data table is also modified simultaneously. 

- “Clear” push button: This push button sets attenuation values for all angles of radiation 

pattern in the current radiation plane (H or E) to 50 dB. 

- “Load” push button: To load a file, with the file name in the format “ant_*.ant”, 

containing E- and H-plan radiation patterns as well as other characteristics of antenna. 

- “Save” push button: Generates a file name in the format “ant_*.ant” and saves the 

modified or new pattern. A warning message will be displayed if the file name is already 

in use. 

Additionally, antenna patterns may be modified graphically using a mouse left click on the 

pattern shape. The corresponding attenuation value for the relevant angle is modified 

simultaneously. 

Under “Antenna Editor” dialogue box, an “Option” menu is implemented which enables users to 

change 2D plot style and draw 3D radiation pattern. The following items are available in the 

“Option” menu: 

- Fill Diagram: To fill inside the curve of radiation pattern with a colour which may be 

selected from standard colour palette. If active, a check mark will be shown to the left 

side of item. 

- Thick Lines: To increase the line thickness of radiation pattern curve. If active, a check 

mark will be shown to the left side of item. 

- 5 Degrees Grid: Increases the angular grid of 2D radiation pattern plot from 10 degrees to 

5 degrees. If active, a check mark will be shown to the left side of item. 

- 1 Degrees Grid: Increases the angular grid of 2D radiation pattern plot from 10 degrees to 

1 degree. If active, a check mark will be shown to the left side of item. 

- 1 dB Grid: Increases the radial grid of 2D radiation pattern plot from 10 dB to 1 dB. If 

active, a check mark will be shown to the left side of item. Figure 3.25 shows the highest 

resolution of grid setting for the “Antenna Editor” dialogue box. 

- 3D: Draws the 3D radiation pattern of antenna in a new window. This item is identical to 

the 3D push button on the antenna dialogue box. Figure 3.26 displays the 3D view of an 

antenna radiation pattern. 
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Figure 3.25. The highest resolution grid in “Antenna Editor” dialogue box 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.26. 3D view of an antenna radiation pattern. 

 a) filled 3D pattern, b) empty 3D pattern, c) Rotated 3D pattern, and d) 3D property adjustments 

 

 

 

 

 

 

 

 

 
 

(a) Filled 3D radiation pattern   (b) Empty 3D radiation pattern 

 

 

 

 

 

 

 

 

 

(d) Dialogue box to adjust 

 visual effects of 3D view 
(c) 3D rotated radiation pattern 
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Several actions are defined for the mouse in the 3D pattern view. The pattern shape may 

be rotated briefly or continuously by horizontal or vertical mouse move, slow or fast 

respectively, while holding the left mouse button. An additional mouse left button click 

stops the rotation. The size of pattern shape can be enlarged or reduced by horizontal or 

vertical mouse movement while holding the right mouse button. Horizontal or vertical 

mouse movement while holding right mouse button plus CTRL key, pans the 3D radiation 

pattern. 

The “Option” menu under the 3D pattern view provides the following items to adjust the 

display properties: 

- Fill diagram: To paint radiation pattern mesh with a rainbow colour map. 

- Quad mode: To change colour distribution mode on the face of 3D pattern to quad 

mode. 

- Properties: To adjust the visual setting of the 3D pattern. The relevant dialogue box is 

shown in Figure 3.26d. 

- Background Colour: To change background colour of the 3D pattern view. 

 

3.4.2.5.2. Convert Antenna File 

 

By selection of this menu item the above sscreen will be displayed. This functionality will be 

used to convert the antenna files provided by some antenna manufacturers to the *.ant file format 

supported by SMS4DC. 

3.4.2.5.3. 2D View/Contour item in Tools menu of DEM view 

As introduced in Section 3.4.2.5, once an area has been selected in the DEM using either the 

“Draw Box” or “Draw Box from Database” toolbar push buttons, the “2D View/Contour” item 

will be activated. After choosing this item, the selected area is copied to a resizable new window. 

The DEM view may be zoomed in or out by changing the window size using the mouse. “Show 

Legend” toolbar push button may be used for switching on/off the legend and printing facilities 

available from the “File” menu. “Tools” and “Database” menus are available in this view. 

“Normalize”, “Colourmap”, “Legend” and “Symbol Attribute” items in the “Tools” menu, and 

“Display Selected Station(s)” and “Remove Stations from Display” items in the “Database” menu 

have the same functions as described in 3.4.2.5 and 3.4.2.8 respectively. There is also a 

“Contour” item under the “Tools” menu which can be used for decreasing the number of colours 

by increasing simultaneously the level-step in “Legend”. Figure 3.27 display an example of the 



 
63 

application of this feature. This item functions in the same way as the “Contour Levels” item 

under Tools menu of the area calculation widow. 

Figure 3.27. An example for application of “Contour” item in the “Tools” menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.4.2.5.4. 3D View item in Tools menu of DEM view 

As introduced in Section 3.4.2.5, when an area has been selected using “Draw Box” or “Draw 

Box from Database” toolbar buttons, this item becomes active. By choosing this item, a 3D view 

of the selected area will be created in a new window. The “Option” menu is available and the 

mouse can be used to adjust some visual effects. Figure 3.28 shows a 3D view of a selected area. 

 

Figure 3.28. 3D view of a selected area and corresponding visual setting dialogue box 

 

 

 

 

 

 

 

 

       (a) Dialogue box to adjust visual 

              effects of 3D view 
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“Option” menu under 3D view provides the following items to adjust display properties: 

- Fill diagram: To paint DEM mesh with a given colour map. 

- Quad mode: To change colour distribution mode on the surface of a 3D DEM to quad 

mode. 

- Background Colour: To change background colour of 3D view. 

- Properties: To adjust visual settings of a 3D display. The relevant dialogue box is 

shown in Figure 3.28a. 

- Contour: To decrease the number of displayed colours by increasing the level-step in 

“Legend”. The 3D shape in Figure 3.28 shows an example for a three colour display. 

Several actions are defined for the mouse in the 3D view. A 3D figure can be rotated briefly or 

continuously by horizontal or vertical mouse movement, slow or fast respectively, while holding 

the mouse left button. An additional mouse left button click stops the rotation. The size of the 3D 

shape can be enlarged or reduced by horizontal or vertical mouse movement while holding the 

right button. Horizontal or vertical mouse movement while holding the right mouse button plus 

CTRL key, pans the 3D figure. 

 

3.4.2.6. Calculations menu of DEM view 

The calculations menu consists of the following items: 

 Distance (km): Calculation of great circle distance of a path along a line (profile) or poly-

line in km. This item is activated if a line or polyline has been created previously using 

“Draw Line” or “Draw Line from Database” or “Poly Line” toolbar buttons (see Section 

3.4.1). The value of distance in km is presented on the status bar in the format of 

“Dist(km): value”. 

 Area (km2): Calculation of an area bounded by a simple polygon (non-intersecting 

boundary), constructed by connecting two end points of a polyline drawn by using the 

“Poly Line” toolbar button (Section 3.4.1). The area value in km2 is presented on the 

status bar. Figure 3.29 explains the concept of a simple polygon. 

 

Figure 3.29. Types of polygon. a) simple polygon, and b) complex polygon 

 

 

 

 

 

 

(a)     (b) 

 

 Azimuth (Deg.): Calculation of the azimuth angle of a first point in respect to a second 

point in degrees. This item is activated if a line has been drawn using the “Draw Line” or 

“Draw Line from Database” toolbar buttons (Section 3.4.1). The value of the azimuth 

angle is presented on the status bar. Figure 3.30 shows two different examples. 
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Figure 3.30. Azimuth calculation 

 

 

 

 

 

 

 

 

 

 

 Elevation (Deg.): Calculation of elevation angle of path from first point to the second 

point in degrees with respect to the horizon. This item is activated if a line has been drawn 

previously using “Draw Line” or “Draw Line from Database” toolbar buttons (see Section 

3.4.1). By selecting this item a dialogue box is shown giving users the possibility to 

change k-factor in the range – 20 to – 0.01 and +0.01 to +20 (default value is +1.33). 

Terrain height is used for propagation calculations. The value of calculated elevation 

angle is presented at the status bar. A negative value of elevation angle indicates that the 

second point is below the (radio) horizon with respect to the first point. 

 Horizon Distance: This item provides a multi-entry calculator to calculate point to point 

distance between antennas over a smooth Earth path and the individual distance from each 

antenna to the horizon. Figure 3.31 displays the provided dialogue box. 

 

Figure 3.31. Dialogue box of horizon distance calculation 

 
 

The value of k-factor should be in the range – 20 to – 0.01 and +0.01 to +20 (default 

value is +1.33) 

First point 

second point 

North 

direction 

second point 

first point 

North 

direction 
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 Effective Height: Calculation of the effective height of an antenna for a station in the 

database. A full description of this item is given in Section 3.4.2.6.1. 

 Units Converter: A calculator to convert various technical units from one type to another. 

Supported units are µV, µW, mW, W, kW, dBW, dBm and dBµV/m. The values for 

frequency, receiving antenna gain, cable loss of receiver and reference impedance must be 

given by the user for some conversions. Figure 3.32 displays the unit calculator dialogue 

box. 

Figure 3.32. Unit calculator dialogue box 

 
 

 Intermodulation: This item calculates intermodulation products from up to three 

independent signals which are suspected to be received as interference by a victim 

receiver. Selection of this item initiates an intermodulation calculator which is explained 

in Section 3.4.2.6.2. 

 Earth Station: 

 Horizon Elevation: 

This menu item calculates the Horizon Elevation Angles for a selected Earth 

station and stores the values in the database. 
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 Azimuth to GSO Satellites 

This menu item is used to calculate the Azimuth from the Earth station to its 

associated Space station (satellite) and store in the database. 

 

 
 Elevation to GSO Satellites 

This menu item is used to calculate the Elevation from the Earth station to its 

associated Space station (satellite) and store in the database. 

 
 

3.4.2.6.1. Effective height calculation in the Calculations menu 

The calculation of effective height of an antenna is possible through the item “Effective Height” 

provided in the “Calculations” menu of the SMS4DC desktop (DEM view). As explained in ITU-

R P.1546, the effective height of an antenna is a function of surrounding terrain height, from 3 

km to 15 km, as well as antenna height. Effective antenna height is used by field-strength 

prediction models included in GE84, GE89, GE06, ST61, P.370, P.1812 and P.1546.  

After selection of the item “Calculations -> Effective Height”, the database of stations is 

displayed. Once a station is selected from the spreadsheet, the background DEM will be panned 

to the location of selected station and a diagram representing effective height around the antenna 

will be displayed as shown in Figure 3.33. 
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Figure 3.33. Spreadsheet of stations and picture of effective height of an antenna 

  

 

 

 

 

 

 

 

 

 

 

 

 

As displayed in Figure 3.33, the diagram of antenna effective height consists of two concentric 

circles of values. The inner circle is azimuth angle and outer circle gives the antenna effective 

height along the corresponding azimuth. The “Tools” menu, in this case, provides the following 

items: 
 

 Text Colour: To customize the colour of texts using the standard “Colour Dialogue” box; 

 Line Colour: To customize the colour of lines using the standard “Colour Dialogue” box; 

 Background: To insert the DEM centred on the station location as a background of 

effective height values. Activation of this item is indicated by a check-mark to the left; 

 Colour Map: Colour maps which may be selected for the background DEM, if the 

background DEM has been shown already. List of colour maps shown in Figure 3.22. 

 Save Effective Height (Database): Saves the effective height values, in metres, together 

with the corresponding azimuths (with 5 degrees resolution) into the database. 

 Save Effective Height (text): Saves the effective height values, in metres, together with 

the corresponding azimuths (with 5 degrees resolution), the station name, the map 

property file name and the location into a text file. Figure 3.34 provides an example of the 

application of some of the above items. 

 Background DEM: On the window that shows an Effective Height diagram over a 

Background DEM, a mouse right click will display a table of values of effective height of 

the antenna at different azimuths. The items save Effective Height (Database) and Save 

Effective Height (text) (also seen in the menu “Calculations -> Effective Height->Tools”) 

will appear at the bottom of this table. Additionally, printing features are available 

through the “File” menu    

 Edit Database: This item enables the editing of values (previously saved in the database) 

of effective height of antenna at different azimuths, including a value for the maximum 

effective height (Max Heff) (see Figure 3.35). A “Save” push button is available above 

the table to save the modifications. 
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Figure 3.34 Background map, saved text file and context menu 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.35 Sample for editing saved effective heights values 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.4.2.6.2. Intermodulation calculation in the Calculation menu 

The “Calculation-> intermodulation” item enables users to calculate intermodulation products of 

up to three independent transmitting frequencies, up to 7th order, which might cause interference 

to victim receivers.  Figure 3.36 shows the Intermodulation calculator on screen with a sample 

calculation and a saved text report of the results. 
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Figure 3.36. a) Intermodulation calculator and b) saved report (text file) 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

          (a) Intermodulation calculator 

 

 

 

             (b) Saved report (text file) 
 

The Calculator displayed in Figure 3.36a consists of following Sections: 

 Transmitter: This section of the screen lists the main transmitting frequencies that are 

producing the intermodulation products. “Add” or “AddDB” push button can be used to 

add a transmitting frequency manually or from the database of stations, respectively. 

“Delete” and “AllDel” push buttons are for deleting one or all frequencies from the list, 

respectively. The “Move” Push button copies all the transmitting frequencies into the 

frequency list of Receiver Section by considering 25 kHz as the default bandwidth. 

 Receiver: This section of the screen lists the victim receiver centre frequencies with a 

corresponding equivalent-bandwidth. “Add” or “AddDB” push button can be used to add 

a transmitting frequency and corresponding bandwidth manually, or from the database of 

stations. “Delete” and “AllDel” push buttons delete one or all frequencies from the list 

respectively. The “Move” Push button copies all receiving frequencies into the frequency 

list of the Transmitter Section. 

 Signal: The number of transmitting signals which have to be combined to produce 

intermodulation products. Two or up to three signals can be selected. 

 Order of intermodulation: The order of intermodulation products which have to be 

investigated to determine if they might cause interference to the receivers or not. The 

order of intermodulation is the sum of absolute value of multiplicands of the main 

harmonics contributing to the intermodulation product. 

 Order of Harmonics: The maximum order of main harmonics which have to be 

investigated to determine if they might cause interference to the receivers or not.. 

 Results: List of suspect intermodulation products with their detailed calculations for: 

o main harmonics, 
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o two transmitting signals contributing, and 

o three transmitting signals contributing. 

 Calculate push button: Push button to calculate suspect combinations using the latest 

settings and frequencies input to the calculator. In order to view the latest results, it is 

necessary to run the calculator after changing values or radio buttons of calculator. 

 Save push button: This button saves the results of intermodulation calculations and 

calculator settings in a text file in a user-specified folder location. The content of a sample 

file is shown in Figure 3.36b. 

 

3.4.2.7. Profile menu of DEM view 

The Profile menu consists of the following items: 

 Line: Plots a path profile along a path established on the DEM using the “Draw Line” or 

“Draw Line from Database” toolbar push buttons (Section 3.4.1). Figure 3.37 displays a 

path profile plotted by this item. 

Figure 3.37. Path profile plotted along a line 

 depicted using “Draw Line” or “Draw Line from Database” toolbar push buttons 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The graph of the path profile is equipped with a vertical marker which is movable 

horizontally by mouse movement while holding left mouse button. Values for the 

geographical coordinates, terrain height and ground-distance from left point (beginning 

point of this line), at the current vertical marker location, are displayed on the status bar. 

Additionally, users may change the value of k-factor through the “Option” menu in the 

range –20 to –0.01 and +0.01 to +20. The default value of k-factor is 1.33. 

 Polyline: Plotting path profile along a polyline established on DEM using “Polyline” 

toolbar push button (Section 3.4.1). Figure 3.38 displays a path profile depicted by this 

item. 
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Figure 3.38. Path profile plotted along a poly line depicted using “Polyline” toolbar push button 

 
 

The graph of path profile is equipped with a vertical marker which is movable 

horizontally by mouse movement while holding left mouse button. Values for:  

geographical coordinates, terrain height and ground-distance from left point (beginning 

point of this polyline), at the current vertical marker position, are displayed on the status 

bar. The k-factor is not considered in this plot. 

 Fresnel Zone: This plots a path profile and the corresponding nth Fresnel Zone along a 

path established on DEM using the “Draw Line” or “Draw Line from Database” toolbar 

push buttons (Section 3.4.1). The default values for left site antenna, right site antenna, 

frequency, k-factor and Fresnel Zone number are displayed at the top of plot. These 

values may be changed through the menu item: “Option->Change Fresnel Zone 

Parameters”. Figure 3.39 shows a path profile and corresponding Fresnel Zone plotted by 

this item. 
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Figure 3.39. Path profile with Fresnel Zone  

along a line depicted using “Draw Line” or “Draw Line from Database” push buttons 

 
 

The graph of the path profile and corresponding Fresnel Zone is equipped with a vertical 

marker which is movable horizontally by mouse movement while holding left mouse 

button. The values for: geographical coordinates, terrain height and ground-distance from 

left point (beginning point of this line), at the current position of the vertical marker, are 

displayed on the status bar. Additionally, users may change the value of k-factor through 

the “Option” menu in the range –20 to –0.01 and +0.01 to +20. The default value of k-

factor is 1.33. 

 

3.4.2.8. Database menu of DEM view 

The Database menu consists of the following items: 

 Display Selected Station(s): This item is designed to display stations which are selected 

from the database of stations. Therefore, by choosing this item, the spreadsheet of stations 

is displayed to enable selection of one or more stations using a mouse left click on the 

cells on the first column of each row. When the OK button is pushed, the selected stations 

will be displayed on the DEM, but the DEM will not pan to the location of the selected 

stations, 

Some helpful functions are implemented in the spreadsheet of stations. Users may select 

rows by mouse left-click on corresponding rows of the record-select column (first column 

from left). The colour of selected rows will be yellow. A mouse left click on each column 

name will sort the records in ascending or descending order based on the contents of that 

column. Additionally, a push-button is provided to export the selected rows in CSV 

(Comma Separated Values) format. Figure 3.40 shows the spreadsheet of stations. 
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Figure 3.40. Spreadsheet of stations with some selections 

 
 

 Station(s) in Desktop: This item performs a similar function to the item “Display Selected 

Station(s)” (explained in the previous bullet) except that the DEM is panned to the 

location of the selected stations if they are located in the four adjacent DEM tiles. 

Otherwise, if the selected stations are not in four adjacent DEM tiles, the intermediate 

four adjacent tiles will be loaded to the desktop. For more information on map 

manipulation in SMS4DC software refer to Chapter 1. 

 Move Station: This item enables the user to move a station to a new location using the 

mouse. This item will be “grayed out” and inaccessible if no station is displayed on the 

DEM. Therefore, at least one station should be displayed on DEM for activation of 

“Move Station” item, by using either of the first two items of the “Database” menu 

(explained in the two previous bullets). It should be noted that the effective heights of 

antenna in different azimuths have to be recalculated for the new location as the old 

values are no longer valid.  

Selecting this item causes a check mark to appear to the left of the item and the “Move 

Station” toolbar button will be activated (see Section 3.4.1). To move a station, the user 

positions the mouse cursor inside the station symbol then clicks and holds the mouse right 

button. The station symbol may then be dragged across the DEM to the proposed new 

location where the mouse right button is released. A message box requests the user to 

confirm the new location, with a warning that, in the database record, the new coordinates 

will replace and delete the coordinates of the original location. Re-selecting this item 

removes the check mark next to the item and deactivates the “Move Station” toolbar 

button. 

 Add Station: This enables users to add a station at the mouse cursor position on the DEM 

and save the corresponding technical data in the working database. The mouse cursor 

shape changes to the “+” shape and the “+” is positioned at the proposed location of the 

new station. A left click of the mouse button displays a data entry mask to input the 

technical data of the station. The geographical coordinates of the location at the mouse 

position on the DEM are loaded into the corresponding data fields in the mask. These 

coordinates may be modified by keyboard entry. Figure 3.41 shows an example of the 

data entry mask. The newly created station will be inserted in the folder for Anonymous 

Stations in the Administrative Window. 
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Figure 3.41. Data entry mask to enter parameters of new station, isotropic and a sample of directional 

antenna patterns 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

The range of radiocommunication services that may be dealt with by SMS4DC is limited, 

by the ITU-D specification, to the: Fixed, Land Mobile and Broadcasting (Sound and TV) 

services. Therefore the range of the Class of Stations is limited to only those classes that 

correspond to these three specified services. The “Assign Antenna” push button enables 

antenna selection from a folder of antenna specification data files. An isotropic antenna 

will be assigned by default if no specific antenna is selected. The vertical and horizontal 

polarization directivity pattern of an antenna can be displayed using the “Show Pattern” 

push button. A new antenna may be defined by using the item “Tools->Edit Antenna”. 

 

 Search Station: There are three sub-items: “Search Station->By Location”, “Search 

Station->By Location and Frequency” and “Search Station->List of Queried Station(s)”. 

In order to activate these sub-items, an area must be selected in advance by the “Draw 

Box” or “Draw Box from Database” toolbar buttons. The third sub-item, “List of Queried 

Station(s)”, additionally requires at least one station to be located in the selected area. The 

first sub-item displays a station symbol at the locations of all stations located in a selected 

area. The second sub-item produces a similar display but only for those stations between 

the lower and upper frequency limits specified by the user in a pop-up dialogue box 

(Figure 3.42a). The third sub-item produces a spreadsheet (Figure 3.42b) which lists the 

details of all stations within the selected area. This spreadsheet is equipped with two  

buttons to enable users to sort the stations in ascending or descending order, with respect 

to column “IDst” (by default), or any other column selected by a mouse left click on that 

column’s field name. The third button can be used to export the selected rows in CSV 

(Comma Separated Values) format. 

 Remove Stations from Display: This item removes all displayed terrestrial stations from 

the DEM. 

 Display Links: This item displays selected point – to – point radio links on the 

background DEM. Selection of this item opens a spreadsheet of all point – to – point links 
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in the database, from which users may select one or more links for display on the 

background DEM. Figure 3.43 shows an example. Arrows are used to indicate 

transmission direction for bi-directional or unidirectional links and will remain attached to 

connected stations even when they are moved to a new location on the map. “Remove 

Station(s) from Display” item can be used for removing links from map.   

 

Figure 3.42. a)Dialogue box to define frequency band criteria  

to search stations in a given area, and b) list of queried stations found in the given area 

 

 

 

 

 

 

       (a) Frequency criteria 

 

 
     (b) List of queried stations found in the given area 

Figure 3.43. A sample display of point – to – point links on the map 

 

 Import from IFIC (Terrestrial Services): This item enables the import of selected data 

from the BR IFIC database into the SMS4DC database. This function requires the (latest) 

BR IFIC database to be installed in accordance with the installation instructions. As from 

terrestrial BR IFIC No. 2739, the BR IFIC database is not in Microsoft Access format but 
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in SQLite format. Before being able to perform the data import, it is essential to create a 

data bridge after each installation of the BR IFIC. The bridge can be built through the 

usage of the “BR IFIC Format Converter” which is available in the TerRaQ-Plus (see the 

following picture). 
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As shown in Figure 3.44, choosing this item launches the “IFIC import” dialogue box and 

provides a data filter to specify the type of data required for import. The content of this 

dialogue box is similar to the BR TerRaQ software. The following filter conditions can be 

set using the dialogue box: 

o Radiocommunication service type: use the check boxes to select either FM/TV 

(for Broadcasting assignments or allotments) or FXM (for Fixed or Land Mobile 

assignments). If FM/TV is selected, the Allotments check box is activated. This 

enables the user additionally to request the import of information for broadcasting 

allotments. 

o Administration: The user may select administrations from this window list and 

add them to (or remove them from) the selection window list. 

o Frequency condition: To specify a frequency range filter for the imported records. 

o Class of Station: A Combo box to select class of station for which data is to be 

imported. 

o Fragment: A Combo box enables the selection of the fragments corresponding to 

the service type selected. 

o Assign ID(s) of the specific notice(s) to import. 
 

Leaving conditions blank means no preference with respect to that item and SMS4DC 

will ignore the relevant condition. However, a warning message will be displayed if no 

conditions are defined.  
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Figure 3.44. Dialogue box of importing data from BRIFIC 

 
 

 Import from  BR IFIC (Space Services): This item imports information of Earth stations 

which belong to one or more administrations, into the SMS4DC database. The 

information source must be an “mdb” file having a data format identical with the BR IFIC 

(Space Services) database format (including space BR IFIC and electronic notices). 

As displayed in Figure 3.45, choosing this item opens the “BR-IFIC import” dialogue box 

and provides a mask to specify the source database (with mdb extension) and one or more 

administrations whose Earth station information is to be imported. The browse button 

enables the user to find the correct “mdb” file location. After choosing the 

administration(s) of interest and pushing the “Import” button, SMS4DC displays a 

Yes/No dialogue screen and the number Earth station records available for import 

(according to the administrations selected). This screen enables the user to continue or 

abandon the data import. A progress bar is included at the bottom of the main import 

screen.  
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Figure 3.45. Dialogue box to import information of earth stations from BR BR-IFIC database 

 

 

 

 

 

 

 

 

 

 

 

 Licensing: This item provides access to the Administrative module of SMS4DC. The 

details of all the Administrative functions of SMS4DC are described in chapter 4. 

 Audit Trail: This item shows the action log for audit purposes. The log is in spreadsheet 

format, listing: action date and time; users who performed the actions; effected record and 

the table in which the effected records are registered. Three combo boxes are provided 

which allow the list to be filtered to a specific user, action or modified database table.  

Figure 3.46 shows an example of the audit trail spreadsheet.  

Table 3.1 shows the list of logged actions: Owners, Licenses, Stations, Equipments, 

Antennas, Frequencies, Links, Payments and Invoice tables.   

 

Figure 3.46. Log of actions performed by each users on relevant record of database table with time and date 

tag 
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Table 3.1. Actions and tables for which SMS4DC keeps a log for audit purposes 

Actions logged Description 

Add … Adds a new record to the corresponding table. The Audit Trail spreadsheet lists: the user 

taking the action, date and time of action, record number, name of relevant table.  

Delete … Deletes an existing record from the corresponding table. The delete command may cascade 

several deleting actions. For example: deleting an Owner record will delete all associated 

licenses, stations, equipment etc. which are attached to the owner. Therefore, a delete action 

will be logged in the “Audit trail” spreadsheet for each associated deleted record. The Audit 

Trail spreadsheet lists: the user taking the action, date and time of actions, name of relevant 

tables. Prior to performing a delete action, a warning message is generated by SMS4DC. No 

“undo” is possible after deleting a record. 

Update … Updates an existing record in the corresponding table. The Audit Trail spreadsheet lists: the 

user taking the action, date and time of action, name of the relevant table. No “undo” is 

possible after deleting a record. 

{Fixed, Land 

Mobile or 

Broadcasting} 

License Generated 

Issues and prints a license for Fixed, Mobile or Broadcasting stations. A record is generated 

in the “Audit trial” spreadsheet for each print of a multiple print out. 

Invoice creation Issues an invoice and prints a billing letter for Fixed, Mobile or Broadcasting stations in a 

license. 

Assign antenna Adds an antenna to the Antenna Library. 

BR notification 

generated 

Generates an ITU BR notification XML file. 

  

 Users: This item allows the “Supervisor” to create a new user account or modify an 

existing account. Application of this item explained fully in Section 3.2. 

 Backup: This item builds and saves a backup file of the SMS4DC database into the 

default path “…\SMS4DC\BackUp” or a user-defined location. After selecting this item 

the user is requested to specify a directory where backup files will be created. The date of 

the backup file creation will be included in the name of backup mdb file, i.e. SMS-

Newyyymmdd.mdb. It is recommended strongly that a backup, using this command, is 

made on a regular and systematic basis. The following instruction will restore the 

database from the backup database file: 

1. Deleting “yyymmdd” part of backup filename; 

2. Copying mdb file into the folder “…\SMS4DC\DB”  

 

 Display Selected Earth Station(s): This item is designed to display Earth stations which 

have been selected from the database. Choosing this item displays a spreadsheet of Earth 

stations so that one or more Earth stations may be selected using a mouse left click. After 

pushing the “OK” button, the selected earth stations will be displayed on the DEM 

without panning the DEM to the location of these stations. 

Helpful functions are implemented in the spreadsheet of Earth stations. Users may select 

rows and columns by mouse left-click on the corresponding rows of the record-select 

column (first column from left) and field name respectively. The colour of the selected 

rows changes to yellow while the colour of the selected column is dark-blue. A mouse left 

click on the top of the record-select column selects all records. Moreover, two push 
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buttons are provided to sort the list of stations, in ascending or descending alpha-numeric 

order, with respect to the “IDst” column (by default) or any other selected column. The 

third button can be used to export the selected rows in CSV (Comma Separated Values) 

format. Figure 3.47 displays the spreadsheet of earth stations. 

 

Figure 3.47. Spreadsheet of stations with some selections 

 
 

 Earth Station(s) in Desktop: This item provides a similar function to the item “Display 

Selected Earth Station(s)” (explained in the previous bullet) except the DEM is panned to 

the location of selected stations if the selected stations are located on the four adjacent 

DEM tiles. If selected stations are not in four adjacent DEM tiles, the intermediate four 

adjacent tiles will be loaded to the desktop. For more information on map manipulation in 

SMS4DC software refer to Chapter 1. 

 Move Earth Station: This item enables the user to move an earth station to a new location 

using the mouse. At least one earth station must be displayed on the DEM to activate the 

“Move Earth Station” item, otherwise the item will be “grayed out” on the menu. 

Selection of this item will cause a check mark to appear on the left of the item and the 

“Move Earth Station” toolbar button will be activated (see Section 3.4.1). To move an 

Earth station, the user clicks and holds the right mouse button on the symbol of the 

required Earth station, then drags it to the proposed new location. When the mouse right 

button is released a message box pops-up to request the user to confirm/approve saving 

the new location. Reselecting (mouse right click on) this item removes the check mark 

from the item and deactivates the “Move Earth Station” toolbar button. 

 Add Earth Station: This enables users to add an Earth station at the mouse position and 

save the corresponding information in the working database. Selecting the item changes 

the mouse cursor to the “+” shape, this is moved to the proposed location of the new Earth 

station. A left mouse click displays a data entry mask to input information about the new 

station. The geographical coordinates and terrain height of mouse location are loaded 

automatically into the corresponding entries in the mask. Figure3.48 shows the data entry 

mask. The newly created record for the Earth station will be saved in the folder for 

Anonymous Stations in the Administrative Window. 
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Figure 3.48. Data entry mask to enter information for a new Earth station 

 
 

 Search Earth Station: This item displays an Earth station symbol at the locations of all 

stations located in a user selected area. To activate this item, an area must be selected in 

advance by “Draw Box” or “Draw Box from Database” toolbar buttons.  

 Remove Earth Stations from Display: This item removes the symbols of all Earth stations 

displayed on the DEM.  

 Display Receiving Area: This item displays a predefined receiving area of a station. The 

receiving area (which may be: circle, zone or multipoint) must be defined previously by 

means of the “Add Receiver” push button function on the frequency level of the 

concerned station in the Administrative window. All stations with predefined receiving 

area will be listed in a spreadsheet and the concerned station may be selected using a 

mouse left click on the record-select column of the spreadsheet. After selecting the 

wanted station, a vector-style dialogue box appears which enables the user to adjust line 

colour and style, as well as the fill style inside the area (see Figure3.49). Once the 

parameters have been determined, the receiving area of the wanted station will be 

displayed on the DEM map as shown in Figure3.50.  

 

Figure 3.49. Spreadsheet of stations with predefined receiving area 
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Figure 3.50. Sample output of Display Receiving Area function  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Display Service Area (FXM): This item displays a predefined service area of a station in 

the fixed or land mobile service. A service area of a station is defined at the station level 

in the Licensing/Administrative window and may be: a circle (by entering Latitude, 

Longitude and Radius of Service and selecting the Station Type field as Fixed) or zone 

(by entering Area of Transmission and selecting the Station Type field as Typical). All 

stations with a predefined service area will be listed in a spreadsheet and users may select 

the concerned station, using a mouse left click on the record-select column of the 

spreadsheet. When the wanted station is selected, a vector-style dialogue box appears 

which enables the user to adjust line colour and style, as well as the fill style inside the 

area (as shown in Figure 3.51). Once the parameters have been determined, the service 

area will be displayed on the DEM map as shown in Figure3.52. 

 

Figure 3.51. Spreadsheet of stations with predefined service area 
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Figure 3.52. Sample output of Display Service Area (FXM) function  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Display Service Area (GE06 BC, BT): This item displays the service area test points of a 

broadcasting assignment in the GE06 Plan. The service area test points are added to this 

assignment by the service area function under the GE06 sub-menu. All assignments (in 

conformity with GE06 Plan) within the predefined service area will be listed in a 

spreadsheet and users may select the concerned assignment, using a mouse left click on 

the record-select column of spreadsheet. When the wanted assignment is selected, a 

vector-style dialogue box appears which enables the user to adjust the line colour and 

style, as well as the fill style inside the area (see Figure 3.53 Once the parameters have 

been determined, the service area of the wanted assignment will be displayed on the DEM 

map, as shown in Figure 3.53. 

 

Figure 3.53. Spreadsheet of broadcasting assignments in GE06 Plan with predefined service area 
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Figure 3.54. Sample output of Display Service Area (GE06 BC, BT) function  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Display Allotment Area: this item displays the predefined allotment area test points of a 

broadcasting allotment in the GE06 Plan. Allotment area tests points are added to an 

allotment by the “Define Allotment Area” function under the Database menu, or in the 

Licensing/Administrative data window in the Allotments folder by using a mouse right 

click on a required Allotment Name to display the sub-menu items: “Adding a new 

contour” or “Attach contour”. All allotments (in conformity with GE06 Plan) with 

predefined allotment areas will be listed in a spreadsheet and users may select the 

concerned allotment, using a mouse left click on the record-select column of the 

spreadsheet. After selecting the wanted allotment, a vector-style dialogue box appears 

which enables the user to adjust line colour and style, as well as fill style inside the area, 

as illustrated in Figure 3.55. Once the parameters have been determined, the allotment 

area of the wanted allotment will be displayed on DEM map, as shown in Figure3.56. 

 

Figure 3.55. Spreadsheet of broadcasting allotments in GE06 Plan with predefined allotment area 
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Figure 3.56. Sample output of Display Allotment Area function  

 

 

 

 

 

 

 

 

 

 

 

 

 Define Allotment Area: This item defines an allotment area for a broadcasting allotment 

in the GE06 Plan. As the first step, the user should draw a polyline around the edge of the 

desired allotment area on DEM map (see the example in Figure3.57). Then this function 

will be activated and can be selected by the user. All allotments (in conformity with GE06 

Plan) will be listed in a spreadsheet and users may select the concerned allotment, as 

shown in Figure3.58. When the wanted allotment is selected, the allotment area will be 

added. 

 Figure 3.57. Desired allotment area on DEM map 

 

 

 

 

 

 

 

 

 

 

Figure 3.58. Spreadsheet of broadcasting allotments in GE06 
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 Display GE06 Plan Entry: This item displays the Plan Entry Code and linked assignments 

and/ or associated allotment with selected assignment/allotment in GE06 Plan. All 

allotments/assignments (in conformity with GE06 Plan) will be listed in a spreadsheet and 

users may select an allotment/assignment, using a mouse left click on the record-select 

column of the spreadsheet (see Figure3.59). After selection, another spreadsheet appears, 

listing the wanted assignment/allotment and its linked assignments and/or associated 

allotment with their general information (see Figure3.60Figure 3.60), from which users 

can select some or all of them by a mouse left click on the record select column. By 

pushing the OK button after selection, they are displayed on the DEM map (see 

Figure3.61). 

 

Figure 3.59. Spreadsheet of broadcasting assignments/allotments in GE06 Plan  

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.60. Sample output of Display GE06 Plan Entry  

 

 

 

 

 

 

 

Figure 3.61. Sample output of Display GE06 Plan Entry  
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 Display Converted Assignments: This item displays converted assignments stemmed 

from a selected allotment, or displays the source allotment of a selected converted 

assignment in the GE06 Plan. All allotments and converted assignments (in conformity 

with GE06 Plan) will be listed in a spreadsheet and users may select the wanted 

allotment/assignment, using a mouse left click on the record-select column of spreadsheet 

(see Figure3.62). After selection, another spreadsheet appears listing the source allotment 

and all related converted assignments, with their general information (see Figure3.63), 

from which users can select some or all of them by mouse left click on record select 

column. After pushing the OK button they are displayed on the DEM map (see Figure 

3.64). 

 

Figure 3.62. Spreadsheet of broadcasting allotments or converted assignments in GE06 Plan  

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.63. Sample output of Display Converted Assignments  
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Figure 3.64. Sample output of Display Converted Assignments on DEM 

 

 

 

 

 

 
 

 

 

3.4.2.9. Propagation Models menu of DEM view 

This menu provides access to a range of field-strength calculations along a line, poly-line, inside 

a selected rectangular area and at end-points of a link. A variety of propagation models is 

available: free-space, LOS (line of sight), ITU-R recommendation P.1546, ITU-R 

recommendation P.1812, ITU-R recommendation P.370, Okumura-Hata, ITU-R recommendation 

P.526 (considering both diffraction and smooth earth models separately), ITU-R recommendation 

P.452 and ITU-R recommendation P.530. Two types of network processing are available using 

the following propagation models: free-space, ITU-R recommendation P.370, ITU-R 

recommendation P.1546, ITU-R recommendation P.1812 and Okumura-Hata. Moreover, an item 

for the calculation of Earth-space path loss, using ITU-R recommendation P.618 propagation 

model, is available in this menu. For each propagation model, Table 3.2 shows a summary of the 

functions available in the sub-item menu of the propagation menu. 

 

Table 3.2. Propagation Models (1)  and the sub-item menu of functions available for each propagation model  

 

    Sub-items 

Propagation Models 

L
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e
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o
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Network processor 
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Max. Field 

Strength 

Best 

Serve

r 

Free Space Y Y Y N N Y Y N 

Line of Sight Y Y Y N N N N N 

ITU-R P.370 Y Y Y Y Y Y Y N 

ITU-R P.1546 Y Y Y Y Y Y Y N 

ITU-R P.1812 Y Y Y Y Y Y Y N 

Okumura-Hata N N Y N N Y Y N 

ITU-R P.526 (by diffraction) N N N Y N N N N 

ITU-R P.526 (Smooth Earth) N N N Y N N N N 

ITU-R P.452 N N N Y N N N N 

ITU-R P.530 N N N Y N N N N 

ITU-R P.618 N N N N N N N Y 

(1): ‘Y’ and ‘N’ stand for “Yes” and “No” respectively. 
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The last item in the “Propagation Models” menu enables users to overlay calculation results 

inside a rectangular area on background DEM. 

With reference to the latest ITU-R recommendation, each propagation model in Table 3.2 has its 

own parameter-set and can be customized by users by using the relevant dialogue box. Table 3.3 

shows the dialogue box of parameters for each model. 

 

Table 3.3. Parameters of different propagation models 

Propagation 

Model 
Parameters Dialogue Box of Parameters 

Free Space  

      & 

Line of 

Sight 

 k-factor in the range –20 to  

–0.01 and 0.01 to 20 

 Receiver height 

 

ITU-R P.370  Time percentage (1 to 50%) 

 Location percentage (1 to 99%) 

 Earth Curvature (k-factor) in the 

range –20 to –0.01 and 0.01 to 20 

 System type (Analogue and digital) 

 Environment (Urban Area, Rural 

Area, Suburban Area) 

 Land/Sea Discrimination key, 

 Clearance Angle key, 

 Receiver height 
 

ITU-R 

P.1546 

 Time percentage (1 to 50%) 

 Location percentage (1 to 99%) 

 Earth Curvature (k-factor) in the 

range –20 to –0.01 and 0.01 to 20 

 Land/Sea Discrimination key, 

 Clearance Angle key, 

 Service (Urban Mobile, Suburban or 

Rolling hills Mobile, Analogue 

Broadcasting, Digital broadcasting) 

 Receiver height 

 Environment (Open Area, Rural Area, 

Urban Area, Dense Urban Area, 

Suburban Area) 

 

ITU-R 

P.1812 

 Time percentage (1 to 50%) 

 Location percentage (1 to 99%) 

 Clutter Type (Water/Sea, 

Open/rural,Suburban, Urban/ 

trees/forest, Dense urban 

 ) Service (Mobile, Analogue 

Broadcasting, Digital broadcasting) 

 InDoor/OutDoor 

 Receiver height  
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Okumura- 

Hata 
 Hata Equation (User Defined): 

enables user to customize equation 

coefficients 

 Receiver height 

 Earth Curvature (k-factor) in the 

range –20 to –0.01 and 0.01 to 20 

 Environment (Open Area, Rural Area, 

Urban Area, Dense Urban Area, 

Suburban Area)  

ITU-R P.526 

(by 

diffraction) 

 k-factor in the range –20 to  

–0.01 and 0.01 to 20 

 

ITU-R P.526 

(Smooth 

earth from 

P.527) 

 Type of terrain (A: Sea Water, B: Wet 

Ground, C: Fresh Water, D: Medium 

Dry Ground, E: Very Dry Ground, F: 

Pure Water, G: -1ºC Ice, G:  -10ºC 

Ice) 

 k-factor in the range –20 to  

–0.01 and 0.01 to 20  

ITU-R P.452  Time percentage (0.001 to 50%) 

 Pressure (hPa) 

 Tempreture (C) 

 Clutter Type 

 Average Year / Worst-Month 

Prediction 

 

ITU-R P.530  Predicted k-factor for 99.99% 

 k-factor in the range –20 to  

–0.01 and 0.01 to 20 

 Fresnel Zone number 

 Annual/ Worst-Month Availability 

 Quick Plannin Option 

 Reference atmosphere based on ITU-

R Rec. P.835 

 Climatic region based on ITU-R Rec. 

P.841 

 

ITU-R P.618 Explained in Section 3.4.2.9.1  

 

The following paragraphs describe the different calculation functions that are available in sub-

menus for the propagation models. Table 3.2 summarises the functions available for each model. 

The Earth-space propagation model, ITU-R P.618, is explained separately in Section 3.4.2.9.1. 
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 Calculation along a line: This function calculates field strength values produced by a 

station along a path profile at a given receiving height above ground level. However, in 

the case of the line-of-sight (LOS) model, the “Line” calculation sub-item provides only a 

visibility analysis along the line from the wanted station. To activate the “Line” sub-

items, a line must be drawn in advance on the DEM using “Draw Line” or “Draw Line 

from Database” toolbar buttons (see Section 3.4.1). By choosing the “Line” sub-item, a 

spreadsheet of stations in the database is opened and users may select a station (preferably 

near to the depicted line) by a mouse left click on the corresponding row of the record-

select column. After pushing the OK button, a dialogue box is presented that contains 

several parameters, the values of which may be customized for use in the model. Each 

model has its own parameter dialogue box which is explained in the Table 3.3. 

Once the user approves the values in the parameter dialogue box, a 2D plot appears, 

displaying two curves: path profile and field strength value. In the case of the LOS model, 

only a path profile is displayed, in which portions of the profile are filled with red, if a 

line-of-sight to the selected station exists, or blue if there is no LOS. The graph is 

equipped with a vertical marker which is movable horizontally by the mouse while 

holding the left click. The geographical coordinates, terrain height, ground-distance from 

the left point (beginning point of the line) and field strength value (dBµV/m), or visibility 

status in the case of the LOS model, at the position of the vertical marker are displayed on 

the status bar. Figure3.65 shows a visibility analysis plot using the LOS model and 

Figure3.66 shows a sample plot of field-strength values along a profile using ITU-R P.370 

propagation models. 

 

Figure 3.65. “Line” calculation sub-item using “Line of Sight” model 

 (visibility check). Blue : No LOS, and red: LOS to the concerned station 
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Figure 3.66. A sample plot of field-strength values along a profile using 

 ITU-R P.370 propagation model (path profile in blue and field strength in brown) 

 
 

Displayed 2D plots can be printed through Windows standard printing function from 

“File” menu. 

Calculation along poly line: This calculates field strength values produced by a selected 

station along a polyline at a given receiving height above ground level. However, 

performing a “Polyline” calculation using the “Line of Sight” model provides only a 

visibility analysis from the polyline to the selected station. To activate “Polyline” sub-

items, a polyline must be drawn on the DEM using the “Draw Polyline” toolbar button 

(Section 3.4.1). After choosing the “Polyline” sub-item, a spreadsheet of stations in 

database is opened and users may select a station (preferably near to the poly line drawn 

on the DEM) by a mouse left click on the corresponding row of the record-select column. 

After pushing the OK button, a dialogue box is presented that contains several parameters, 

the values of which may be customized for use in the model. Each model has its own 

parameter dialogue box, previously explained in Table 3.3. Once the user approves the 

values in the parameter dialogue box, a 2D plot appears, displaying two curves: path 

profile and field strength value. In the case of the LOS model, only a path profile is 

displayed, in which portions of the profile are filled with red, if a line-of-sight to the 

selected station exists, or blue if there is no LOS. The graph is equipped with a vertical 

marker which is movable horizontally by the mouse while holding the left click. The 

geographical coordinates, terrain height, ground-distance from the left point (beginning 

point of the line) and field strength value (dBµV/m), or visibility status in the case of the 

LOS model, at the position of the vertical marker are displayed on the status bar. Figure 

3.67 displays a visibility analysis (LOS model) along a poly line and Figure 3.68 

illustrates a sample plot of field-strength values along a poly line calculated using the 

ITU-R P.370 propagation model. 
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Figure 3.67. “Polyline” calculation sub-item using “Line of Sight” model 

 (visibility check). Blue : No LOS, and red: LOS to the concerned station 

 
 

 

Figure 3.68. A sample plot of field-strength values along a poly line using 

 ITU-R P.370 propagation model (path profile in blue and field strength in brown) 

 
 

Poly line points along path can be distinguished by ‘o’ symbol. Displayed 2D plots can be 

printed through Windows standard printing function from “File” menu. 
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 Area calculation: This calculates of field strength values produced by a selected station 

inside a rectangular area at a given receiving height above ground level. However, 

performing an “Area” calculation sub-item using the “Line of Sight” model provides only 

visibility analysis from the selected station to the area. To activate the “Area” sub-items a 

rectangular area must be drawn in advance on the DEM using the “Draw Box” or “Draw 

Box from Database” toolbar buttons (see Section 3.4.1). By choosing “Area” sub-item, a 

spreadsheet of stations in the database is opened and users may select a station inside the 

area by a mouse left click on the corresponding row of the record-select column. Selection 

of stations outside of the rectangle will cause a warning message and there will be no 

further action. After pushing the OK button, a dialogue box is presented that contains 

several parameters, the values of which may be customized for use in the model. Each 

model has its own parameter dialogue box, previously explained in Table 3.3. 

When the user approves the values in the dialogue box of parameters, a new window 

appears and the area-calculation progress bar is displayed simultaneously in the status bar. 

Once the calculation process has finished, the area-calculation result will appear in the 

new window. The geographical coordinates, terrain height, distance to the reference 

station and field strength value (dBµV/m), at the current mouse cursor position, are 

displayed on the status bar. In the case of the LOS model, only a visibility analysis will be 

displayed, showing those parts of the selected area with line of sight (LOS) to the selected 

station in red and those parts without LOS in blue. Figure3.69 displays an example of a 

visibility analysis of a selected area with respect to a given station. Figure3.70 displays 

sample results using ITU-R P.370, Okumura-Hata and free-space propagation models. 

 

Figure 3.69. “Area” calculation sub-item using “Line of Sight” model 

 (visibility check). Blue : No LOS, and red: LOS to the concerned station 
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Figure 3.70. Area calculation using a) ITU-R P.370 

 propagation model, b) Okumura-Hata, and c) Free Space propagation models 

 
(a) Area calculation using ITU-R P.370 propagation model 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(b) Area calculation using Okumura-Hata model                    (c) Area calculation using Free-Space model 

 

Two toolbar buttons: “Refresh” and “Show Legend” are active in the area calculation 

result window, which is explained in Section 3.4.1. Moreover, several helpful items are 

implemented under the “Tools” menu that provides functions for the 2D field-strength 

values. This menu is explained in Section 3.4.2.9.2. 
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 Link calculation: This item applies specific propagation models for the calculation of a 

link budget. Table 3.2 shows the propagation models that may be used for link budget 

calculations. Selecting this menu item opens a spreadsheet of stations in the database from 

which two stations may be selected to form a link. Stations are selected by a mouse left 

click on the relevant row of the record-select column. After selection of the stations, a 

dialogue box of propagation model parameters will appear. By confirming the values for 

these parameters, a link calculation dialogue box is presented, displaying the calculation 

results as well as providing a visual user-interface to optimize the link characteristics. The 

link calculation dialogue box contains: a path profile diagram, the first Fresnel zone, Earth 

curvature and those technical characteristics of a link that are relevant to the propagation 

model in use. Figure3.71 displays the link calculation dialogue box using the ITU-R 

P.370 propagation model. 

 

Figure 3.71. Link calculation dialogue box using the ITU-R P.370 propagation 

 model, calculation direction a) from left to right and b) from right to left 

 

 

 

 

 

 

 

 

The “Link” push button, on the top-right of the dialogue box, enables the calculation of 

link characteristics and values, displayed on a coloured background, with initial values for 

the relevant parameters shown in edit boxes for each side (station) of the link. Using the  

 

two radio buttons on the top-right of the dialogue box, the direction of the link can be 

reversed and the link budget re-calculated for the opposite direction of transmission. 

Some of the values in the dialogue box are presented in edit-boxes so they may be 

changed by the user to optimise the link. These edit boxes change mode automatically, 

depending on the direction of the link, so they will accept data entry if the link is in one 

direction but when the link direction is reversed, they display a result of the calculation in 

a coloured, non-editable box. As shown in Table 3.3, link calculation using different 

propagation models also requires different technical parameters. Accordingly, calculation 

results are different for different propagation models. The most comprehensive result is 

obtained using the ITU-R P.530 model. Figure3.72 shows the link calculation dialogue 

box using different propagation models. 

A vertical marker is also provided along displayed 2D plots. This can be moved 

horizontally by holding a mouse right button. The geographical coordinates, profile height 

and distance from the left side for the marker current position are displayed on status bar. 

 



 
99 

Figure 3.72. Link calculation dialogue box using different propagation models 

 
       

               

 

 

 

 

 

 

 

 

 

 

(a) Using P.452                          (b) Using ITU-R P.526 with diffraction  
 

                                                                                 

 

   

 

 

 

 

 

 

 

 

 

 

     (c) Using ITU-R P526 with smooth earth    (d) Using ITU-R P.530 
  

 

 

 

 

 

 

 

 

 

      

 (e) Using ITU-R P.530, reflection points, availability 

            calculation and text file profile data 
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The ITU-R P.530 link calculation dialogue box allows the height of the antennas to be 

optimized visually by dragging them to a new height using a mouse right click and hold. 

Releasing the mouse button after changing the antenna height causes the reflection paths, 

as well as the link characteristics, to be re-calculated automatically. 

 Field Strength Contour: This item saves and displays field strength contours around a 

selected station where the field strength values inside the contour are higher than a given 

threshold. A dialogue box of the propagation model requests the user to enter a threshold 

value for this parameter. 

When this item is selected, a spreadsheet of stations in the database opens so that a station 

may be selected by a mouse left click on the relevant row of the record-select column. 

After selection of a station, a propagation model parameter-entry dialogue box will 

appear. In case of model P.370, an additional parameter, Δh, is required. This parameter 

defines the degree of terrain irregularity; for broadcasting services it is applied in the 

range 10 km to 50 km from the transmitter. 

After confirming the values for the model to use, the user is asked to specify the folder in 

which the vector text file is to be saved and then the calculation progress bar is displayed. 

When the calculation has finished, a vector-style dialogue box appears which enables the 

user to adjust line colour and style as well as fill style inside the contour. Finally, the 

resulting contour will be drawn on the background DEM. Figure3.73 shows a sample 

field strength contour and vector-style dialogue box. 

 

Figure 3.73. A sample field strength contour and vector style dialogue box 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Maximum Field Strength: This item calculates and displays the maximum value of field 

strength values produced by more than one transmitting stations at any point inside a 

predefined rectangular area. Prior to the selection of this sub-item, a rectangular area must 

be selected using the “Draw Box” or “Draw Box from Database” toolbar buttons (se 

Section 3.4.1). Then, the stations inside the selected area will be listed to enable the user 

to select several stations. Stations are selected by a mouse left click on the corresponding 

rows of the record-select column. A dialogue box of propagation model parameters opens 

after the station selection is completed. The area calculation progress bar will be 
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displayed and the maximum field strength values at each pixel will be displayed after the 

calculation has finished. The calculation time depends on the number of stations selected 

and the size of the calculation area. Figure 3.74 demonstrates an application of the 

maximum field strength function using different propagation models in an analysis of a 

three-station network. 

 

Figure 3.74. Application of maximum field strength method in analysis of  

a three-station network using a) ITU-R P.370, b) Okumura-Hata and c) Free-Space propagation models 

 
(a) Using ITU-R P.370 propagation model 

 
(b) Using Okumura-Hata propagation model 
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(c) Using Free-Space model 

 

The status bar, in this application, shows country name, administration code, geographical 

coordinates, altitude (in metres), and maximum field strength value at the position of the 

mouse cursor. 

 Best Server: This item calculates and displays the best serving station, among various 

stations, at each point inside a predefined rectangular area. Prior to the selection of this 

sub-item, a rectangular area must be selected using the “Draw Box” or “Draw Box from 

Database” toolbar buttons (see Section 3.4.1). Then, the stations inside the selected area 

will be listed to enable the user to select several stations. Stations are selected by a mouse 

left click on the corresponding rows of the record-select column. A dialogue box of 

propagation model parameters opens after the station selection is completed. The area 

calculation progress bar will be displayed and the areas covered by different stations 

distinguished by different colours. The calculation time depends on the number of stations 

selected and the size of the calculation area. Figure 3.75 and Figure 3.76 demonstrate an 

application of the best server function using different propagation models in an analysis 

of a three-station network. 
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Figure 3.75. Three-station network processing using best server function 

 using P.370 propagation model a) without considering clearance angle and, b) considering clearance angle 

 

 

 

 

 

 

 

 

 

 
 

  (a) Best server result without considering clearance angle          (b) Best server result considering clearance angle 

 

Figure 3.76. Application of best server function in an analysis of  

a three-station network using a) Okumura-Hata and b) Free-Space propagation models 

 

 

 

 

 

 

 

 

 

 
 

 

            (a) Using Okumura-Hata propagation model                        (b) Using Free-Space propagation model 

 

In this application, the legend colour distinguishes the best served areas of each station. 

The country name, administration code, geographical coordinates, altitude(in metres) and 

the best serving station name at the mouse cursors current position are presented on the 

status bar. 

 

3.4.2.9.1. Menu of propagation models, P.618 propagation model 

The ITU-R P.618 propagation model is used to calculate the Earth-space radiocommunication 

path loss due to the water vapour, rain, cloud, scintillation and atmospheric gaseous. Selection of 

this item from the “Propagation Models” menu of SMS4DC desktop (DEM view) causes the 

following dialogue box to appear: 
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Figure 3.77. ITU-R P.618 propagation model dialogue box for Erath-space radiocommunication 

 
 

Users may enter the input parameters in the relevant edit boxes directly, or use the information 

about a transmitting earth station stored in the local database. Pushing the “Database” button 

opens a dialogue box which enables the user to choose an uplink frequency for an Earth station. 

A mouse left click or arrow keys can be used for navigation in the tree-view of Earth station 

information. In order to perform an uplink calculation, a transmitting frequency must be selected 

by a double left-click on the frequency. Figure 3.78 shows the uplink frequency selection 

dialogue box. Data base information for the selected earth station and uplink frequency are 

available in the right side of dialogue box. 

By finalizing the selection of the uplink frequency, the relevant emission information will be 

uploaded to the edit box of the propagation model dialogue box.  
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Figure 3.78. Uplink frequency selection dialogue box 

 
 

Once the input values have been provided, the values of different attenuations may be calculated 

by pushing the “Calculation” button at the bottom of the propagation model dialogue box. 

Depending to the various methods described in the ITU-R recommendations P.676 and P.836 for 

estimation of gaseous attenuation, two asymptotic values are calculated for total attenuation. 

 

3.4.2.9.2. Tools menu of area calculation window 

Several helpful items that function on the 2D field-strength values are implemented under the 

“Tools” menu of the area calculation window. The Area calculation window, itself, displays the 

2D field strength values produced by a station inside a rectangular area. This type of calculation 

can be launched through the “Area” sub-items of propagation models provided in the 

“Propagation Models” menu of SMS4DC desktop, DEM view. 

The following items are provided under this “Tools” menu: 

 Normalize: Changes the colour display range of field-strength values by changing the 

minimum and maximum thresholds of field strength value (also see Tools->Legend for 

the colour scale). Points with field strength values higher and lower than the defined value 

range will be displayed by two colours shown at the bottom and top of the Legend colour 

scale; values between the maximum and minimum will be represented by the range of 

colours shown in the Legend colour scale. Figure 3.79 displays a sample of applied value 

range. The old values are those values which are suggested by SMS4DC based on 

minimum and maximum field strength value of points loaded into the memory from 2D 

area calculation result. Moreover, the short-key Ctrl+N is assigned to this item. 
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Figure 3.79. Normalized area calculation result 

 
 

 Colour map: Changes the colour map used in the display of field strength values in the 

area calculation window. Figure 3.22 shows the available colour maps. Figure 3.80 shows 

an example of selecting the copper colour map on a 2D field strength view. 

 

Figure 3.80. An example of employing of copper colour map on 2D field strength view 
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 Legend: This item switches on or off the field strength colour scale legend bar. If this 

item is selected, a check mark appears to the left and, automatically, the “Show Legend” 

toolbar button will appear as “pushed”. Reselection of the item removes the check mark 

and releases the “Show Legend” toolbar button. 

 Contour Value: This item displays a continuous line (or contour) around a selected station 

by constructing and joining together a set of vector points having a calculated field 

strength value equal to a threshold value set by the user. Inside the contour, the field 

strength will be statistically higher than the threshold value, while outside the contour, the 

field strength will be lower. After selection this item, users may define a threshold value. 

The user is requested to specify the folder and file name in which the vector field strength 

values are to be saved in a text file. Once the location and file name have been entered, 

SMS4DC starts to generate the vector file and displays a calculation progress bar in status 

bar. Finally, a vector-style dialogue box appears which enables user to adjust line colour 

and style as well as the fill style inside the contour. Figure 3.81 displays some examples 

of contours for an area calculation.  

 

Figure 3.81. Example of depicted contours on an area calculation result 

 a) vector style dialogue box, b) unfilled vector, and c) filled vector 

 

 

 

 

 

 

 

 

 
 

           (a)    (b)         (c) 

 

Overlaying of multiple vectors is possible on the same area calculation result and the 

Windows printing function is available through the “File” menu. The saved vector can be 

re-loaded into an area calculation window. 

 Contour Levels: This item is useful for decreasing the number of colours by 

simultaneously increasing the level-step in “Legend”. Figure 3.82 display an example of 

the application of this feature. 
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Figure 3.82. An example for application of “Contour Levels” in the “Tool” menu 

 
 

 Draw Contour from File: This item loads and displays saved vectors into the active area 

calculation result window. Choosing this item opens a dialogue box enabling the user to 

select for display a vector file from the hard disk. After selection of the vector file, the 

vector-style dialogue box appears and users may adjust vector colour and style as well as 

fill style inside the contour. Multiple vectors with various styles may be displayed. Figure 

3.83 shows an example of the application this feature. 

 

Figure 3.83. a) Dialogue box for loading a vector file and,  

b) Contours loaded and displayed in an area calculation result window 

 

 

 

 

 

 

 

 

 

 

                                         (a) 

 

 

         (b) 

 

 Remove Contour from Display: This item removes all vectors from the active display. 

 Coverage Area: This item calculates the area in km2, inside which the field strength value 

is higher than a specified threshold value and displays the result. Selection of this item 

opens a dialogue box to request specification of a value for the field strength threshold. 
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Once the threshold value has been specified, SMS4DC draws a two-colour map in the 

result window: those areas with field strength value higher than the threshold are painted 

with the first colour and those lower than the threshold value have the second colour. The 

value of the total area is presented at the bottom of the area calculation result widow and a 

check mark appears to the item left side. Figure 3.84 displays effect of this item in the 

result window. 

 

Figure 3.84. a) Dialogue box to define threshold value and,  

b) Application of “Coverage Area” item for a sample area calculation result 

 

 

 

 

 

 

 

 

          (a) 

 

 

 

 

                (b) 

Reselection of “Coverage Area” item undoes colour map of area calculation result 

window and removes check mark from item left side. 

 Google Earth Export/Display: Selection of this menu item brings up a "Save as" screen 

(as displayed in 3.4.2.5) asking for the path and name of the result file in Google Earth 

format and also whether to execute the Google Earth application to display this file. 

 

3.4.2.10. Vectors menu of DEM view 

The “Vector” menu provides the following items to display or remove different vectors from the 

DEM: 

 Draw Circle: This item draws a circle around a station with a given radius. Performing 

this item opens the spreadsheet of stations which enables users to select a station by left 

click on relevant row of record-select column. After selection of a station, a small 

dialogue box will appear to define the radius of the circle. This circle is a helpful tool to 

identify the boundaries of circular areas around a station. 

 Draw from File: This item loads a vector file from the hard disk and displays it on the 

DEM. Selection of this item requires the user to select a vector file from the relevant 

folder on the hard disk. Then, the vector colour and fill style must be defined using a 

dialogue box. Figure 3.85 illustrates a vector of the Swiss border which has been loaded 

from a file. The location of the vector file is also printed on title bar of the vector-style 

dialogue box. 
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Figure 3.85. The “Draw from File” item of “Vector” menu and vector style definition dialogue box 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Draw Country Border: This item draws the border of a selected country on the DEM. 

After selection of this item, a list is displayed (see Figure 3.15a) of all countries for which 

boundary vectors are available in the IDWM (the latest version is installed with 

SMS4DC). Users may browse the combo-list or type the location name into the edit-box. 

Once a country has been selected, a vector-style dialogue box will appear to enable 

customisation of the line and fill style of selected country’s border. The path and folder 

name for the vector file is displayed on the title bar of the vector-style dialogue box. 

 Remove from Display: This item removes all displayed vectors from the background 

DEM. 

 Vector Handling: This menu shows the vector handling screen which enables the user to 

see the list of all the vectors loaded on the DEM and change their display characteristics 

and remove or save them. Also it is possible to directly export and show the vectors in 

Google Earth. 
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3.4.2.11. Frequency Allocations menu of DEM view 

The Frequency Allocations menu provides the user with the Regional and national frequency 

allocations table (FAT), frequency allocations chart, national frequency assignment plans and 

frequency assignment utility. The following items are implemented in this menu: 

 Draw Chart: This item shows a Section of a Regional or national FAT in the well-known 

strip format. Each segment in the frequency allocations strip denotes a frequency 

allocation to a radiocommunication service with its service priority. This view has an 

integrated toolbar, that may be used for selection of ITU Regions or national frequency 

allocations table, frequency range, type of drawing (linear or logarithmic) and RR Article 

5 footnotes. Selecting “National” in Region combo box (at left of view) enables the user 

to browse national footnotes in the footnote combo box (at right of view). The “Apply” 

push button in the toolbar updates the view in accordance with any new toolbar settings. 

Figure 3.86 displays a sample picture of FAT chart. 

 

Figure 3.86. A Section of frequency allocations chart in Region 3 

 
 

The mouse cursor shape on the strip is changed to a cross (+) and a left-click on a 

coloured patch shows its characteristics, including: frequency band, service name, service 

priority, service footnotes and frequency band footnotes at the top-left corner of chart. 

The text of the selected footnote in the relevant combo-box of the toolbar appears below 

the chart. The chart can be printed through the print item of the “File” menu. 

The “Edit” menu under the frequency allocations chart provides three powerful items: 

“Plan”, “Service Table” and “Footnotes” to edit the content of the frequency allocations 

table and chart colour. Users may browse and edit the content of integrated FATs, 

inserting up to six primary services and up to six secondary services, using the “Plan” 

item. Figure 3.87 shows the relevant dialogue box and browsing toolbar. 
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Figure 3.87. FAT browsing toolbar and dialogue box for editing the integrated FAT 

 

 
As illustrated in Figure 3.88, each row of service tables in the FAT editing dialogue box 

consists of a service combo-box (to select one of the standard radiocommunication 

services) and an edit box for its relevant service footnotes. Band footnote(s) are those 

relevant to all radiocommunication services for that frequency band. The push buttons in 

the FAT browsing toolbar are explained in Table 3.4, below. 
 

Table 3.4. Push buttons in FAT browsing toolbar in the item “Frequency Allocations->Edit->Plan” 

Toolbar 

Buttons 
Name Description 

 
Move to the 

first record 

Push button to load the allocation that has been made in the first (lowest) frequency band of the 

active FAT. 

 
Go to the 

previous 

record 

Push button to load the allocation that has been made in the previous (lower) frequency band of 

the active FAT with respect to the displayed frequency allocation on the dialogue box. Also, 

pressing Page Up key while the cursor is in the Frequency Band text boxes, does the same task. 

 
Go to the next 

record 

Push button to load the allocation that has been made in the next (higher) frequency band of the 

active FAT with respect to the displayed frequency allocation on dialogue box. Also, pressing 

Page Down key while the cursor is in the Frequency Band text boxes, does the same task. 

 
Move to the 

last record 

Push buttons to load the allocation that has been made in the last (highest) frequency band of 

active FAT. 

 
Add record Push buttons to add, to the active FAT, a new frequency band and relevant frequency 

allocations. 

 
Delete current 

record 

Push buttons to delete, from the active FAT, the current record (a frequency band and all 

relevant frequency allocations). 

 
Save current 

record 
Push buttons to save a modified allocation in the active FAT. 

 
Sort To sort the contents of a frequency allocations table (FAT) with respect to the frequency band 

(i.e. lowest frequency to highest frequency or vice versa). Normally, after the addition of a new 

frequency band to the FAT it will be appended to the database of FAT. By using this toolbar 

push button the new frequency band will take its correct position in a sorted FAT. 
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“Service table” item in the “Frequency Allocations->Draw Chart->Edit” menu enables 

user to browse and modify radiocommunication service name and colour used in the 

frequency allocations chart. Figure 3.88 displays the relevant dialogue box. 

 

Figure 3.88. a) Dialogue box for modification of legend 

 of frequency allocations chart and b) integrated standard colour palette 

 

 

 

 

 

 

 

(a) Dialogue box for modification of legend 

            of frequency allocations chart 

 

        (b) Standard colour palette 

 

The same toolbar (previously explained for “Frequency Allocations->Draw Chart->Edit-

>Plan” item) is also available in this item to browse and save modifications. Table 3.4 

explains the functions of the toolbar push buttons. The last item “Frequency Allocations-

>Draw Chart->Edit->Footnote” provides the user with a facility for footnote modification 

or definition. Figure 3.89 displays the dialogue box for the footnote editor associated with 

this item. 
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Figure 3.89. International or national footnote editor a) International, b) National 

 

 

 

 

 

 

 

 

 

 

 

a) Editing a Regional footnote    b) Editing a National footnote 

 

Users have the freedom to type any footnote text in the one of the Windows-supported 

languages. The default language of the footnote editor is the SMS4DC preferred language 

which is selected during logon. CTRL+Enter is necessary to start a new line. Depending 

on the type of uploaded background FAT, a table of Regional or National footnotes will 

be available for modification. Moreover, users are able to add more footnotes to the 

footnote list of an active FAT. Table 3.4 contains a description of the browsing toolbar 

integrated with the footnote editor dialogue box. The new footnotes may be assigned to 

the sub-bands of the FAT using “Frequency Allocations->Edit->Plan” item (Figure 3.87). 

 Frequency Arrangement: Item to browse, define and report national frequency 

arrangement plans in one of the three possible formats: homogeneous, uniform and non-

uniform. As shown in Figure 3.90, for each type of arrangement, which may be selected 

from the combo box “Type of Frequency Plan”, a different set of parameters is required. 

The content of the dialogue box format changes in accordance with the different types of 

frequency arrangement. A spreadsheet is added to the dialogue box to display the centre 

frequency of the active frequency plan. This spreadsheet can be edited directly in the case 

of non-uniform channelling plan. Frequency plans created by means of the frequency 

arrangement dialogue box are used for national frequency assignment (i.e. for the user 

country specified during first execution of the SMS4DC software). Table 3.5 explains the 

dialogue box content.  
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Table 3.5. Description of Frequency Arrangement dialogue box (1) 

Item Description H U N 

Frequency Plan ID 

An ID which is generated by SMS4DC, automatically in case of 

homogeneous and uniform channel arrangements, by a combination of 

reference frequency and channel spacing. In the case of non-uniform 

arrangement, the ID must be specified by the user.  

X X X 

Region 
The ITU Region of the frequency allocation table in which frequency 

arrangement plan is defined. 
X X X 

Service Priority Priority of service in which frequency assignment plan is defined. X X X 

Type of  

Frequency Plan 

A combo box to select one of three available frequency arrangement 

formats. The dialogue box reconfigures according to the plan type. 
X X X 

Channel Spacing Frequency distance XS between centre frequencies of two adjacent 

channels. 
X X 

 

Reference 

Frequency 

Frequency used as a reference to calculate centre frequencies in 

homogeneous and uniform frequency arrangement plans. 
X X 

 

Lower and Upper 

Frequency Offsets 

Frequency offsets to calculate “go” and “return” centre frequencies 

tabulated in “Frequency List” spreadsheet. 
X 

  

Number of 

Channels 

Number of duplex paired or simplex channels defined in plan. 
X X X 

First:… Last: … The first and the last channel numbers in a plan. X X  

Channel Set 
One of “All”, “Odd” or “Even” channel set which have their centre 

frequencies in the plan (spreadsheet of frequency list). 
X X  

Comment Any comment relevant to the current frequency arrangement. X X X 

 
Push buttons to load the first (lowest) frequency arrangement. X X X 

 
Push button to load the previous (lower) frequency arrangement. X X X 

 
Push button to load the next (higher) frequency arrangement. X X X 

 
Push buttons to load the last (highest) frequency arrangement. X X X 

 
Push buttons to reset the dialogue box for addition of a new frequency 

arrangement. 
X X X 

 
Push buttons to delete current frequency arrangement. X X X 

 
Push buttons to save modified or new frequency arrangement. Pushing 

this button is necessary after any modification to the frequency list in 

case of non-uniform frequency arrangements. 

X X X 

 
Push button to display and provide a report of a current frequency 

arrangement Figure 3.91). This report can be saved in a text file. 
X X X 

,  
Push button to sort spreadsheet of frequency list, ascending or 

descending, with respect to a selected or “No” (i.e. channel number) 

column. Selection of a column can be made by mouse left-click on field 

name. 

X X X 

“Add channel” 

push button 

Push button to add a new row in the frequency list for addition of a new 

frequency pair with the relevant bandwidth in a non-uniform frequency 

plan. 

  X 

“Delete channel” 

push button 

Push button to delete a selected row from the frequency list and to 

remove a frequency pair in a non-uniform frequency plan. 
  X 

Frequency List List of centre frequencies which have been calculated or entered directly.  X X X 

       (1)
: H, U and N stand for Homogeneous, Uniform and Non-uniform channel arrangement plans 
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Figure 3.90. Frequency arrangement definition dialogue box for the three frequency plan types 

 

 

 

 

 

 

 

 

 

 

 
 

 

(a) Homogeneous channel arrangement 

 

 

 

 

 

 

 

 

 

 

 

 

 

(b) Uniform channel arrangement 

 

 

 

 

 

 

 

 

 

 

 
 

(c) Non-uniform channel arrangement 
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Figure 3.91. Report of frequency arrangement plan 

 
 

 Frequency Table: This item displays all assignable frequencies of all frequency 

arrangement plans. Two push buttons are provided to sort the list, ascending or 

descending, with respect to the ID (by default) or any other selected column. Selection of 

a column can be made by a mouse left-click on field name. Currently, the “OK” push 

button has no function. 

 

Figure 3.92. Spreadsheet of frequencies assignable through approved frequency plans 

 



 
118 

 Frequency Assignment: This item assigns a frequency to a selected station after 

calculation of potential interference caused to or received from any other stations of all 

(mobile, fixed, broadcast)  radiocommunication services in a given frequency band inside 

a circular search area. The procedure starts by selecting from a list of stations the national 

station for which a transmitting frequency assignment has been requested (a national 

station is a station which is located inside the default country of SMS4DC). Since the 

number of national stations stored in the local database may become thousands, SMS4DC 

makes it easier to find the concerned station by applying a frequency condition (filter). 

This filter shortens the list to show only those stations within a limited frequency range 

specified to include the concerned station. Therefore, whenever this item is selected, a 

dialogue box is opened for the user to define the frequency range in which an assignment 

is required and thereby limit the number of stations listed in the station selection 

spreadsheet. When the spreadsheet of national stations is displayed, the concerned station 

may be easily identified and selected for a frequency assignment. Figure 3.93 displays the 

dialogue box to narrow frequency range and list of stations with frequencies in range.  

 

Figure 3.93. a) Dialogue box of initial frequency range definition and b) Spreadsheet of concerned stations 

 

 

 

 

 

 

 

 

 (a) Frequency range 

 

 
                 (b) List of stations which contains the concerned station 

 

Selection of a station can be made by a left click on the record-select column of the 

concerned row. Assignment parameters must be set after station selection. Figure 3.94a 

shows the assignment parameters dialogue box. The assignment algorithm searches for 

suitable channels to assign within any channel plan arrangement in the range between 

Fmin and Fmax. Then, all existing stations within the “Channel Scan Range” of each 

channel in that plan and within the search radius specified are examined for potential 

interference. Therefore, to ensure adjacent channels are examined for interference, the 

“Channel Scan Range” must be greater than zero and may usually be set to the channel 

spacing for the applicable channel arrangement. Once the assignment parameters have 

been set, all frequencies available within those parameters are examined for potential 

interference and the results are displayed in the result dialogue box. Figure 3.94b displays 

the result of investigation for assignable frequencies. 
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Figure 3.94. a) Frequency assignment parameters and b) Result of investigation for assignable frequencies 

 

 

 

 

 

 

 
 

(a) Frequency assignment parameters 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

(b) Result of investigation for assignable frequencies (prior to interference calculation for a selected frequency) 

 

SMS4DC looks for all available frequencies in the table of assignable frequencies (Figure 

3.92) between frequencies Fmin and Fmax, as entered in the “Assignment Parameters” 

dialogue box. The frequencies of channels identified by this search procedure are listed in 

the first and second columns of a spreadsheet frequency list. For two-frequency (duplex) 

channels, the second column contains the corresponding paired frequency. Then, inside 

the circular area with the radius as specified in the “Assignment Parameters” dialogue 

box, a search is made in the database to identify any existing stations using the listed 

frequencies, plus/minus the Channel Scan Range. For each frequency (pair), the number 

of stations found is displayed in the column “Num of stations”. A yellow background 

colour highlights the row of any frequencies with nonzero in the column “Num of 

Stations” as having potential interference. The procedure will identify all stations within 

the range of the “Assignment Parameters” dialogue box, regardless of 

radiocommunication service.  

Choosing any row with yellow highlight from the list of frequencies by a mouse double 

left-click, initiates detailed interference calculations, both to and from the station under 

assignment, using the Free Space propagation model. The emission masks of the 

interferer and victim stations are considered for interference calculations, if these have 

been recorded in the database. The Net Filter Discrimination (NFD) value is set to zero in 

the absence of emission mask records. The result of calculations for each yellow highlight 
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frequency in the list will be displayed in the spreadsheet of “List of Stations”. Where no 

potential interference problem is found for a frequency, the second spreadsheet will 

remain blank. The fields “E1_2” and “E2_1” stand for produced field strength value, in 

dBµV/m, by concerned station on stations in the “List of Stations” and vice versa. The 

last field, with the name “dE1_2” is equal to “E1_2” minus the “Permissible Field 

Strength” value (specified in the “Assignment Parameters” dialogue box. A red 

background in the field dE1_2 indicates an interference situation. In the List of 

Frequencies spreadsheet, the colour of rows for frequencies containing with an 

interference situation is changed to red after detailed interference calculation. Figure 3.95 

displays results of detailed interference calculation for a suspect assignable frequency.   

 

Figure 3.95. Result of detailed interference calculation for a suspect assignable frequency 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After considering the results, a suitable frequency for assignment may be selected by a 

double right mouse click on the “No.” (channel number) column and the row for the 

frequency to be selected. Once the “Assign” push button is used, the selected transmitting 

frequency in the list and its corresponding receiving frequency will be assigned to the 

concerned station. If additional frequencies are to be assigned to this (or any other 

multiple frequency station), the Database -> Licensing menu should be used to add a 

“nominal” new frequency to the station in the Administrative part. However, the nominal 

frequency should then be changed to an assigned (and interference checked) frequency by 

using the Frequency Allocation -> Frequency Assignment menu procedures described 

above. 
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3.4.2.12. Coordination menu of DEM view 

This menu has sub-menu items designed to deal with different scenarios of frequency 

coordination by procedures and calculation in accordance with either: 

 

The latest versions of the following Regional Plans: 

o GE84: Regional Agreement relating to the Use of the Band 87.5 – 108 MHz for FM 

Sound Broadcasting (Region 1 and Part of Region 3) 

o ST61: Regional Administrative Conference of the Members of the Union in the European 

Broadcasting Area, Geneva, (revised in 2006) 

o GE89: Regional Administrative Conference for the Planning of VHF/UHF Television 

Broadcasting in the African Broadcasting Area and Neighbouring Countries, Geneva, 

(revised in 2006) 

o GE06: Regional Radiocommunication Conference for planning of the digital terrestrial 

broadcasting service in parts of region 1 and 3, in the frequency bands 174-230 MHz and 

470-862 MHz.  

Or country-specific, bilateral or multilateral border coordination agreements as 

described in the following sub-menus: 

o Agreement: The entry of user-defined agreements which would be utilized for border 

coordination item. 

o Border: Implementation of border coordination for concerned TX or RX stations in Fixed 

and Land Mobile service in accordance with a regional agreement. 

o HCM Agreement 

Following Sections explain sub-items under mentioned regional plans. 

 

3.4.2.12.1. GE84 sub-menu of DEM view 

The coordination of FM sound broadcasting station with stations in broadcasting, fixed and land 

mobile radiocommunication services, in accordance with the GE84 plan (Figure 3.8b), can be 

processed through this sub-menu. The following items are implemented: 

 BC2BC (Cord. Distance): This item enables users to identify countries in the GE84 plan, 

whose FM sound broadcasting stations are likely to be affected by the emissions from an 

FM sound broadcasting station located in another country in the GE84 plan. After 

selecting this item, a list of countries is presented in a dialogue box (Figure 3.15a). The 

country where the (potentially interfering) FM sound broadcasting station is located can 

be selected from this list. Then, all the FM sound broadcasting stations (in conformity 

with GE84) located inside the selected country will be listed in a spreadsheet. The user 

may select the concerned station, using a mouse left click on the record-select column of 

the spreadsheet and proceed to the coordination calculation. As shown in Figure 3.96 a 

check box is available on the list allowing the user to calculate the effective height of 

antenna directly from the DEM map instead of loading the existing record from the 

database. Also, if this check box is used, the background DEM will be panned to the 

location of the selected station. 
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Figure 3.96. Spreadsheet of FM sound broadcasting stations in the selected country 

 

 

 

 

 

 

 

 

 

 

Finally, the list of countries (Administrations) likely to be affected and their azimuth and 

distance from their nearest border point to the wanted station are listed in a spreadsheet 

underneath the first row, which provides general information about the wanted FM sound 

broadcasting station. Figure 3.97 displays a sample output of BC2BC coordination 

calculation. 

 

Figure 3.97. Result of coordination distance calculation 

 for GE84 FM sound station in respect to the other GE84 FM sound stations 

 
 

The information displayed in the result spreadsheets can be saved as a report in a file 

presented in a report-style with the HTML format by using the “Report” push button. 

 BC2BT ST61 (Cord. Distance): This item enables users to identify countries in the ST61 

plan, whose TV broadcasting stations are likely to be affected by emissions from an FM 

sound broadcasting station located in another country in the GE84 plan. After selecting 

this item, a list of countries is presented in a dialogue box (Figure 3.15a). The country 

where the (potentially interfering) FM sound broadcasting station is located, can be 

selected from this list. Then, all the FM sound broadcasting stations (in conformity with 

GE84) located inside the selected country will be listed in a spreadsheet and users may 

select the concerned station, using a mouse left click on the record-select column of a 

spreadsheet and proceed to the coordination calculation. As shown in Figure 3.96, a check 

box is available on the list allowing the user to calculate effective height of antenna 

directly from the DEM map instead of loading the existing record from the database. 
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Also, if this check box used, the background DEM will be panned to the location of 

selected station.  

Finally, the list of countries (Administrations) likely to be affected and their azimuth and 

distance from their nearest border point to the wanted station are listed in a spreadsheet 

underneath the first row, which gives the general information of the wanted FM sound 

broadcasting station. Figure 3.98 displays a sample output of BC2BT coordination 

calculation. 

 

Figure 3.98. Result of coordination distance calculation 

 for GE84 FM sound station in respect to ST61 TV broadcasting stations 

 
 

The information displayed in the result spreadsheets can be saved in a file presented in a 

report-style with the HTML format by using “Report” push button. 

 BC2FX (Fst): Item enabling users to identify countries in the GE84 plan, whose fixed 

stations are likely to be affected by the emissions from an FM sound broadcasting station 

located in another country of the GE84 plan. The technical criteria have been fully 

defined in the GE84 plan. After selecting this item, a list of countries is presented in a 

dialogue box (Figure 3.15a). The country where the (potentially interfering) FM sound 

broadcasting station is located can be selected from this list. Then, all the FM sound 

broadcasting stations (in conformity with GE84) located inside the selected country will 

be listed in a spreadsheet and users may select the concerned station, using a mouse left 

click on the record-select column of the spreadsheet and proceed to the coordination 

calculation. As shown in Figure 3.96, a check box is available on the list allowing the user 

to calculate effective height of antenna directly from the DEM map, instead of loading the 

existing record from the database. Also, if this check box used, the background DEM will 

be panned to the location of the selected station. 

Finally, the list of countries (Administrations) likely to be affected and their azimuth and 

distance from the nearest border point to the wanted station are listed in a spreadsheet 

below the first row, which provides general information about the wanted FM sound 

broadcasting station. Figure 3.99 displays a sample output of BC2FX coordination 

calculation. 
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Figure 3.99. Result of coordination field strength calculation 

 for GE84 FM sound station in respect to the fixed stations 

 
 

The information displayed in the result spreadsheets can be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 BC2LM (Fst.): This item enables users to identify countries in the GE84 plan, whose land 

mobile stations are likely to be affected by emissions from an FM sound broadcasting 

station located in another country in the GE84 plan. The technical criteria have been fully 

defined in GE84 plan. After selecting this item, a list of countries is presented in a 

dialogue box (Figure 3.15a). The country where the (potentially interfering) FM sound 

broadcasting station is located can be selected from this list. Then, all the FM sound 

broadcasting stations (in conformity with GE84) located inside the selected country will 

be listed in a spreadsheet. The user may select the concerned station, using a mouse left 

click on the record-select column of the spreadsheet and proceed to the coordination 

calculation. As shown in Figure 3.96, a check box is available on the list allowing the user 

to calculate the effective height of the antenna directly from the DEM map instead of 

loading the existing record from the database. Also, if this check box used, the 

background DEM will be panned to the location of the selected station. 

Finally, the list of countries (Administrations) likely to be affected and their azimuth and 

distance from the nearest point on the border to the wanted station are listed in a 

spreadsheet underneath the first row that provides the general information about the 

wanted FM sound broadcasting station. Figure 3.100 displays a sample output of BC2LM 

coordination calculation. 
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Figure 3.100. Result of coordination field strength calculation 

 for GE84 FM sound station in respect to the land mobile stations 

 
 

The information displayed in the result spreadsheets can be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 Interference from (Usable Fst.): This item calculates the aggregate and nuisance field 

strength from selected FM sound broadcasting stations inside a circular area within a 

given frequency range, to a GE84 FM sound broadcasting station. After selecting this 

item, a list of countries is presented in a dialogue box (Figure 3.15a). The country where 

the (wanted) FM sound broadcasting station is located can be selected from this list. Then, 

all the FM sound broadcasting stations (in conformity with GE84) located inside the 

selected country will be listed in a spreadsheet. The user may select the concerned station, 

using a mouse left click on the record-select column of the spreadsheet. When the wanted 

FM sound broadcasting station has been selected, a dialogue box appears that allows the 

user to specify: the radius of circular area, frequency search range, time percentage and 

minimum acceptable field strength. Once the calculation parameters have been specified, 

a list of all FM sound broadcasting stations that meet the specified search parameters is 

shown in a spreadsheet, from which users can select some or all of them for the next 

calculation step by a mouse left click on record select column. As shown in Figure 3.96, a 

check box is available on the list to allow the user to calculate effective height of the 

antenna directly from the DEM map instead of loading an existing record from the 

database. If the OK button is pushed, calculation starts and the relevant progress bar is 

displayed. 

Finally, a result spreadsheet is displayed showing a list of stations exceeding the 

minimum field strength value, together with their country code and field strength value.  

The aggregate field strength value at the location of the wanted FM sound broadcasting 

station is calculated. Figure 3.101 displays a sample output of the interference calculation. 

 



 
126 

Figure 3.101. Result of calculation of interference from FM sound broadcasting stations 

 inside a specified area within a specified frequency range to a wanted FM sound broadcasting station 

accordance with GE84 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The information displayed in the result spreadsheet can be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 Interference to (Usable Fst): This item calculates the nuisance field strength to the 

locations of GE84 FM sound broadcasting stations, situated inside a specified circular 

area and within a given frequency range, from a selected FM sound broadcasting station. 

After selecting this item, a list of countries is presented in a dialogue box to allow 

selection of the country where the (interfering) FM sound broadcasting station is located 

(Figure 3.15a). Then, a spreadsheet is displayed listing all FM sound broadcasting stations 

(in conformity with GE84) located inside the selected country. The user may select the 

concerned (interfering) station by using a mouse left click on the record-select column of 

this spreadsheet. A dialogue box will be displayed for the user to specify the calculation 

parameters: the radius of circular area, search frequency range, time percentage and 

minimum acceptable field strength value. Once these have been determined, all FM sound 

broadcasting stations that meet the search criteria are listed in a spreadsheet from which 

users can select, by mouse left click on record select column, some, or all of them, for the 

next calculation step. As displayed in Figure 3.96, a check box is available on the list 

allowing the user to calculate effective height of antenna directly from the DEM map 

instead of loading an existing record from the database. When the OK button is pushed, 

calculation starts and the relevant progress bar is displayed. 

Finally, a result spreadsheet is displayed listing the stations identified as being interfered 

with by the wanted FM sound broadcasting station and showing: their country code, the 

field strength produced by wanted station (Esi), the aggregate field strength value (Eu) of 

all stations (including wanted station), reference usable field strength value (Eref) and 

value by which the reference usable field strength value is exceeded. Figure 3.102 

displays a sample output of this interference calculation. 
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Figure 3.102. Field strength value produced by a wanted FM BC station  

to selected FM BC stations and aggregate field strength value at any selected FM BC station 

 
 

The information displayed in the result spreadsheets can be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 

3.4.2.12.2. ST61 sub-menu of DEM view 

This item can be used for the calculation of coordination distances from a wanted VHF sound or 

TV broadcasting station to the nearest point of the neighbouring countries which are in ST61 

Plan, Rev. 2006 (Figure 3.8a). This item contains only one item with the following description: 

 [BC, BT] 2 [BC, BT] (Cord. Distance): This item enables users to identify countries in the 

ST61 Plan (see ST61 area: Figure 3.8a), whose sound or TV broadcasting stations are 

likely to be affected by emissions from a sound or TV broadcasting station situated in  

another country of the ST61 plan. After selecting this item, a dialogue box (Figure 3.15a) 

is presented containing a list of countries that enables the user to select the country where 

the (interfering) broadcasting station is situated. Then, a spreadsheet is displayed listing 

all sound and TV broadcasting stations (in conformity with ST61) located inside the 

selected country. The user may select the concerned station, using a mouse left click on 

the record-select column of the spreadsheet, and proceed to the coordination distance 

calculation. As shown in Figure 3.96, a check box is available on the spreadsheet 

allowing the user to calculate the effective height of the antenna directly from the DEM 

map instead of loading the existing record from the database. If this check box used, the 

background DEM will be panned to the location of the selected station. 

Finally, a spreadsheet is displayed that contains a list of countries (Administrations), 

identified as likely to be affected, together with the azimuth and distance from their 

nearest border point to the wanted (interfering) station. The first row of this spreadsheet 

contains general information about the wanted broadcasting station. Figure 3.103 displays 

a sample output of the [BC, BT] 2 [BC, BT] coordination distance calculation. If no 

affected country is found, a message box will be displayed instead of the result dialogue 

box. 
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Figure 3.103. Result of coordination distance calculation for ST61 BC and ST61 BT 

 station in respect to the ST61 BC and ST61 BT stations of other ST61 countries 

 
 

The information displayed in the result spreadsheet may be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 

3.4.2.12.3. GE89 sub-menu of DEM view 

This item has been developed to analyze different scenarios for coordination calculations, for TV 

broadcasting stations, in accordance with the GE89 plan, Rev 2006 (Figure 3.8c). The following 

sub-items are described under this item: 

 BT2BT (Cord. Distance): This item identifies those countries in GE89 plan whose TV 

broadcasting stations are likely to be affected by emissions from a wanted TV 

broadcasting station situated inside another country. After selecting this item, a dialogue 

box (Figure 3.15a) presents a list of countries from which the user can select the country 

where the (interfering) TV broadcasting station is situated. Then, a spreadsheet displays a 

list of all TV broadcasting stations (in conformity with GE89 plan) situated inside the 

selected country. The (interfering) station may be selected from this list, using a mouse 

left click on the record-select column of the spreadsheet, and proceed to the coordination 

distance calculation. As displayed in Figure 3.96, a check box is available on the list 

enabling the user to calculate effective height of the antenna directly from the DEM map 

instead of loading the existing record from database. If this check box used, the 

background DEM will be panned to the location of selected station. 

Finally, a spreadsheet is displayed, containing a list of countries (Administrations), 

identified as likely to be affected, together with the azimuth and distance from their 

nearest border point to the wanted (interfering) station. The first row of this spreadsheet 

contains the general information about the wanted (interfering) TV broadcasting station.  

Figure 3.104 displays a sample output of the BT2BT coordination distance calculation. 
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Figure 3.104. Result of coordination distance calculation 

 for a wanted GE89 TV station in respect to the TV broadcasting stations of other countries 

 
 

The information displayed in the result spreadsheets may be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 

 BT2FX (Fst.): This item enables users to identify, in accordance with the GE89 plan, 

fixed stations that are likely to be affected by the TV broadcasting station of another 

country. The calculation requires values to be specified for the following parameters: the 

radius of the circular search area around the wanted (interfering) BT station, the 

frequency range and the percentage of time and locations. The technical criteria have been 

fully defined in GE89 plan. After choosing this item a dialogue box (Figure 3.15a) 

presents a list of countries from which the user can select the country where the 

(interfering) TV broadcasting station is situated. Then, a spreadsheet displays a list of all 

TV broadcasting stations (in conformity with GE89 plan) situated inside the selected 

country. The concerned station may be selected using a mouse left click on the record-

select column of the spreadsheet. After this selection, a dialogue box will appear that 

enables entry of values for: the radius of the circular search area, search frequency range, 

time percentage, location percentage and terrain roughness (DeltaH). Once these values 

have been specified, a list of all fixed stations which meet these conditions is presented in 

a spreadsheet and users can select some or all of them for the next calculation step by a 

mouse left click on the record select column. As shown in Figure 3.96, a check box is 

available on the spreadsheet allowing the user to calculate effective height of the antenna 

directly from the DEM map instead of loading an existing record from the database. If 

this check box is used, the background DEM will be panned to the location of last 

selected station. Pressing the OK button starts the calculation and a progress bar is 

displayed. 

Figure 3.105. Spreadsheet of broadcasting stations inside the selected country 

 

 

 

 

 

 



 
130 

Finally, the results are shown in a spreadsheet, which lists: the fixed stations identified, 

the field strength produced by wanted TV station (Esi), the relative protection ratio (RPR) 

and acceptable field strength value of interfering signal (Elimit). The top row of the result 

spreadsheet displays the general information about the wanted TV station. Figure 3.106 

shows a sample output of this item after completion of the calculation. It should be noted 

that if the field strength produced by wanted TV station exceeds the acceptable field 

strength value of the interfering signal, it will be shown in red. 

 

Figure 3.106. List of affected fixed stations around the wanted TV station in accordance with the GE89 plan 

 

 

 

 

 

 

 

 

 
 

 

 

The information displayed in the result spreadsheets can be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 BT2LM (Fst.): This item enables users to identify, in accordance with the GE89 plan, 

base stations and mobile stations in the land mobile service likely to be affected by a TV 

broadcasting station situated in another country. The calculation requires values to be 

specified for the following parameters: the radius of the circular search area around the 

wanted (interfering) BT station, the frequency range and the percentage of time and 

locations. The technical criteria have been fully defined in GE89 plan. After choosing this 

item a dialogue box (Figure 3.15a) presents a list of countries from which the user can 

select the country where the (interfering) TV broadcasting station is situated. Then, a 

spreadsheet displays a list of all TV broadcasting stations (in conformity with GE89 plan) 

situated inside the selected country. The concerned station may be selected using a mouse 

left click on the record-select column of the spreadsheet. After this selection, a dialogue 

box will appear that enables entry of values for: the radius of the circular search area, 

search frequency range, time percentage, location percentage and terrain roughness 

(DeltaH). Once these values have been specified, a list of all stations which meet these 

conditions is presented in a spreadsheet and users can select some or all of them for the 

next calculation step by a mouse left click on the record select column. As shown similar 

to in Figure 3.96, a check box is available on the spreadsheet allowing the user to 

calculate effective height of the antenna directly from the DEM map instead of loading an 

existing record from the database. If this check box is used, the background DEM will be 

panned to the location of last selected station. Pressing the OK button starts the 

calculation and a progress bar is displayed. Finally, the results are shown in a spreadsheet, 

which lists: the stations in land mobile service identified, the field strength produced by 
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wanted TV station (Esi), the relative protection ratio (RPR) and acceptable field strength 

value of interfering signal (Elimit). The top row of the result spreadsheet displays the 

general information about the wanted TV station. Figure 3.107 shows a sample output of 

this item after completion of the calculation. It should be noted that if the field strength 

produced by wanted TV station exceeds the acceptable field strength value of the 

interfering signal, it will be shown in red.  

 

Figure 3.107. List of affected stations in land mobile service 

 around the wanted TV station in accordance with the GE89 plan (No affected station detected in Figure) 

 

 

 

 

 

 

 

 

 

 

 

 

The information displayed in the result spreadsheets may be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 [FX, LM]2BT (Fst.): This item enables users to identify, in accordance with the GE89 

Plan, those TV broadcasting stations likely to be affected by stations in the land mobile or 

fixed services situated in another country. The calculation requires values to be specified 

for the following parameters: the radius of the circular search area around the wanted BT 

station, the frequency range and the percentage of time and locations. The technical 

criteria have been fully defined in GE89 plan. After choosing this item a dialogue box 

(Figure 3.15a) presents a list of countries from which the user can select the country 

where the fixed or land mobile station is situated. Then, a spreadsheet displays a list of all 

stations in Fixed or Land Mobile service situated inside the selected country. The 

concerned station may be selected using a mouse left click on the record-select column of 

the spreadsheet. After this selection, a dialogue box will appear that enables entry of 

values for: the radius of the circular search area, search frequency range, time percentage, 

location percentage and terrain roughness (DeltaH), k-factor and protection ratio. Once 

these values have been specified, a list of all TV broadcasting stations which meet these 

conditions is presented in a spreadsheet and users can select some or all of them for the 

next calculation step by a mouse left click on the record select column. Pressing the OK 

button starts the calculation and a progress bar is displayed. Finally, the results are shown 

in a spreadsheet, which lists: for each TV broadcasting station identified, country name, 

country code, protection ratio, the field strength produced by interferer station (Em) and 

tolerable field strength value of interfering signal (Elimit). The top row of the result 

spreadsheet displays the general information about the interferer station. Figure 3.108  

shows a sample output of this item after completion of the calculation. It should be noted 
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that if the field strength produced by the interfering station exceeds the acceptable field 

strength value specified for the interfering signal, it will be shown in red.  

 

Figure 3.108. List of affected TV stations in broadcasting service 

 around the wanted station in fixed or land mobile service in accordance with the GE89 plan 

 

 

 

 

 

 

 

 

 

 

 

 

The information displayed in the result spreadsheets may be saved in a file presented in a 

report-style with the HTML format by using “Report” push button. 

3.4.2.12.3.1. GE89 Interference sub-menu of DEM view 

Under this sub-menu, different scenarios for interference calculations have been implemented for 

the broadcasting stations in the GE89 plan (Rev 2006). The items for this sub-menu are described 

below: 

 Interference from (BT2BT) (Usable Fst.): This item calculates aggregate and nuisance 

field strength from selected TV broadcasting stations to a wanted GE89 TV broadcasting 

station. The procedure to identify the (interfering) BT stations for examination requires a 

search around the wanted BT station within a specified circular area and a given 

frequency range. After selecting this item, a dialogue box (Figure 3.15a) is presented 

containing a list of countries from which the user may select the country where the 

wanted BT station is situated. Then, a spreadsheet is displayed listing all TV broadcasting 

stations (in conformity with GE89 plan) situated inside the selected country will be listed 

in a spreadsheet. The wanted TV broadcasting station may be selected using a mouse left 

click on the record-select column of this spreadsheet and a dialogue box will appear 

enabling the user to specify values for: the radius of circular search area, the search 

frequency range, percentage of time and location, terrain roughness and minimum 

acceptable field strength. Once these values have been specified, a spreadsheet is 

displayed listing all TV broadcasting stations meeting the specified conditions. Users can 

select some or all of them for the next calculation step by a mouse left click on record 

select column. Similar to Figure 3.96, a check box is available on the list, allowing the 

user to calculate effective height of the antenna directly from the DEM map instead of 

loading an existing record from the database. If this check box is used, the background 

DEM will be panned to the location of the last selected station. When OK button is 

pushed, the calculation starts and a progress bar is displayed. 
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Finally, in a result spreadsheet, a list is displayed showing those TV stations exceeding 

the tolerable interference level, together with their country code, the field strength 

produced by each TV station on the wanted TV station (Esi), the protection ratio (PR) and 

acceptable field strength value of interfering signal (Elimit). The top row of the 

spreadsheet contains summary information about the wanted TV station. The aggregate 

field strength value (Eu) of all TV stations at the location of the wanted TV station is 

displayed. Figure 3.109 shows a sample output from this calculation item. 

 

Figure 3.109. Interference of TV broadcasting stations, inside a given area within 

 a frequency range, on a wanted TV broadcasting station in accordance with GE89 

 

 

 

 

 

 

 

 

 

 

 

 

The information displayed in the result spreadsheets may be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 Interference to (BT2BT) (Fst): This item calculates the nuisance field strength of a 

selected GE89 TV broadcasting station at the location of other GE89 TV broadcasting 

stations situated inside a circular area and within a given frequency range. After selecting 

this item, a dialogue box (Figure 3.15a), containing a list of countries, is presented to 

enable selection of the country where the concerned TV broadcasting station is situated. 

Then, a spreadsheet is presented listing all TV broadcasting stations (in conformity with 

GE89) situated inside the selected country and users may select the concerned station, 

using a mouse left click on the record-select column of this spreadsheet. When the wanted 

TV broadcasting station has been selected, a dialogue box will appear requesting the user 

to specify: the radius of the circular area, the search frequency range, time percentage and 

minimum acceptable field strength value. Once these values have been specified, a 

spreadsheet is presented listing all TV broadcasting stations meeting the search 

conditions. The user may select some or all of them for the next calculation step by a 

mouse left click on the record select column. As displayed in Figure 3.96, a check box is 

available on the spreadsheet allowing the user to calculate effective height of the antenna 

directly from the DEM map instead of loading an existing record from the database. 

When the OK button is pushed, the calculation starts and a progress bar is displayed. 

Finally, the result spreadsheet displays a list of those stations which have interference 

from the wanted TV broadcasting station; together with their country code, the field 

strength produced by the wanted station (Esi), the protection ratio (PR) and the acceptable 
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field strength value (Elimit). Figure 3.110 shows a sample output of this interference 

calculation. The field “Eu” is not in use. 

 

Figure 3.110. Interference from wanted TV broadcasting station on other 

 TV broadcasting stations inside a given area and within a given frequency range 

 

 

 

 

 

 

 

 

 

 

 

 

The information displayed in the result spreadsheets may be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 BT2FX (Fst.): This item enables users to calculate interference, in accordance with the 

GE89 Plan, from a wanted TV broadcasting station to those point-to-point links situated 

inside a circular area around the concerned TV station, within a given frequency range, in 

a given percentage of time and location, taking into consideration antenna radiation 

patterns of receivers and transmitter. The technical criteria have been fully defined in 

GE89 plan. After choosing this item, a list of countries is presented in a dialogue box 

(Figure 3.15a), enabling selection of the country where the concerned TV broadcasting 

station is situated. Then, a spreadsheet will be displayed listing all TV broadcasting 

stations (in conformity with GE89 plan) situated inside the selected country and the user 

may select the concerned station, using a mouse left click on the record-select column of 

spreadsheet. When the wanted TV broadcasting stations has been selected, a dialogue box 

will appear enabling the user to specify values for: the radius of the circular search area, 

the search frequency range, time percentage, location percentage, terrain roughness 

(DeltaH) and k-factor. Once these values have been specified, a list of all point-to-point 

links which meet the conditions is presented in a spreadsheet and the user may select 

some or all of them for next calculation step by a mouse left click on the record select 

column. When the OK button is pushed, the calculation starts and a progress bar is 

displayed.Finally, the result spreadsheet is displayed, listing the calculation results for all 

selected point-to-point links; together with their country code, relative protection ratio 

(RPR), the field strength produced by wanted TV station (Esi) and tolerable field strength 

value of interfering signal (Elimit). The first row of the spreadsheet contains a summary 

of information about the wanted TV station. Figure 3.111 displays a sample output of this 

calculation item 
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Figure 3.111. Interference from wanted TV broadcasting station 

 on point-to-point links and dialogue box of calculation parameter 

 

 

 

 

 

 

 

 

 

 
 

 

The information displayed in the result spreadsheets may be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 BT2LM (Fst.): This item enables the user to calculate interference, in accordance with the 

GE89 Plan, from a wanted TV broadcasting station to those stations in the land mobile 

service situated inside a circular area around the interferer station, within a given 

frequency range, in a given percentage of time and location and taking into consideration 

the BT station’s antenna radiation pattern. The technical criteria have been fully defined 

in GE89 plan. After choosing this item, a list of countries is presented in a dialogue box 

(Figure 3.15a) enabling the user to select the country where the concerned TV 

broadcasting station is situated. Then, all TV broadcasting stations (in conformity with 

GE89 plan) located inside the selected country will be listed in a spreadsheet and the user 

may select the concerned station, using a mouse left click on the record-select column. 

After selecting the wanted TV broadcasting station, a dialogue box will appear for the 

user to enter values for: the radius of circular search area, search frequency range, time 

percentage, location percentage and terrain roughness (DeltaH). Once these values have 

been specified, a list of all stations which meet the conditions is listed in a spreadsheet 

and the user may select some or all of them for next calculation step by a mouse left click 

on the record select column. When the OK button is pushed, the calculation starts and a 

progress bar is displayed  

Finally, a result spreadsheet displays the calculation results for all selected stations in the 

land mobile service, together with their country code, the field strength produced by 

wanted TV station (Esi) and tolerable field strength value of interfering signal (Elimit). 

The top row of the spreadsheet contains a summary of information about the wanted TV 

station. Figure 3.112 displays a sample output of this calculation item. 
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Figure 3.112. Interference from wanted TV broadcasting station 

 on stations in land mobile service and dialogue box of calculation parameter 

 

 

 

 

 

 

 

 

 

The information displayed in the result spreadsheets can be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 [FX, LM]2BT (Fst.): This item enables users to calculate, in accordance with the GE89 

Plan, the interference from a wanted station in the Fixed or Land Mobile service to those 

TV broadcasting stations inside a circular area around the interferer station, within a given 

frequency range, at a given percentage of time and locations. The technical criteria have 

been fully defined in GE89 plan. After choosing this item, all stations in the Fixed or 

Land Mobile service are listed in a spreadsheet and the user is able to select the concerned 

station, using a mouse left click on the record-select column. When the wanted station in 

Fixed or Land Mobile service has been selected, a dialogue box will appear, enabling the 

user to enter values for: the radius of circular search area, search frequency range, time 

percentage, location percentage, terrain roughness (DeltaH), k-factor and protection ratio. 

Once these values have been specified, all TV broadcasting stations which meet the 

conditions are listed in a spreadsheet and the user may select some or all of them for the 

next calculation step by a mouse left click on the record select column. When the OK 

button is pushed, the calculation starts and a progress bar is displayed. 

Finally, the result spreadsheet displays a list of stations in the Fixed or Land Mobile 

service with an analysis of their interference to selected TV broadcasting stations. For 

each TV broadcasting station the following information is displayed in a spreadsheet: 

Country name, country code, protection ratio, the field strength produced by interferer 

station (Em) and tolerable field strength value of interfering signal (Elimit). The first row 

of this spreadsheet contains summary information about the interferer station. Figure 

3.113 displays a sample output of this calculation item. 
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Figure 3.113. Interference caused by interferer station in the Fixed or Land Mobile 

 service to stations in the TV Broadcasting service and the dialogue box of calculation parameters 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The information displayed in the result spreadsheets may be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 
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3.4.2.12.4. GE06 sub-menu of DEM view 

This item has been developed to analyse different scenarios of coordination and interference and 

perform calculations according to the GE06 Plan (Figure 3.8d) with respect to the broadcasting 

assignments (digital/analogue) or allotments as well as stations in the fixed and land mobile 

services. The sub-item functions under this menu are described below: 

 BCBT2BCBT (Affected Admin): this item identifies those countries in GE06 Plan whose 

broadcasting services are likely to be affected by emissions from a wanted broadcasting 

assignment (digital/analogue) or allotment situated in another country. After choosing this 

item, all broadcasting assignments and allotments (in conformity with GE06 Plan) will be 

listed in a spreadsheet and the user may select, using a mouse left click on the record-

select column of the spreadsheet, the assignment/allotment required for the coordination 

contour calculation. As displayed in Figure 3.114, a check box is available on the 

spreadsheet allowing the user, in appropriate cases, to calculate effective height of the 

antenna directly from the DEM map instead of loading an existing record from the 

database. 

All linked assignments and/or associated allotment for the wanted digital broadcasting 

assignment/allotment, based on its plan entry code, are considered by the software for 

calculation of the coordination contour. The technical criteria have been fully defined in 

the GE06 Plan. 

When the wanted broadcasting assignment/allotment selected, a dialogue box will appear 

to determine the k factor, search radius and azimuth step. The coordination contour is 

developed using equally spaced radials equal to azimuth step (1°/10°) apart, over 360° 

around the allotment/assignment, centred on a single reference point. The coordination 

contour is calculated for each radial by starting at a distance equal to search radius from 

the reference point. Calculation starts and relevant progress bar is displayed if OK button 

pushed. 

Finally, the list of countries (Administrations) likely to be affected which their national 

boundaries intersected with or enclosed by calculated coordination contour and the trigger 

field strength value are listed in a spreadsheet below the general information of wanted 

broadcasting assignment/allotment and its linked assignments and/or associated allotment. 

Figure 3.115 displays a sample output of BCBT2BCBT coordination contour calculation 

for identification of likely to be affected countries in respect to their broadcasting service. 

 Figure 3.114. Spreadsheet of broadcasting assignments or allotments 
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Figure 3.115. Result of identification of likely affected Administrations 

 for a wanted GE06 assignment / allotment in respect to their broadcasting service  

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

The calculated coordination contour could be saved and drawn on DEM map by using 

“Show and Save Coordination Contour” push button as shown in Figure 3.116. In this 

case, software save the coordination contour in BDT_Soft\SMS4DC\Reports path with 

the file name of ADM-ADMREFID-BCBT2BCBT.txt which refers to administration and 

adm-ref-Id of wanted assignment/allotment. This vector can be redrawn from “Draw from 

File” function under the “Vector” menu on DEM or IDWM map. Also there is a check 

box named "Google Earth" which if is checked while clicking on "Show and Save 

Coordination Contour" button, displays the corresponding dialog box for creation and 

display the result contour file in Google Earth. 

The information displayed in result spreadsheets can be reported in a file presented in a 

report-style with the HTML format by using “Report” push button. 

 

Figure 3.116. Result of coordination contour calculation 

 for a wanted GE06 assignment / allotment  
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 BCBT2FXLM (Affected Admin): Item enabling users to find likely to be affected 

Administrations which their stations in fixed and land mobile services are inside a 

coordination contour around a wanted broadcasting assignment/allotment within a 

frequency range or those that have frequency overlap with relevant broadcasting 

assignment/allotment. All broadcasting assignments and allotments (in conformity with 

GE06 Plan) will be listed  in a spreadsheet and users could select the concerned 

assignment (digital/analogue) or allotment, using a mouse left click on the record-select 

column of spreadsheet, for proceeding of coordination contour calculation. As displayed 

in Figure 3.117, a check box is available on this spreadsheet to allow the user to calculate 

effective height of the antenna directly from the DEM map instead of loading the existing 

record from the database where appropriate. 

All linked assignments and/or associated allotment with wanted digital broadcasting 

assignment or allotment, based on its plan entry code, are considered by software for 

calculation of coordination contour. The technical criteria have been fully defined in 

GE06 Plan.  

When the wanted broadcasting assignment/allotment has been selected, a dialogue box 

will appear, for the user to specify: the k factor, search radius, azimuth step and frequency 

range or overlapping frequency option. The coordination contour is developed using 

equally spaced radials, equal to the azimuth step (1°/10°) apart, over 360° around the 

allotment/assignment, centred on a single reference point. The coordination contour is 

calculated for each radial by starting at a distance equal to the search radius from the 

reference point. The software considers all receiving stations/areas which have their 

frequencies in the identified frequency range, or if the frequency overlapping option is 

selected, it will take into account only those receiving stations/areas that have a frequency 

overlap with the relevant broadcasting assignment/allotment.  

Once values for the parameters have been entered into the dialogue box and “OK” is 

pressed, a spreadsheet list of unique trigger field strength values and their relevant 

receiving antenna heights are displayed (see Figure 3.118). These values have been 

extracted from the tables of trigger values in GE06 Plan and correspond with the 

receiving stations/areas located within the specified search radius. Users can select some 

or all of them for the next calculation step by a mouse left click on the record select 

column. When the OK button is pressed, the calculation starts and a progress bar is 

displayed. 

Figure 3.117. Spreadsheet of broadcasting assignments/allotments 
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Figure 3.118. Spreadsheet of unique triggers values and their relevant receiving antenna heights 

 

 

 

 

 

 

 

 

 

 

 

Finally, a spreadsheet (“Affected Administrations”) lists the stations in the fixed and land 

mobile services that are likely to be affected because their location/receiving area 

intersects with, or is enclosed by, the calculated coordination contours. For each affected 

station, additional information is displayed, including: Country code, Administration 

code, the relevant trigger field strength value and receiving antenna height. The first row 

of this spreadsheet contains a summary of information about the wanted broadcasting 

assignment/allotment and its linked assignments and/or associated allotment. Figure 3.119 

displays a sample output of the BCBT2FXLM coordination contours calculation for 

identification of countries whose stations in the fixed and land mobile services are likely 

to be affected.  

Figure 3.119. Result of identification of likely affected Administrations 

 for a wanted GE06 assignment/allotment in respect to their fixed and land mobile services  

 

 

 

 

 

 

 

 

 

 

 

 

The calculated coordination contours may be saved and drawn on the DEM map by using 

the “Show and Save Coordination Contour” push button (see Figure 3.120). In this case, 

the coordination contours are saved in the BDT_Soft\SMS4DC\Reports path. The file 

name is in the format: [ADM]-[ADMREFID]-BCBT2FXLMX.txt to provide a unique 

reference to the administration and adm-ref-Id of the wanted assignment/allotment. This 

vector can be redrawn from “Draw from File” function under the “Vector” menu on DEM 

or IDWM map. Also there is a check box named "Google Earth" which if is checked 
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while clicking on "Show and Save Coordination Contour" button, displays the 

corresponding dialog box for creation and display the result contour file in Google Earth. 

The information displayed in the result spreadsheets can be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

Figure 3.120. Result of coordination contours calculation 

 for a wanted GE06 assignment / allotment in respect to fixed and mobile stations 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 FXLM2BCBT (Affected Admin): This item identifies Administrations whose 

broadcasting service is likely to be affected by a wanted station in the fixed or land 

mobile service situated inside another country. This item has two sub-items as follows: 

 FXLM2BCBT (Affected Admin)/TX FXLM: This item enable users to identify those 

Administrations whose broadcasting service is likely to be affected by a wanted station in 

the fixed or land mobile service situated inside another country. The administrations with 

which coordination is required are identified by the coordination contour for the 

broadcasting service that intersects with, or encloses, the national boundaries of other 

administrations. In the case of typical or mobile stations each boundary test point of the 

service area boundary will be considered as a source of potential interference. The largest 

field strength obtained, at each calculation point under consideration, among all boundary 

test points, is taken as the value of field strength to be used. The technical criteria have 

been fully defined in GE06 Plan. All stations in the fixed and land mobile services (in 

conformity with GE06 Plan) will be listed in a spreadsheet and the user may select the 

concerned station, using a mouse left click on the record-select column of this 

spreadsheet. A check box added to the spreadsheet allows the user to calculate effective 

height of the antenna directly from the DEM map instead of loading an existing record 

from the database (see Figure 3.121). When the wanted station has been selected, a 

dialogue box will appear for the user to specify values for: the k factor, search radius and 

azimuth step. The coordination contour is developed using equally spaced radials, equal 

to azimuth step (1°/10°) apart, over 360° around the wanted station, centred on a single 

reference point. The coordination contour is calculated for each radial by starting at a 

distance equal to the search radius from the reference point. Once values for the 
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parameters have been specified and the OK button pushed, the calculation starts and a 

progress bar is displayed. 

Finally, a result spreadsheet displays the list of affected Administrations, as well as the 

relevant trigger field strength and receiving antenna height. The first row of the 

spreadsheet displays a summary of information about the wanted station. Figure 3.122 

shows a sample output of this calculation item. 

Figure 3.121. Spreadsheet of stations in fixed and land mobile services 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.122. Result of identification of Administrations whose broadcasting service is likely to be affected by 

a wanted transmitting station in the fixed or land mobile service 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The calculated coordination contours may be saved and drawn on the DEM map by using 

“Show and Save Coordination Contour” push button as shown in Figure 3.123. In this 

case, the coordination contours are saved in the BDT_Soft\SMS4DC\Reports path. The 

file name is in the format: [ADM]-[ADMREFID]- FXLM2BCBT.txt to provide a unique 

reference to the administration and adm-ref-Id of the wanted assignment/allotment. This 

vector can be redrawn from “Draw from File” function under the “Vector” menu on DEM 

or IDWM map. Also there is a check box named "Google Earth" which if is checked 
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while clicking on "Show and Save Coordination Contour" button, displays the 

corresponding dialog box for creation and display the result contour file in Google Earth. 

The information displayed in the result spreadsheets can be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

Figure 3.123. Result of coordination contour calculation 

 for a wanted transmitting station in fixed or land mobile service  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The information displayed in the result spreadsheets may be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

• FXLM2BCBT (Affected Admin)/RX FXLM: This item enables users to identify 

administrations whose receiving stations in the fixed or land mobile service are likely to 

be affected in respect to the broadcasting service. The administrations with which 

coordination is required are identified where their national boundaries are intersected or 

encloses by the coordination contour for the broadcasting service. The technical criteria 

have been fully defined in GE06 Plan. All stations in fixed and land mobile services (in 

conformity with GE06 Plan) will be listed in a spreadsheet and users may select the 

concerned station, using a mouse left click on the record-select column of the spreadsheet 

(see Figure 3.124). When the wanted station has been selected, a dialogue box will appear 

for the user to specify values for: the k factor, search radius and azimuth step. Also, there 

are some options for selection of the assumed transmitter BC/BT station and also 

consideration of the antenna discrimination of the fixed or land mobile receiving station. 

The coordination contour is developed using equally spaced radials equal to the azimuth 

step (1°/10°) apart, over 360° around the wanted station, centred on a single reference 

point. The coordination contour is calculated by placing the assumed broadcasting station, 

referred to above, at a distance equal to the search radius from the reference point and 

determining the field strength at the reference point. In the case of selection of an 

assumed analogue TV stations, the RPR value is considered in the calculation of the 

trigger values. Once values for the parameters have been specified, a list of unique trigger 

values and their relevant receiving antenna heights are displayed (see Figure 3.125). 

These values have been extracted from the tables of trigger values in GE06 Plan and 

correspond with the wanted receiving station/area. Users may select some or all of them 
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for the next calculation step by a mouse left click on record select column. When the OK 

button is pushed, the calculation starts and a progress bar is displayed. 

Finally, a result spreadsheet displays the list of affected Administrations as well as 

relevant trigger field strength and receiving antenna height. The first row of this 

spreadsheet displays a summary of information about the wanted station. Figure 3.126 

shows a sample output of this calculation item. 

 

Figure 3.124. Spreadsheet of stations in fixed and land mobile services 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.125. Spreadsheet of unique trigger values and their relevant receiving antenna heights 
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 Figure 3.126. Result of identification of likely affected Administrations 

 for a wanted receiving station in fixed or land mobile service in respect to their broadcasting service  

 

 

 

 

 

 

 

 

 

 

 

 

The calculated coordination contours may be saved and drawn on DEM map by using 

“Show and Save Coordination Contour” push button (see Figure 3.127). In this case, the 

coordination contours are saved in the BDT_Soft\SMS4DC\Reports path. The file name is 

in the format: [ADM]-[ADMREFID]- FXLM2BCBT.txt to provide a unique reference to 

the administration and adm-ref-Id for the wanted assignment/allotment. This vector can 

be redrawn from “Draw from File” function under the “Vector” menu on DEM or IDWM 

map. Also there is a check box named "Google Earth" which if is checked while clicking 

on "Show and Save Coordination Contour" button, displays the corresponding dialog box 

for creation and display the result contour file in Google Earth. 

The information displayed in the result spreadsheets can be saved in a file presented in a 

report-style with the HTML format by using the “Report” push button. 

 

Figure 3.127. Result of coordination contour calculation 

 for a wanted receiving station in fixed or land mobile service  
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 Coverage Area: This item calculates noise-limited and interference-limited coverage areas 

for a wanted broadcasting assignment. All assignments (digital/analogue) in the 

broadcasting service (in conformity with GE06 Plan) will be listed in a spreadsheet and 

the user may select the concerned assignment, using a mouse left click on the record-

select column of spreadsheet (see Figure 3.128), a check box is available on this 

spreadsheet to allow the user to calculate effective height of the antenna directly from the 

DEM map instead of loading the existing record from the database. When the wanted 

assignment has been selected, a dialogue box will appear for the user to specify values for 

the location probability and the minimum median field strength. The default values have 

been extracted from the tables of the GE06 Plan, based on: Notice Type and Reference 

Plan Configuration/ Rx mode and system variant of the wanted assignment. There are also 

some options for selection of: search radius, frequency range, interference time 

percentage, environment and consideration of analogue plan, digital plan, stations in fixed 

and land mobile service and the antenna discrimination for calculation of interference-

limited coverage area. Once the user has specified values for these parameters, or 

accepted the default values, the locations of the noise-limited coverage area are found, 

which represent the area that could be served if there was no interference. This area will 

be approximated on the basis of 36 radials. A vector-style dialogue box appears which 

enables the user to adjust line colour and style as well as fill style of the noise-limited 

contour. Similar to Figure 3.129, a spreadsheet lists all interferer 

stations/assignments/allotments that meet the conditions, and the user may select some or 

all of them for calculation of their interference-limited coverage area by a mouse left click 

on the record select column. When the OK button is pushed the calculation starts and a 

progress bar is displayed. Nuisance field strengths caused by the interfering stations/ 

assignments/ allotments are calculated at each of the noise-limited test points. All linked 

assignments and/or associated allotment with interfering digital broadcasting 

assignment/allotment, based on its plan entry code, are considered by the software for 

calculation of nuisance field strengths. The technical criteria have been fully defined in 

the GE06 Plan. Usable field strength is calculated for each of these test points and then 

the new coverage radius will be found on the bearing at which the field strength from the 

wanted station equals (or exceeds) the usable field strength. A vector-style dialogue box 

appears which enables the user to adjust line colour and style as well as fill style of the 

interference-limited contour. Finally, the noise-limited coverage area, as well as the 

interference-limited coverage area will be displayed on the DEM map (see Figure 3.130). 

Figure 3.128. Spreadsheet of assignments in broadcasting service 
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 Figure 3.129. Spreadsheet of found interferer stations/assignments/allotments 

 

 

 

 

 

 

 

 

 

Figure 3.130. Result of calculation of noise-limited and interference-limited  

coverage area for a broadcasting assignment  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The calculated noise-limited and interference-limited coverage areas will be saved in the 

BDT_Soft\SMS4DC\Reports path. The file names are in the format: IDst-ADM-

ADMREFID-NLCVA.txt and IDst-ADM-ADMREFID-ILCVA.txt, respectively, to 

provide unique references for: station ID, Administration and adm-ref-Id of the wanted 

assignment. These vectors may be redrawn from “Draw from File” function under the 

“Vector” menu on the DEM or IDWM map. Also it is possible to create and display the 

result contour file(s) in Google Earth. 
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 Service Area: This item calculates service area test points for a wanted broadcasting 

assignment. A dialogue box will appear for the user to determine the assignment type as: 

New or Existing assignment, number of test points and possibility to limit service area to 

national boundary of wanted assignment. In the latter case, if the coverage radius crosses 

the national boundary, the test point in this area is located at the crossing point between a 

radial and the boundary. The user may also attach a user defined service area to the 

wanted assignment. 

In the case of a New Assignment (see Figure 3.131), the service area is calculated as 

noise-limited coverage area, but taking into account a required minimum median field 

strength which is augmented by a margin of 3 dB. All broadcasting assignments (in 

conformity with GE06 Plan) will be listed in a spreadsheet and users may select the 

concerned assignment (digital/analogue), using a mouse left click on the record-select 

column of the spreadsheet, and proceed to the service area test point calculation. When 

the wanted assignment has been selected, another dialogue box will appear for the user to 

determine the location probability and the minimum median field strength. The default 

values have been extracted from the tables of GE06 Plan based on: Notice Type and 

Reference Plan Configuration/Rx mode and system variant of the wanted assignment, as 

well as environment (similar to Figure 3.132). If the wanted assignment is an analogue 

station, the usable field strength (UFS) is also calculated and can be saved at each test 

point which may be required for calculation of interference. Finally, the service area test 

points will be displayed on DEM map (see Figure 3.133). 

Also it is possible to create and display the result contour file(s) in Google Earth. 

  
 

 

Figure 3.131. Dialogue box for determination of service area parameters 
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Figure 3.132. Spreadsheet of broadcasting assignments  

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.133. Result of calculation of service area test points for a broadcasting assignment  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The calculated service area test points as well as the median field strength/usable field 

strength (in the case of analogue assignments) and wanted field strength value on each 

test point may be displayed by a mouse right click on the frequency level of a wanted 

assignment in the Administrative window (see Figure 3.142). In the case of an Existing 

Assignment (see Figure 3.134), the service area is calculated as an interference-limited 

coverage area. All broadcasting assignments (in conformity with GE06 Plan) will be 

listed in a spreadsheet and users may select the concerned assignment (digital/analogue), 

using a mouse left click on the record-select column of spreadsheet and proceed to the 

calculation of service area test points. When the wanted assignment has been selected, 

another dialogue box will appear for the user to specify: the location probability and the 

minimum median field strength. The default values have been extracted from the tables of 

the GE06 Plan, based on: Notice Type and Reference Plan Configuration/Rx mode and 
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system variant of the wanted assignment (similar to  Figure 3.135). There are also some 

user options for selection of: search radius, frequency range, interference time percentage, 

environment and consideration of analogue plan, digital plan, stations in fixed and land 

mobile service and the antenna discrimination for calculation of the interference-limited 

coverage area. Similar to the Figure 3.136, the list of all interferer 

stations/assignments/allotments, meeting conditions, is listed in a spreadsheet from which 

users can select, by mouse left click on the record select column, some or all of them for 

calculation of the interference-limited coverage area. When the OK button is pushed the 

calculation starts and a progress bar is displayed. Nuisance field strengths caused by the 

interfering stations/assignments/allotments are calculated at each of the noise-limited test 

points. All linked assignments and/or associated allotment with interfering digital 

broadcasting assignment/allotment, based on its plan entry code, are considered by 

software for calculation of nuisance field strengths. The technical criteria have been fully 

defined in GE06 Plan. Usable field strength is calculated for each of these test points and 

then the new coverage radius will be found on the bearing at which the field strength from 

the wanted station equals (or exceed) the usable field strength. Finally, the service area 

test points will be displayed on the DEM map (see Figure 3.137). 

  

Figure 3.134. Dialogue box for determination of service area parameters 
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Figure 3.135. Spreadsheet of broadcasting assignments  

 

 

 

 

 

 

 

 

 

 

Figure 3.136. Spreadsheet of found interferer stations/assignments/allotments 

 

 

 

 

 

 

 

 

 

Figure 3.137. Result of calculation of service area test points for a broadcasting assignment 
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The calculated service area test points as well as the usable field strength and wanted field 

strength value on each test point may be displayed by a mouse right click on the 

frequency level of a wanted assignment in the Administrative window (see Figure 3.142). 

In the case of User Defined Service Area, the user can attach a desired service area to the 

wanted assignment. As the first step, desired service area must be drawn on the map as a 

polyline (similar to Figure 3.138). After that, the option for selecting the “User Defined 

Service Area” in service area parameters will be active and user may select it (see Figure 

3.139). All broadcasting assignments (in conformity with GE06 Plan) will be listed in a 

spreadsheet and users may select the concerned assignment (digital/analogue), using a 

mouse left click on the record-select column of this spreadsheet. When the wanted 

assignment has been selected, another dialogue box will appear for the user to determine 

environment (see Figure 3.140). If the wanted assignment is an analogue station, the 

usable field strength (UFS) is also calculated at each test point which may be required for 

calculation of interference by other functions. Finally, the service area test points will be 

displayed on the DEM map (see Figure 3.141).  

Also it is possible to create and display the result contour file(s) in Google Earth. 

  
 

Figure 3.138. Desired service area should be drawn on map as a poly line 

 

 

 

 

 

 

 

 

 
 

Figure 3.139. Dialogue box for determination of service area parameters 
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Figure 3.140. Spreadsheet of broadcasting assignments  

 

 

 

 

 

 

 

 

 

 

Figure 3.141. User defined service area test points for a broadcasting assignment  

 

 

 

 

 

 

 

 

 

 

 

 

The calculated service area test points as well as the median field strength/usable field 

strength (in the case of analogue assignments) and wanted field strength value on each 

test point may be displayed by a mouse right click on the frequency level of a wanted 

assignment in the Administrative window (see Figure 3.142). 

Figure 3.142. Characteristics of service area test points for a broadcasting assignment  
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3.4.2.12.4.1. GE06 Interference To sub-menu of DEM view 

Under this sub-menu, different scenarios of interference calculations have been implemented for 

the broadcasting assignments/allotments and stations in the fixed and land mobile services in the 

GE06 Plan. The following items have been designed for this sub-menu: 

 BCBT2DBCBT: This item calculates interference from an analogue TV assignment or a 

digital BCBT Plan Entry to digital BCBT assignments/allotments. All broadcasting 

assignments/allotments (in conformity with GE06 Plan) will be listed in a spreadsheet and 

the user may select the concerned assignments/allotments, using a mouse left click on the 

record-select column of spreadsheet. When the wanted broadcasting assignment 

/allotment has been selected, a dialogue box will appear for the user to determine: the 

search radius, search frequency range, percentage of time, protection margin limit, 

environment and implementation of receiving antenna discrimination (see Figure 3.143). 

All linked assignments and/or associated allotment with wanted digital broadcasting 

assignment/allotment, based on its plan entry code, are considered by the software for 

calculation of nuisance field strengths. Once the calculation parameters have been 

determined, a list of all victim digital broadcasting assignments/allotments that meet the 

conditions, is listed in a spreadsheet from which users may select some or all of them for 

the next calculation step by a mouse left click on the record select column (similar to 

Figure 3.144). When the OK button is pushed, the calculation starts and a progress bar is 

displayed. Interference is calculated at each service area test point of the victim 

assignments or at each test point of the victim allotments and the maximum value of 

interference among all test points of a victim assignment/allotment is considered. For this 

purpose, the combined nuisance field strength value is subtracted from the minimum 

median field strength at each test point to give the protection margin. The minimum value 

of protection margin is considered and compared with the protection margin limit.  

Finally, a spreadsheet lists the victim assignments/allotments with their country and 

administration code, minimum protection margin and relevant test point, combined 

nuisance field strength value and minimum median field strength value. The first row of 

this spreadsheet displays a summary of information about the wanted broadcasting 

assignment/allotment and its linked assignments and/or associated allotment. Figure 3.145 

displays a sample output from the BCBT2DBCBT interference calculation. 

 

Figure 3.143. Spreadsheet of interferer digital/analogue broadcasting assignments/allotments 
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 Figure 3.144. Spreadsheet of found victim digital assignments/allotments 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.145. Sample output from BCBT2DBCBT interference calculation 

 

 

 

 

 

 

 

 

 

 

 

 

The column “PM min” reports an interference case and can be identified visually by a red 

background among the other values in this column. 

The information displayed in the result spreadsheets can be presented (and saved) in the 

form of a report with the HTML format by using “Report” push button. 

 BCBT2ABT: Item to calculate interference caused by an analogue TV assignment or a 

digital BCBT Plan Entry to analogue TV assignments. All broadcasting 

assignments/allotments (in conformity with GE06 Plan) will be listed in a spreadsheet and 

users may select the concerned assignments/allotments using a mouse left click on the 

record-select column of this spreadsheet. When the wanted broadcasting assignment 

/allotment has been selected, a dialogue box will appear for the user to specify values for: 

the search radius, searching frequency range, percentage of time, limiting margin, 

environment and implementation of receiving antenna discrimination (see Figure 3.146). 

All linked assignments and/or associated allotment belonging to the wanted digital 

broadcasting assignment/allotment, based on its plan entry code, are considered by 

software for calculation of nuisance field strengths. Once the calculation parameters have 

been specified, a spreadsheet is displayed, listing all victim analogue broadcasting 

assignments, meeting conditions. The user may select some or all of them for the next 
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calculation step by a mouse left click on the record select column (similar to Figure 

3.147). When the OK button is pushed, the calculation starts and a progress bar is 

displayed. Interference is calculated at each service area test point of victim assignments 

and the maximum value of interference among all test points of a victim assignment is 

considered. For this purpose, at each test point of the victim assignment, the power sum 

value of UFS (Usable Field Strength value calculated by service area function) and 

nuisance field strength value is calculated. The nuisance field strength is subtracted from 

the value of UFS to give Margin. The maximum value of Margin among the test points is 

considered to compare with limiting margin.  

Finally, a spreadsheet is displayed listing the victim assignments with their country and 

administration code, maximum value of margin and relevant test point, nuisance field 

strength value and wanted field strength. The top row of this spreadsheet contains a 

summary of information about the wanted broadcasting assignment/allotment and its 

linked assignments and/or associated allotment. Figure 3.148 shows a sample output of 

the BCBT2ATV interference calculation. 

 

Figure 3.146. Spreadsheet of interferer digital/analogue broadcasting assignments/allotments 

 

 

 

 

 

 

 

 

 

 

 

 

 Figure 3.147. Spreadsheet of found victim analogue assignments 
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Figure 3.148.Sample output of BCBT2ATV interference calculation 

 

 

 

 

 

 

 

 

 

 

 

 

 

The column “Margin max” reports an interference case that can be identified visually by a 

red background among the other values in this column, 

The information displayed in the result spreadsheets may be presented as a report (and 

saved in a file) with the HTML format by using the “Report” push button. 

 FXM2DBCBT: This item calculates interference caused by a station in the fixed or land 

mobile services to digital BCBT assignments/allotments. All stations in the fixed or land 

mobile services (in conformity with GE06 Plan) will be listed in a spreadsheet and the 

user may select the concerned station, using a mouse left click on the record-select 

column of this spreadsheet (see Figure 3.149). When the wanted station has been selected, 

a dialogue box will appear for the user to specify values for: the search radius, search 

frequency range, percentage of time, protection margin limit, environment and 

implementation of receiving antenna discrimination. In the case of the interfering mobile 

station or typical station, the software asks for the location of the station. There are three 

possibilities: as nearest point to victim assignment/ allotment, gravity point of service area 

and user defined location (see Figure 3.150). Once the calculation parameters have been 

specified, a spreadsheet displays a list of all victim digital broadcasting 

assignments/allotments that meet the conditions and the user may select some or all of 

them for the next calculation step by a mouse left click on the record select column 

(similar to Figure 3.151). When the OK button is pushed, the calculation starts and a 

progress bar is displayed. Interference is calculated at each service area test point of 

victim assignments, or at each test point of victim allotments, and the maximum value of 

interference among all test points is considered. For this purpose, the combined nuisance 

field strength value is subtracted from the minimum median field strength at each test 

point to give the protection margin. The minimum value of protection margin is 

considered and compared with protection margin limit.  

Finally, a spreadsheet displays a list of the victim assignments/allotments with their 

country and administration code, minimum protection margin and relevant test point, 

combined nuisance field strength value and minimum median field strength. The top row 

of this spreadsheet contains a summary of information about the wanted station. Figure 

3.152 displays a sample output of the FXM2DBCBT interference calculation. 
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Figure 3.149. Spreadsheet of interferer stations in fixed and land mobile services 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.150. Sample of interference calculation parameters for fixed/base stations and mobile/typical stations 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Figure 3.151. Spreadsheet of found victim digital assignments/allotments 
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Figure 3.152. Sample output of FXM2DBCBT interference calculation 

 

 

 

 

 

 

 

 

 

 

 

 

The column “PM min” reports an interference case and can be identified visually by a red 

background among the other values in this column. 

The information displayed in the result spreadsheets can be presented as a reported (and 

saved in a file) with the HTML format by using the “Report” push button. 

 FXM2ABT: This item calculates interference caused by a station in fixed or land mobile 

service to analogue TV assignments. All stations (in conformity with GE06 Plan) will be 

listed in a spreadsheet and users may select the concerned station, using a mouse left click 

on the record-select column of this spreadsheet. When the wanted station has been 

selected, a dialogue box will appear for the user to specify values for: the search radius, 

searching frequency range, percentage of time, limiting margin, environment and 

implementation of receiving antenna discrimination (see Figure 3.153). Once values for 

the calculation parameters have been specified, a spreadsheet displays a list of all victim 

analogue broadcasting assignments that meet the conditions and users may select some or 

all of them for the next calculation step by a mouse left click on the record select column 

(similar to Figure 3.154). When the OK button is pushed, calculation starts and a progress 

bar is displayed. Interference is calculated at each service area test point of victim 

assignments and the maximum value of interference is considered among all test points. 

For this purpose, at each test point of the victim assignment, the power sum value of UFS 

(Usable Field Strength value calculated by service area function) and nuisance field 

strength value is calculated. The nuisance field strength value is subtracted from the value 

of UFS to give the Margin. The maximum value of Margin among test points is 

considered and compared with the limiting Margin.  

Finally, a spreadsheet lists the victim assignments with their country and administration 

code, maximum value of margin and relevant test point, nuisance field strength value and 

wanted field strength. The first row of this spreadsheet contains summary information 

about the wanted station. Figure 3.155 displays a sample output of the FXM2ABT 

interference calculation. 
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Figure 3.153. Spreadsheet of interferer stations in fixed and land mobile services 

 

 

 

 

 

 

 

 

 

 

 

 

 Figure 3.154. Spreadsheet of found victim analogue assignments 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.155. Sample output of FXM2ABT interference calculation 

 

 

 

 

 

 

 

 

 

 

 

 

The column “Margin max” reports an interference case and the red background identifies 

it visually from the other values in this column. 
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The information displayed in the result spreadsheets can be presented as a report and 

saved in the HTML format by using “Report” the push button. 

 BCBT2FXM: this item calculates interference caused by an analogue TV assignment or a 

digital BCBT Plan Entry to stations in the fixed or land mobile services. All broadcasting 

assignments/allotments (in conformity with GE06 Plan) will be listed in a spreadsheet and 

the user may select the concerned assignments/allotments, using a mouse left click on the 

record-select column of this spreadsheet. When the wanted broadcasting assignment 

/allotment has been selected, a dialogue box will appear for the user to specify values for:  

the search radius, search frequency range, percentage of time, protection margin limit, 

environment and implementation of receiving antenna discrimination (see Figure 3.156). 

All linked assignments and/or associated allotment belonging to the wanted digital 

broadcasting assignment/allotment, based on its plan entry code, are considered by the 

software for the calculation of nuisance field strengths. Once the calculation parameter 

values have been specified, a spreadsheet lists all victim stations in the fixed or land 

mobile services that meet the conditions, from which users may select some or all of them 

for the next calculation step by a mouse left click on the record select column (similar to 

the Figure 3.157). When the OK button is pushed, the calculation starts and a progress bar 

is displayed. Interference is calculated at receiving stations, or at each service area test 

point of victim stations, and the maximum value of interference is determined by 

comparing the values from all test points. For this purpose, the nuisance field strength 

value is subtracted from the minimum median field strength at each test point to give the 

protection margin. The minimum value of protection margin is considered and compared 

with the protection margin limit. In the generic case for FXM stations, the interference 

field strength generated by TV assignment\allotment is compared with the maximum 

allowed interference level, which is calculated based on the GE06 Agreement (GE06, 

Appendix to Annex 4.2).   

Finally, a spreadsheet lists: the victim stations with their country and administration code, 

minimum protection margin/ the interference field strength generated by TV assignment 

or allotment (INTFS) subtracted from the maximum allowed interference level (E) and 

relevant test point, nuisance field strength value and minimum median field strength. The 

first row of this spreadsheet contains a summary of information about the wanted 

broadcasting assignment/allotment and its linked assignments and/or associated allotment. 

Figure 3.158 displays a sample output of the BCBT2FXM interference calculation. 

 

Figure 3.156. Spreadsheet of interferer digital/analogue broadcasting assignments/allotments 
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Figure 3.157. Spreadsheet of found victim stations in fixed or land mobile service 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.158. Sample output of BCBT2FXM interference calculation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The column “PM min” reports an interference case and the red background identifies it 

visually from the other values in this column. 

The information displayed in the result spreadsheets may be presented as a report and 

saved in the HTML format by using the “Report” push button. 
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3.4.2.12.4.2. GE06 Interference From sub-menu of DEM view 

Under this sub-menu different scenarios of interference calculations have been implemented for 

the broadcasting assignments/allotments and stations in the fixed and land mobile services in 

GE06 Plan. The following items have been designed for this sub-menu: 

 BCBT2DBCBT: This item calculates interference to a digital BCBT 

assignment/allotment caused by analogue TV assignments or digital BCBT Plan Entries. 

All digital broadcasting assignments/allotments (in conformity with GE06 Plan) will be 

listed in a spreadsheet and the user may select the victim assignment/allotment, using a 

mouse left click on the record-select column of this spreadsheet. When the victim digital 

broadcasting assignment/allotment has been selected, a dialogue box will appear for the 

user to specify values for the search radius, search frequency range, percentage of time, 

protection margin limit, environment and implementation of receiving antenna 

discrimination (see Figure 3.159). Once the values for the calculation parameters have 

been specified, a spreadsheet lists all interferer broadcasting assignments/allotments, 

meeting conditions, from which the user may select some or all of them for the next 

calculation step by a mouse left click on the record select column (similar to Figure 

3.160). When the OK button is pushed, the calculation starts and a progress bar is 

displayed. Interference is calculated at each service area test point of victim assignment, 

or at each test point of victim allotment, and the maximum value of interference is 

determined by comparing values at all test points. For this purpose, the combined 

nuisance field strength value is subtracted from minimum median field strength at each 

test point to give the protection margin. The minimum value of protection margin is 

considered and compared with the protection margin limit. All linked assignments and/or 

associated allotment belonging to the interfering digital broadcasting 

assignment/allotment, based on its plan entry code, are considered by the software for the 

calculation of nuisance field strengths.  

Finally, a spreadsheet lists: the interferer assignments/allotments and their linked 

assignments and/or associated allotment with their country and administration code, 

minimum protection margin and relevant test point, combined nuisance field strength 

value and minimum median field strength. The first row of the spreadsheet contains 

summary information about the victim broadcasting assignment/allotment. Figure 3.161 

displays a sample output of the BCBT2DBCBT interference calculation. 

 

Figure 3.159. Spreadsheet of victim digital broadcasting assignments/allotments 
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Figure 3.160. Spreadsheet of interferer digital/analogue broadcasting assignments/allotments 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.161. Sample output of BCBT2DBCBT interference calculation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The column “PM min” reports an interference case and the red background identifies it 

visually from the other values in this column. 

The information displayed in the result spreadsheets may be displayed as a report and 

saved in the HTML format by using the “Report” push button. 

 BCBT2ABT: This item calculates interference to an analogue TV assignment caused by 

analogue TV assignments or digital BCBT Plan Entries. All analogue TV assignments (in 

conformity with GE06 Plan) will be listed in a spreadsheet and the user may select the 

victim assignment, using a mouse left click on the record-select column of this 

spreadsheet. When the victim broadcasting assignment has been selected, a dialogue box 

will appear for the user to specify values for: the search radius, search frequency range, 

percentage of time, limiting margin, environment and implementation of receiving 

antenna discrimination (see Figure 3.162). Once the calculation parameters have been 
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determined, a spreadsheet lists all interferer analogue TV assignments or digital BCBT 

assignments/allotments, that meet the conditions, from which users may select some or all 

of them for the next calculation step by a mouse left click on the record select column, 

(similar to Figure 3.163). When the OK button is pushed, the calculation starts and a 

progress bar is displayed. Interference is calculated at each service area test point of 

victim assignment and the maximum value of interference is determined by comparing 

the values from all test points. For this purpose, at each test point of the victim 

assignment, the power sum value of UFS (Usable Field Strength value calculated by 

service area function) and nuisance field strength value is calculated. The nuisance field 

strength value is subtracted from the value of UFS to give the Margin. The maximum 

value of Margin among test points is considered and compared with the limiting margin. 

All linked assignments and/or associated allotment belonging to the interfering digital 

broadcasting assignment/allotment, based on its plan entry code, are considered by the 

software for calculation of nuisance field strengths.   

Finally, a spreadsheet lists: the interfering assignments/allotments and their linked 

assignments and/or associated allotment with their country and administration code, 

maximum value of margin and relevant test point, nuisance field strength value and 

wanted field strength. The first row of this spreadsheet contains a summary of information 

about the victim TV analogue assignment. Figure 3.164 displays a sample output of the 

BCBT2ATV interference calculation. 

Figure 3.162. Spreadsheet of victim analogue broadcasting assignments 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.163. Spreadsheet of interferer digital/analogue broadcasting assignments/allotments 
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Figure 3.164. Sample output of BCBT2ABT interference calculation 

 

 

 

 

 

 

 

 

 

 

 

The column “Margin max” reports an interference case and can be identified by red 

background among other values in this column, visually.  

The information displayed in result spreadsheets can be reported in a file presented in a 

report-style with the HTML format by using “Report” push button. 

 FXM2DBCBT: Item to calculate interference to a digital BCBT assignment/allotment 

caused by stations in fixed or land mobile service. All digital BCBT 

assignments/allotments (in conformity with GE06 Plan) will be listed in a spreadsheet and 

users could select the victim assignment/allotment, using a mouse left click on the record-

select column of spreadsheet. When the victim assignment/allotment selected, a dialogue 

box will appear to determine the search radius, searching frequency range, percentage of 

time, protection margin limit, environment and implementation of receiving antenna 

discrimination. In the case of interferer mobile station or typical station, there are three 

possibilities as nearest point to victim assignment/allotment, gravity point of service area 

and user defined location as displayed in Figure 3.165. Once the calculation parameters 

determined, list of all interferer stations in fixed and mobile services, meeting conditions, 

is listed in a spreadsheet which users can select some or all of them for next calculation 

step by mouse left click on record select column, Similar to the Figure 3.166. Calculation 

starts and relevant progress bar is displayed if OK button pushed. Interference is 

calculated at each service area test point of victim assignment or at each test point of 

victim allotment and the maximum value of interference is considered among all test 

points. For this purpose combined nuisance field strength value is subtracted from 

minimum median field strength at each test point to give protection margin. The 

minimum value of protection margin is considered and compared with protection margin 

limit. Finally, the interferer stations in fixed and mobile services with their country and 

administration code, caused minimum protection margin and relevant test point, caused 

combined nuisance field strength value and the minimum median field strength are listed 

in a spreadsheet below the general information of victim digital assignment/allotment. 

Figure 3.167 displays a sample output of FXM2DBCBT interference calculation. 

 



 
168 

Figure 3.165. Spreadsheet of victim digital assignment/allotment 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.166. Spreadsheet of found interferer stations in fixed and land mobile services  

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.167. Sample output of FXM2DBCBT interference calculation 
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The column “PM min” reports an interference case and the red background identifies it 

visually from the other values in this column. 

The information displayed in the result spreadsheets may be presented as a report and 

saved in the HTML format by using the “Report” push button. 

 FXM2ABT: This item calculates interference to an analogue TV assignment caused by 

stations in the fixed or land mobile services. All analogue TV assignments (in conformity 

with GE06 Plan) will be listed in a spreadsheet and the user may select the victim 

analogue TV assignment, using a mouse left click on the record-select column of this 

spreadsheet. When the victim analogue TV assignment has been selected, a dialogue box 

will appear for the user to specify values for: the search radius, search frequency range, 

percentage of time, limiting margin, environment and implementation of receiving 

antenna discrimination (see Figure 3.168). Once values for the calculation parameters 

have been specified, a spreadsheet lists: all interfering stations in the fixed and land 

mobile services that meet the conditions, from which users may select some or all of them 

for the next calculation step by a mouse left click on the record select column (similar to 

the Figure 3.169). When the OK button is pushed, the calculation starts and a progress bar 

is displayed. Interference is calculated at each service area test point of victim assignment 

and the maximum value of interference is determined by comparing the values at all test 

points. For this purpose, at each test point of the victim assignment, the power sum value 

of UFS (Usable Field Strength value calculated by service area function) and nuisance 

field strength value is calculated. The nuisance field strength value is subtracted from the 

value of UFS to give the Margin. The maximum value of Margin among test points is 

considered and compared with the limiting margin.  

Finally, a spreadsheet lists: the interfering stations in the fixed or land mobile services 

with their country and administration code, maximum value of margin and relevant test 

point, nuisance field strength value and wanted field strength. The first row of this 

spreadsheet contains a summary of information about the victim analogue TV assignment. 

Figure 3.170 displays a sample output of the FXM2ATV interference calculation. 

 

Figure 3.168. Spreadsheet of victim analogue assignment  
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 Figure 3.169. Spreadsheet of interferer stations in fixed and land mobile services 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.170. Sample output of FXM2ABT interference calculation 

 

 

 

 

 

 

 

 

 

 

 

 

 

The column “Margin max” reports an interference case and the red background identifies 

it visually from the other values in this column. 

The information displayed in the result spreadsheets can be presented as a report and 

saved in the HTML format by using the “Report” push button. 

 BCBT2FXM: This item calculates interference to a station in the fixed or land mobile 

services caused by analogue TV assignments or digital BCBT Plan Entries. All stations in 

fixed or land mobile service (in conformity with GE06 Plan) will be listed in a 

spreadsheet and the user may select the victim station, using a mouse left click on the 

record-select column of this spreadsheet. When the victim station has been selected, a 

dialogue box will appear for the user to specify values for: the search radius, search 

frequency range, percentage of time, protection margin limit, environment and 

implementation of receiving antenna discrimination (see Figure 3.171). Once the values 

for the calculation parameters have been specified, a spreadsheet lists all the interfering 

broadcasting assignments/allotments that meet the conditions, from which users may 

select some or all of them for the next calculation step by a mouse left click on the record 
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select column (similar to Figure 3.172). When the OK button is pushed, the calculation 

starts and a progress bar is displayed. Interference is calculated at receiving stations or at 

each service area test point of victim stations and the maximum value of interference is 

determined by comparison of the values of all test points. For this purpose, the nuisance 

field strength value is subtracted from minimum median field strength at each test point to 

give the protection margin. The minimum value of protection margin is considered and 

compared with the protection margin limit. In the generic case for FXM stations, the 

interference field strength generated by TV assignment\allotment is compared with the 

maximum allowed interference level which calculated based on GE06 Agreement 

(Appendix to Annex 4.2). All linked assignments and/or associated allotment belonging 

to the interfering digital broadcasting assignment/allotment, based on its plan entry code, 

are considered by the software for the calculation of nuisance field strengths.  

Finally, a spreadsheet lists: the interferer assignments/allotments and their linked 

assignments and/or associated allotment, their country and administration codes,  

minimum protection margin/ the interference field strength generated by TV 

assignment\allotment (INTFS) subtracted from the maximum allowed interference level 

(E) and relevant test point, nuisance field strength value and minimum median field 

strength. The first row of this spreadsheet contains a summary of information about the 

victim station. Figure 3.173 displays a sample output of the BCBT2FXM interference 

calculation. 

 

Figure 3.171. Spreadsheet of victim station in fixed or land mobile service 
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Figure 3.172. Spreadsheet of found interferer digital/analogue broadcasting assignments/allotments 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.173. Sample output of BCBT2FXM interference calculation 

 

 

 

 

 

 

 

 

 

 

 

 

 

The column “PM min” reports an interference case and the red background identifies it 

visually from the other values in this column. 

The information displayed in the result spreadsheets may be presented as a report and 

saved in the HTML format by using the “Report” push button. 
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3.4.2.12.5. Agreement item in Coordination menu of DEM view 

The item “Agreement” in Coordination menu enables the entry of user-defined agreements which 

may be used for border coordination through the “Border” item in Section 3.4.2.12.6. Each 

agreement consists of two parts; header and technical characteristics. Figure 3.174 displays the 

entry mask for user-defined agreements. 

 

Figure 3.174.a) User-defined agreement entry mask and b) List of countries which could be selected 

 

 

 

 

 

 

 

 

 

 

 

 

                           (a) User-defined agreement entry mask                                        (b) List of selectable countries 

 

The header part of entry mask defines: the agreement name, incorporated countries, included 

radiocommunication service(s), propagation models and category of agreement. Currently, 

SMS4DC employs P.1546 and Free Space propagation models for border calculation based on 

user-defined agreements. Only one propagation model per agreement can be selected using the 

button, on the right panel of the entry field. Multiple countries can be selected to be added to the 

list of member countries by pushing the button on the right side of the entry field. The following 

categories can be set using two combo boxes; Mode and Type. Table 3.6 presents the available 

categories for definition of agreements. The software is installed without any border agreements, 

therefore the agreement table will be blank (see Figure 3.174) until the user defines an agreement. 

Table 3.6. Available categories for user-defined agreements 

Mode Mode 1 Mode 2 

Service Land Mobile Fixed Land Mobile Fixed 

Frequency(1) All Frequencies Below 1GHz Above 

1GHz 

All Frequencies Below 1GHz 

Type A A A A B No type is applicable 

Model P.1546 Free Space P.1546 Free Space - P.154

6 

Free Space P.1546 Free Space 

Contour type 
CBR CBR CBR CBR 

Coordination 

Distance 
X-km X-km X-km X-km 

(1): The actual frequency range of agreement is the combination with the propagation model frequency range  
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The contour type, used in Table 3.6, will be explained in Section 3.4.2.12.6. The content of the 

spreadsheet, in the lower part of agreement entry mask, varies for different categories of 

agreement. All fields in the spreadsheet are editable, except AgID. Editing of the field 

“PrefCountries” is managed by the push button “Preferential Countries” at the bottom of the 

entry mask. Table 3.7 describes the spreadsheet data (entry) fields and shows what type of 

agreement configuration causes them to be presented to the user. 

 

Table 3.7. Description of fields used in the spreadsheet 

Field name Description Category 

Mode Type 

AgID The ID number of an agreement in the database. All All 

LoFreq,HiFreq The lower and upper edge of the applicable frequency range (MHz). All All 

PrefCountries The list of preferential countries. If this cell in relevant row or the row is selected, 

the “Preferential Countries” push button can be used for choosing and inserting 

data in this cell. 

2 --- 

PIFS Permissible Interference Field Strength. This value (in dBV/m) is compared with 

the calculated field strength value to determine whether or not coordination is 

necessary. 

All A 

CBR The CBR (Cross Border Range), in km, is the distance beyond the national border 

used to establish a contour of points.  The distance of any point on this contour to 

the border, along the line connecting to the concerned station, will be identical and 

equal to CBR (see Figure 3.175). 

1 A 

X-km The X-km, in km, is the distance beyond national border used to establish a contour 

of points. The nearest distance of any point on this contour to the border will be 

identical and equal to X-km (see Figure 3.175). 

2  

CoordDist1  The coordination distance used where the summation of station height, above sea 

level, and antenna height, above ground level, is less than 300 metres. 

1 B 

CoordDist2 The coordination distance used where the summation of station height, above sea 

level, and antenna height, above ground level, is over 300 metres. 

1 B 

ERP The Effective Radiated Power (ERP), in dBW, of reference transmitter, used for 

field strength calculations (except in type B, mode 1). 

All A 

Emergency The code indicating the operation type for the frequency band, 1 for emergency and 

0 for normal operation modes. This field is available for all categories of 

agreement. 

All All 

 

A set of standard toolbar buttons is provided for browsing the content of user-defined 

agreements. These buttons are explained in Table 3.8. The modify push button may be used to 

modify the displayed agreement. The values entered in the spreadsheet will be saved in the 

agreement directly, without need to push the save button. 
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Table 3.8. Toolbar push buttons provided for browsing of user-defined agreements 

Item Description 

 
Push buttons to load entry mask with the first agreement. 

 
Push button to load entry mask with the previous agreement. 

 
Push button to load entry mask with the next agreement. 

 
Push buttons to load entry mask with the last agreement. 

 
Push buttons to reset the dialogue box for addition of a new agreement. 

 
Push buttons to delete the current agreement. 

 
Push buttons to save a modified or new agreement. Pushing this button is necessary after any 

modification to the header part. 

 

 

3.4.2.12.6. Border coordination item in Coordination menu of DEM view 

The item “Border” in the menu of Coordination performs the border coordination calculations for 

concerned stations in the fixed or land mobile radiocommunication services, in accordance with a 

known bilateral/multilateral agreement. The term “border coordination” refers to procedures 

involving various types of field strength calculation beyond a distance from the country border. 

This field strength has to be calculated when the CBR (Cross Border Range) and X-km 

categories are used to construct the contour. The CBR contour is the locus of points where their 

distances to the border, along the line connecting points to the concerned station, are identical. 

The x-km contour is the locus of points where their nearest distance to the border is set at an 

agreed value of x km. Figure 3.175 compares these categories. 

 

Figure 3.175. Categories of contour definition for field strength calculation in border coordination 

 

 

 

 

 

 

 

(a) Method of CBR      (b) Method of X-km 

 

Information concerning reference bilateral/multilateral agreements may be entered into the 

SMS4DC database from the item: “Coordination->Agreement” in Database menu. 

After selecting this item, a spreadsheet is opened of the fixed and land mobile stations in the 

database. The user is able to select one station by a mouse left click on the relevant row of the 

record select column. By pushing the OK button below the spreadsheet, SMS4DC searches the 

database for applicable border agreements (with their reference calculations) to be used for the 

Station Station 

Contour Contour 

Border Border 

X – km  
from border 
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selected station. Figure 3.176 displays a sample spreadsheet of stations in the fixed and land 

mobile services. 

 

Figure 3.176. Spreadsheet of stations in fixed and land mobile service 

 

 

 

 

 

 

 

 

 

 

 

 

If an applicable agreement (or agreements) is found, they will be displayed in a subsequent 

spreadsheet. The applicability of agreements will depend on the frequency, country and service 

type of the selected station. Several informative fields, such as: code of participating countries, 

services included and contour definition category, are presented for each agreement displayed. A 

blank spreadsheet means that no applicable agreement exists. 

 

Figure 3.177. An example of applicable agreement to the selected station 

 

 

 

 

 

 

 

 

 

 

 

 

After choosing one of the presented applicable agreements, the search radius will be requested as 

additional criteria. Once the search radius has been specified, a dialogue boxes will be opened. 

There are different types of dialogue box depending on the type of accepted propagation model in 

the agreement and class of selected station. In the case of a selected station in the land mobile 

service, a dialogue box will be opened to determine the location of the mobile station in order to 

conduct the field strength calculation (see Figure 3.178a). In addition to the mobile station name, 

the user has to decide the location of mobile station in one of the following situations: the centre 
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of circular service area, the closest distance to the concerned country or a specific point inside the 

service area.  

 

 

 Figure 3.178. a) Dialogue box of  mobile station location and b) ITU-R P.1546 propagation model parameters 

c) Search area determination 

 

 

 

 

 

 

 

 

 

 

                 (b) Propagation model parameters 

 

            (a) Dialogue of mobile station location 

 

 

 

 

               (c) Search area determination  

 

This dialogue box will be repeated for any neighbouring country inside the circular search area 

around the selected station. In the case of using the ITU-R P.1546 propagation model, another 

dialogue box will be opened to set values for the model’s parameters such as: time percentage, 

search frequency range, k-factor and type of environment and receiver height (see Figure 

3.178b). 

After finishing the calculations and closing the progress bar, the result dialogue box will be 

displayed. The wanted station information is displayed above the result dialogue box while the 

calculation results are listed in the lower table. The fields representing the calculation results are 

different for the different categories of calculation contour (CBR or X-km) and selected station. 

Figure 3.179 displays these different result dialogue boxes, created for different scenarios of 

border calculation. Table 3.6 describes the fields used in the different result dialogue boxes 

displayed in Figure 3.179.  
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Table 3.9. Description of fields used to represent results of border calculation 

Field Description 

Type of Agreement 

Frequency Requiring 

coordination 
Preferential 
Frequency 

Type A: LM in 

all frequency and 
FX  below 1GHz 

Type B: FX 
above 1GHz 

LM in all frequency 
and FX below 1GHz 

Frequency Frequency under investigation X X X 

TX or RX Mode of frequency under investigation X X X 

Concerned countries Countries likely to be affected by a 

station in another country 
X X X 

Max. Eb Maximum field strength on border line X  X 

Max. Eb location The location of maximum Eb X  X 

DistB Distance of wanted station to the 

maximum Eb location 
X  X 

Max Ec Maximum field strength on CBR (Figure 

3.175) 
X   

Max. Ec location The location of maximum Ec X   

DistC Distance of wanted station to the 

maximum Ec location 
X   

Max Ex Maximum field strength on X-km 

contour (Figure 3.175) 
  X 

Max. Ex location The location of maximum Ex   X 

DistX Distance of wanted station to the 

maximum Ex location 
  X 

PIFS Permissible Interference Field Strength 

in accordance with agreement 
X  X 

CBR Cross Border Range in accordance with 

agreement 
X   

X-km Contour of X km beyond wanted country 

border line 
  X 

Min. DistB Minimum distance of wanted station to 

the border line 
 X  

Min DistB location The location of maximum Eb  X  

Coord. Dist. Minimum permitted distance to the 

border (from agreement) for comparison 

with MinDistB  

 X  
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Figure 3.179. Border coordination result windows for different type of wanted-victim stations configuration 
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Users are able to generate and store an HTML report of any type of results by pushing the 

“Report” button in the bottom of the result dialogue box. 

 

3.4.2.12.7. HCM Agreement item in Coordination menu of DEM view 

The item “HCM Agreement” in the menu of Coordination, performs the coordination 

calculations for concerned stations in the fixed or land mobile radiocommunication services, in 

accordance with Harmonized Calculation Method (HCM) agreement. This function needs the 

path of relevant maps (TOPO, MORPHO, BORDER) in appropriate format. The path should be 

specified in a file which is named PATH.DAT in SMS4DC/bin folder. If the software cannot find 

the PATH.DAT, it warns and then asks the path of relevant maps, as shown on Figure 3.HCM.1. 

 

Figure 3.HCM.1. The path of relevant maps to be used by HCM Agreement function 

 

 

 

 

 

 

After successful creation of the PATH.DAT, a dialogue box including the functions of HCM 

Agreement will be appeared for fixed and mobile services as displayed on Figure 3.HCM.2. 

The "Directory setting" button of the dialogue box can be used to modify the path of relevant 

maps.  

 

 Fixed service 

The "No Passive Repeater" and "With passive repeater", buttons are for performing the 

interference calculation between two stations or between two stations trough passive 

repeaters. Also there is "Affected Administration" button for fixed service for identification 

of affected administrations based on HCM Agreement. 
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Figure 3.HCM.2. HCM Agreement functions for Fixed and Mobile services 

 
 

With selecting the "Interference Calculations / No Passive Repeater " button, a spreadsheet is 

displayed listing the existing stations. After selecting of two stations (transmitter and receiver 

stations) the results of interference calculation will be displayed as shown in Figures 3.HCM.3 

and 3.HCM.4.  

 

Figure 3.HCM.3. Spreadsheet of Fixed stations in HCM Agreement Function for Fixed service without 

Repeater 
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Figure 3.HCM.4. Sample output of HCM Agreement for Fixed service without Repeater  

 
 

With selecting the "Interference Calculations / With Passive Repeater " button, a spreadsheet is 

displayed listing the existing stations. After selecting of four stations (Transmitter, repeaters and 

receiver stations) the results of interference calculation will be displayed as shown in Figures 

3.HCM.4 and 3.HCM.6.  

 

Figure 3.HCM.5. Spreadsheet of Fixed stations in HCM Agreement Function for Fixed service with Repeater 
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Figure 3.HCM.6. Sample output of HCM Agreement for Fixed service with Repeater  

 
 

By selecting the "Affected Administrations" a list of existing fixed stations will be appeared as 

shown on Figure 3.HCM.7, and by selecting of the wanted station the list of affected 

administrations, based on HCM Agreement, will be displayed as shown in Figure 3.HCM.8. 

 

 

Figure 3.HCM.7. Spreadsheet of Fixed stations in HCM Agreement Function for determination of affected 

Administrations 
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Figure 3.HCM.8. Sample output of HCM Agreement for determination of affected Administrations in Fixed 

service  

 

 

 Mobile service 

Figure 3.HCM.2 shows the list of functions for mobile service. The HCM program including the 

choice of  different calculation-modes, these choices are called CMODE. Negative CMODE - 

codes are for (border-) line-calculations. Transmitter-data has to be supplied and appropriate 

(border-) line should be selected. Zero and all positive CMODE-codes are for station to station 

calculations.  

 

Station to station, Zero and all positive CMODE-codes, these items calculate the interference 

between two stations. After choosing one of these items, all mobile stations will be listed in a 

spreadsheet and the user may select, using a mouse left click on the record-two stations as  

transmitter and receiver as shown in Figure 3.HCM.9. 

 

 

Figure 3.HCM.9. Spreadsheet of Mobile stations in HCM Agreement Functions for interference calculations 

between two stations 

 
 

When the two stations have been selected, a dialogue box will appear for the user to specify 

required values such as Antenna type, height above sea level, channel occupation, depolarization 

loss and permissible filed strength. The “Set Parameter” dialogue box is shown in Figure 

3.HCM.10. 
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Once the user has specified values for these parameters, or accepted the default values,  the 

calculation starts and the results file will be displayed. 

Figure 3.HCM.11 shows the results of interference calculations for the case of "station to 

station". 

 

 

 Figure 3.HCM.10. Dialogue box of interference calculation parameters for Mobile stations in HCM 

Agreement  

 
 

 

Figure 3.HCM.11. Sample output of HCM Agreement for Mobile service-Station to Station interference 

calculation 
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Station to line, all negative CMODE-codes, these items performs line calculations.. After 

choosing one of these items, all mobile stations will be listed in a spreadsheet and the user may 

select, using a mouse left click on the record-one station as  transmitter as shown in Figure 

3.HCM.12. 

 

Figure 3.HCM.12. Spreadsheet of Mobile stations in HCM Agreement Functions for line calculations  

 
 

When the transmitter station has been selected, a dialogue box will appear for the user to specify 

required values such as Antenna type, height above sea level, channel occupation, cross border 

range, country code to calculate to, distance to the coordination line and permissible filed 

strength. The “Set Parameter” dialogue box is shown in Figure 3.HCM.13. 

Once the user has specified the values for these parameters, or accepted the default values,  the 

calculation starts and the results file will be displayed. 

 

Figure 3.HCM.13. Dialogue box of line calculation parameters for Mobile stations in HCM Agreement  
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Figure 3.HCM.14 shows the results of line calculations for the case of "station to line". 

 

Figure 3.HCM.14. Sample output of HCM Agreement for Mobile service-Station to line calculation 
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3.4.2.13. Interference menu of DEM view 

Interference calculations have been implemented in this menu to analyse several configurations 

of wanted and victim stations: BC - BC (FM sound broadcasting stations), BT - BT (Analogue 

TV broadcasting stations), FX – FX (point to point hops and individual fixed stations), ES - ES 

(earth stations), ES – FX and cross service interference calculation procedures. The technical 

reference of the procedures implemented is explained in Chapter 5. These features are described 

below: 

 BC2BC: This item calculates the aggregate interference level of interfering BC stations 

on a directional receiver of a wanted BC station. The interference free area around the 

wanted FM sound broadcasting station is calculated in this item. By selection of this item, 

a list of all FM sound broadcasting station is presented. Users are able to select a wanted 

BC station using a mouse left click on the record select column of the concerned row. 

Figure 3.180 displays the spreadsheet of all available FM sound broadcasting stations in 

the database. 

 

Figure 3.180. Spreadsheet of all available FM sound broadcasting stations 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When the OK button is pushed, a dialogue box of Interference Parameters is opened to set 

the search conditions for the victim BC stations. This dialogue box contains the 

parameters: search radius (in km), frequency range (respect to the centre frequency of 

current signal), minimum field strength (the minimum value of useable field strength), 

interference summation (aggregation) method, time and location percentage, antenna 

discrimination (receiving directional antenna discrimination in accordance with ITU-R 

BS.599 toward to the corresponding BC transmitter) and polarization discrimination. A 

spreadsheet presents a list of all BC stations found in the database that meet the set 

conditions. Figure 3.181 demonstrates the dialogue box of interference calculation 

parameters and found BC stations. 
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Figure 3.181. a) Dialogue box of interference calculation parameters and  

b) Interferer stations meeting conditions 

 

 

 

 

 

 

 

(a) Dialogue box of interference calculation parameters 

 

 

 

 

 

 

 

 
 

(b) Spreadsheet of found BC stations 
 

 

Some or all of listed BC stations can be selected for detailed area calculations. The area 

calculation results, using the free space propagation model, will be displayed in a new 

window and a different menu bar is presented. The circular search area, specified in 

Figure 3.181, is fitted inside the result window. The position of the mouse cursor on the 

area result window shows, on the status bar, the existence of interference for receivers of 

the concerned BC station. The “Tools” menu of the new menu bar provides the following 

helpful items: 

 Normalize: Changes the display range of field-strength values. The user 

can modify the minimum and maximum threshold of field strength value. 

Points with field strength values higher and lower than the defined value 

range will be displayed by the two colours at the bottom and top of the 

legend; 

 Colour Map: Changes the colour map used in the demonstration of terrain 

height in the DEM view. Figure 3.22 displays the implemented colour 

maps; 

 Legend: To switch on / off the legend of 2D plot. A check mark will 

appear in item left side if switched on. A corresponding toolbar button is 

also available (see Section 3.4.1). 

 Usable Fst.: Changes the type of demonstrated area calculation result from 

contour into the 2D field strength value and vice versa. The relevant value 

at the position of the mouse cursor is displayed on the status bar. 

Figure 3.182 displays the 2D plots and “Tools” menu described above. ITU-R BS.412 is 

used to define the protection ratio. 
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Figure 3.182. a) Coverage area of a concerned BC station in presence of /without interferer stations  

b) Usable field strength on receivers of wanted broadcasting station inside a selected area 

 
(a) 

 

 
(b) 

 

 BT2BT: This item calculates the aggregate interference level of interfering BT stations on 

a receiver of a wanted BT station. The interference free area around the wanted TV 

broadcasting station is calculated in this item. The procedure of BT to BT interference 

calculation is same as BC to BC which is explained in the previous bullet, except ITU-R 
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BT.655 is used to define the protection ratio and ITU-R BT.419-3 for the directional 

antenna radiation pattern employed. Figure 3.183 displays 2D results obtained from the 

interference calculation for several interferer BT stations on a directional receiver of a 

wanted BT station. In the member countries of the GE06 agreement and in relevant 

frequency bands, it is preferable to use the calculation functions under the GE06 

submenu. 
 

 Figure 3.183. a) Coverage area of a concerned TV station in presence of /without interferer stations  

b) usable field strength on receivers of wanted TV broadcasting station inside a selected area 

 
(a) 

 

 
(b) 
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 FX2FX (link): This item calculates interference from stations of different point – to – 

point hops on each other by consideration of antenna radiation patterns and XPD, in 

accordance with recommendation ITU-R P.452. This item contains two sub-items: 

“Interference to” and “Interference from”, enabling the user to calculate the interference 

caused by the wanted hop transmitter on receivers of other hops or the interference caused 

by other hop transmitters on the wanted hop receiver, respectively. Choosing one of the 

sub items under this item opens a spreadsheet of available links from which the user may 

select a wanted hop, using a mouse left click on the record select column of the concerned 

record. Figure 3.184 displays this spreadsheet. 

 

Figure 3.184. List of point–to–point hops 

 
 

After selecting a hop, a dialogue box of “Set Parameters” is presented to set the search 

conditions and values for the parameters of the ITU-R P.452 propagation model. Once 

these values have been selected, the list of hops that meet the conditions will be listed in a 

spreadsheet and users are able to select some or all of them for conducting detailed 

calculations. The “Set Parameter” dialogue box and an example list of found hops is 

shown in Figure 3.185. 

 

Figure 3.185. “Set Parameter” dialogue box and hops meeting relevant conditions 

 

 

 

 

 

 

 

 

       (a) Set Parameter dialogue box           (b) Hops meeting relevant conditions 
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After selecting the interfering (or victim) hop, the calculation starts and a progress bar is 

displayed. The calculation result is shown in the Result dialogue box after the progress 

bar closes. The wanted hop information and interference calculation results are displayed 

in the result dialogue box. Figure 3.186 shows the result dialogue box for the two sub-

items “Interference to” and “Interference from”, respectively. 

 

Figure 3.186. a) Dialogue box of interference of wanted hop TX on receiver of victim hops, and, 

b) dialogue box of interference from TX of other hops on wanted hop RX 

 
(a) Dialogue box of interference of wanted hop TX on receiver of victim hops 

 
(b) Dialogue box of interference from TX of other hops on wanted hop RX 

 

In the table of result “IntDist”, “S”, “I” and “Path Type” refer to: distance of the 

interference path between transmitter and receiver, sensitivity of victim receiver, received 

interference level and type of propagation path in accordance with the recommendation 

ITU-R P.452, respectively. As shown in Figure 3.186a, a red text background highlights 

the occurrence of interference. The “Report” push button on the bottom of the result 

dialogue box can be used to generate, store and display an HTML report of the 

interference calculation results. 
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 FX2FX (station): This item calculates interference from fixed stations to each other in 

accordance with recommendation ITU-R P.452, by consideration of antenna patterns and 

NFD (Net Filter Discrimination). This item contains two sub-items: “Interference to” and 

“Interference from”, enabling the user to calculate the interference caused by a wanted 

transmitting station on victim fixed receivers or the interference caused by other fixed 

transmitters on the wanted fixed receiver, respectively. Choosing one of the sub items 

under this item opens a spreadsheet of available fixed stations, from which users may 

select one of them, using a mouse left click on the record select column of the concerned 

record. Figure 3.187 displays this spreadsheet. 

 

Figure 3.187. List of fixed stations 

 

 

 

 

 

 

 

 

 

 

 

After selecting a station, the dialogue box of “Set Parameters” is presented to set the 

search conditions and values for the parameters of the ITU-R P.452 propagation model. 

Once these values have been set, a spreadsheet lists the RX or TX stations (for sub-items 

“Interference to” or “Interference from”) that meet these conditions and the user may 

select some or all of them for the detailed calculations. The “Set Parameter” dialogue 

box and an example spreadsheet list of stations found is displayed in Figure 3.188. 
 

Figure 3.188. “Set Parameter” dialogue box and fixed stations meeting relevant conditions 

 

 

 

 

 

 

 

                                                                                          (b) Fixed stations meeting relevant conditions 

 
        (a) Set Parameter dialogue box           
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After selection of interfering (or victim) station, the calculation starts and a progress bar 

is displayed. When the progress bar closes, the wanted station information and 

interference calculation results are displayed in the result dialogue box. Figure 3.189 

displays the result dialogue box for the two sub-items “Interference to” and 

“Interference from” respectively. 

 

Figure 3.189. a) Dialogue box of interference of wanted fixed TX on victim fixed receiver, and, 

b) dialogue box of interference from unwanted fixed TX on wanted fixed RX 

 

 

 

 

 

 

 

 

 

 

 

 

 

(a) Dialogue box of interference of wanted fixed TX on victim fixed receiver 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(b) Dialogue box of interference from unwanted fixed TX on wanted fixed RX 

 

In the table of results, “TD”, “Dist” and “Path Type” refer to: Threshold Degradation, 

distance of the interference path between transmitter and receiver and type of 

propagation path in accordance with the recommendation ITU-R P.452, respectively. 

Positive values for TD – Permissible TD value, in the relevant column, indicate an 
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interference case and a red background identifies them visually from other values in this 

column, 

The “Report” button on the bottom of the result dialogue box can be used to generate, 

store and display an HTML report of the interference calculation results. 

 

 FXM sub-menu of Interference: The item “FXM” in the “Interference” menu has been 

implemented for the calculation of interference produced/experienced between stations 

in the land mobile service (any frequency) and between stations in the fixed service 

(below 1GHz) and between each other, taking into account the receiving antenna 

radiation pattern. Four sub-items are implemented, as the two calculation procedures: 

“Interference to” and “Interference from”, can use either the Free Space or the P.1546 

propagation models. The two calculation procedures are explained separately below but 

both models are included in these explanations:  

- Interference to (Free Space and P.1546): This item calculates interference to fixed 

or land mobile receiving stations from a wanted transmitting station in the fixed or 

land mobile services, under given conditions. Choosing this item opens the 

spreadsheet of all fixed, base and mobile transmitting stations in the database, from 

which the user may select a wanted station using a mouse left click on the relevant 

record select column. Figure 3.190 shows a spreadsheet of fixed (below 1GHz), base 

and mobile stations. 

 

Figure 3.190. List of fixed (below 1GHz), base and land mobile stations 

 

 

 

 

 

 

 

   

 

 

 

 

Then, the search parameters may be selected from the “Set Parameters” dialogue box. 

The user may set: Search radius, frequency range, minimum field strength value and 

a check box to identify Emergency & Security Systems. The maximum permissible 

interference field strength value is used to extract the reference field strength value 

for the interference calculation by considering correction factors given in the Berlin 

Agreement, Annex 3A (as a good example of a coordination agreement, in use by 

several countries and referenced  in ITU-R Rec. SM.1049-1). After definition of the 

search criteria, SMS4DC lists all fixed, base and mobile stations that meet the defined 

conditions, from which the user is able to select some or all of them. Figure 3.195    
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shows the “Set Parameters” dialogue box for setting the search conditions and the list 

of fixed, base and mobile stations that are found by the subsequent search. 

 

Figure 3.191. a) Set Parameter dialogue box for setting search condition 

 and b) Spreadsheet list of found fixed, base and mobile stations 

 

 

 

 

 
 

        (a) Set parameter dialogue box   (b) Spreadsheet of found fixed, base and mobile stations 

 

Once the victim station has been selected, a dialogue box allows the user to specify 

values for the P.1546 or free space propagation model parameters. Then the Result 

dialogue box presents the calculation result, containing the wanted TX station 

characteristics together with the calculated interference level on victim receivers. The 

height of the receiver is extracted from the victim station’s information. Figure 3.192  

Error! Reference source not found.shows the dialogue box for P.1546 propagation 

model parameters and interference calculation result dialogue box. For the free space 

model, only the k-factor is a necessary model parameter. 

Figure 3.192. a) P1546 propagation model parameters and 

 b) Result of interference calculation of wanted TX on victim RXs (below 1GHz) 

 

 

 

 

 

 

 
 

(a) P1546 propagation model parameters 

 

 

 

 

 
 

 

 

 

 

 
 

(b) Result of interference calculation of wanted TX on victim RXs 
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The “Report” button at the bottom of the result dialogue box may be used to generate, 

store and display an HTML report of interference calculation results. 

 

- Interference from (Free Space and P.1546): This item calculates interference from 

fixed or land mobile transmitting stations to a wanted receiving station in the fixed or 

land mobile services, under given conditions. Choosing this item opens a spreadsheet 

listing all fixed, base and mobile receiving stations in the database from which users 

may select a wanted receiving station using a mouse left click on the relevant record 

select column. Figure 3.193 shows a spreadsheet of fixed (below 1GHz), base and 

mobile stations. 

Then the search parameters may be selected from the “Set Parameters” dialogue box. 

The user may set: search radius, frequency range, minimum field strength value and a 

check box to identify Emergency & Security Systems. The minimum field strength 

value is used to define the reference field strength value for interference calculation 

by considering correction factors given in the Berlin Agreement, Annex 3A (as a 

good example of a coordination agreement used by several countries and referenced 

in recommendation ITU-R SM.1049-1). After definition of the search criteria, 

SMS4DC lists all fixed, base and mobile transmitting stations that meet the defined 

conditions, from which users are able to select some or all of them. Figure 3.193 

shows a spreadsheet of search results listing the fixed, base and mobile transmitting 

stations that met the conditions set in this case. 

 

Figure 3.193. Spreadsheet list of found fixed, base and mobile transmitting stations 

 

 

 

 

 

 

 

 

after the victim station has been selected, the consequent dialogue box enables values 

to be specified for the P.1546 or free space propagation models parameters. Then the 

Result dialogue box presents the calculation result, containing the wanted TX station 

characteristics together with the calculated interference level at the wanted victim 

receiver. The height of the receiver is extracted from the victim station’s information 

on the database. Figure 3.194  shows the interference calculation result dialogue box. 

For the free space model only the k-factor is a necessary model parameter. 
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Figure 3.194. Result of interference calculation on wanted RX caused by victim TXs (below 1GHz) 

 

 

 

 

 

 

 

 

 

 

 

 

 The “Report” button at the bottom of the result dialogue box may be used to 

generate, store and display an HTML report of the interference calculation results. 

 

 Intermodulation (SM1134): This item calculate intermodulation interference that are 

created at the output of a receiver under influence of intensive unwanted signals at the 

receiver input due to non-linearity of an amplitude response of the receiver based on ITU-

R Recommendation SM.1134. Choosing this item opens the spreadsheet of all terrestrial 

stations in the database, from which the user may select a wanted receiving station using a 

mouse left click on the relevant record select column. Figure 3.195 shows a spreadsheet 

of wanted stations. 

 

Figure 3.195. List of wanted stations  

 

 

 

 

 

 

 

 

 

 

 

 

 

 Then, the search parameters may be selected from the “Set Parameters” dialogue box and 

the user may set Search radius. After definition of the search criteria, SMS4DC lists all 

stations that meet the defined conditions, from which the user is able to select some or all 
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of them as interferer stations. Figure 3.196  shows the “Set Parameters” dialogue box for 

setting the search conditions and the list of stations that are found by the subsequent 

search. 

 

 

Figure 3.196. “Set Parameter” dialogue box and stations meeting relevant conditions  

 

 

 

 

 

 

 

 

 

 after the victim station has been selected, the consequent dialogue box enables values to 

be specified for the P.1546. Then the Result dialogue box presents the calculation result, 

containing the wanted RX station characteristics together with the calculated 

interference level at the wanted victim receiver. Figure 3.197 shows the P.1546 

propagation model parameters dialogue box and Figure 3.198 shows the intermodulation 

interference calculation result.  

  

Figure 3.197. P1546 propagation model parameters and 
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Figure 3.198. intermodulation interference calculation result 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 It is posiible to set the parameters such as order of intermodulation, order of harmonics, 

co-channel protection ratio, RF filter of receiver as well as to add or delete new 

transmitters or recievers as shown in Figure 3.199. 

 

 

Figure 3.199. Seting parameters, Adding Transmitter/Reciever stations in the page of intermodulation 

interference calculation result 

 

 

 

 

 

 

 

 

 

 

 

 

 

 The “Save” in the result dialogue box may be used to generate, store and display a report 

of the interference calculation results. 

 



 
202 

 ES2ES (station): This item calculates interference caused or received by a selected Earth 

station, operating with geostationary satellites, on or from other Earth stations located 

inside a circular area around the selected earth station using recommendation ITU-R 

P.452 by consideration of antennas pattern and NFD (Net Filter Discrimination). This 

item contains two sub-items: “Interference to” and “Interference from”, enabling the user 

to calculate the interference caused by a wanted transmitting Earth station to victim 

receiving Earth stations or the interference caused by other Earth stations to a wanted 

receiving Earth station, respectively. Choosing one of the sub items under this item opens 

a dialogue box enabling the user to choose a transmitting or receiving Earth station. The 

tree view structure of the Earth stations database allows selection of an Earth station 

through the relevant: notice ID, Beam ID, Group ID or Frequency, directly by double 

click on the concerned level. Selection of a notice ID means selection of all relevant 

beams, selection of a beam means selection of all groups under the selected beam and so 

on. These data have to be imported from the space IFIC database, or have to be entered 

into the SMS4DC database directly. Figure 3.200a shows the dialogue box for selecting 

an Earth station. 

 

Figure 3.200. Dialogue boxes for a) selecting earth station and b) defining calculation parameters 

 

 

 

 

 

 

 

 

 

 

       a) Dialogue box for selecting earth station 
 

           

Once the earth station has been selected, values for the calculation parameters have to be 

set in the next dialogue box. The calculation parameters dialogue box includes: radius of 

circular searching area, frequency range above and below the selected frequency in which 

the frequency of victim earth stations located, polarization discrimination, user-defined 

maximum permissible interference level (dBW) and the ITU-R P.452 parameter set. The 

parameters related to the recommendation ITU-R P.452 are explained in Table 3.3 and 

polarization discrimination will be considered by the calculation if the polarization of 

transmitting and victim Earth stations’ antennas are orthogonal. Figure 3.200b shows the 

dialogue box for entering values for the parameters described above. 

Users have the option to set the parameter “User-Defined Maximum Permissible 

Interference Level” or to let the software decide. SMS4DC extracts these parameters from 

the Tables 16a and 16b of recommendation ITU-R SM.1448. Pushing the OK button on 

the parameters dialogue box starts the calculation. When the progress bar closes, the 

  b) Dialogue box for defining calculation 

parameters 



 
203 

calculation results will be displayed in a dialogue box containing two separate 

spreadsheets. Figure 3.201a displays the interference calculation result window. 

Figure 3.201a. Calculation result of caused/received interference by/from 

 a transmitting/receiving earth station on/from other earth stations 

 

 

 

 

 

 

 

 

 

The upper part of the spreadsheet result window lists all selected interfering or interfered 

frequencies where, for each frequency, the individual interference calculation is shown in 

the lower spreadsheet. A blank result spreadsheet means no interference case for the 

selected frequency in the upper spreadsheet. For each case, values are given for: TD 

(reference threshold degradation in dB), I (interference value at the location of victim 

receiver in dBW), Pr (maximum permissible interference level in dBW) and type of 

interfering emission path.  Positive values for I – Pr in the column “I – Pr” indicate an 

interference case and a red background identifies them visually from other values in this 

column. 

The “Report” button, at the bottom of the result dialogue box, can be used to generate, 

store and display an HTML report of the interference calculation results. 

 

 ES2FX: This item calculates interference caused by a selected earth station, operating 

with geostationary satellites, on terrestrial stations in the fixed service, above 1GHz, 

located inside a circular area around the selected earth station using recommendation 

ITU-R P.452 by consideration of antennas pattern and NFD (Net Filter Discrimination). 

Choosing this item opens a dialogue box enabling user to choose the transmitting earth 

station. The tree view structure of the Earth stations database allows selection of an Earth 

station through relevant: notice ID, Beam ID, Group ID or, directly, Frequency by a 

double click on the concerned level. Selection of a notice ID means selection of all 

relevant beams, selection of a beam means selection of all groups under the selected beam 

and so on. These data have to be imported from the space IFIC database or have to be 

entered into the SMS4DC package directly. Figure 3.200a displays the dialogue box for 

selecting an Earth station. 

Once the Earth station has been selected, values for the calculation parameters have to be 

set in the next dialogue box. The calculation parameters dialogue box includes: radius of 

circular searching area, frequency range above and below the selected frequency in which 

the frequency of victim fixed stations located, polarization discrimination, user-defined 

maximum permissible interference level (dBW) and the ITU-R P.452 parameter set. The 
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parameters related to recommendation ITU-R P.452 are explained in Table 3.3 and 

polarization discrimination will be considered by SMS4DC if the polarization of 

transmitting earth station and victim fixed station antennas are orthogonal. The dialogue 

box for data entry of these parameters is shown in Figure 3.200b. 

The user has the option to set the parameter “User-Defined Maximum Permissible 

Interference Level” or to leave it as a software decision. SMS4DC extracts this parameter 

from recommendation ITU-R SF.1006. The calculation will be started by pushing the OK 

button of the parameters dialogue box. When the progress bar closes, the calculation 

results will be displayed in a dialogue box containing two separate spreadsheets. Figure 

3.201b shows this interference calculation result window. 

 

Figure 3.201b. Calculation result of caused interference by a transmitting earth station on fixed 

stations 

 

 

 

 

 

 

 

 

 

 

The upper spreadsheet of the result window lists all the selected interfering frequencies; 

while for each of these frequencies, an individual interference calculation is shown in the 

lower spreadsheet. A blank result spreadsheet means no interference case for the selected 

frequency in upper spreadsheet. For each case studied, information is shown for: TD 

(reference threshold degradation in dB), I (interference value at the location of victim 

receiver in dBW), Pr (maximum permissible interference level in dBW) and type of 

interfering emission path.  Positive values for I – Pr in the column “I – Pr” indicate an 

interference case and a red background identifies them visually from other values in this 

column. 

The “Report” push button at the bottom of the result dialogue box can be used to 

generate, store and display an HTML report of the interference calculation results. 

 

 FX2ES: This item calculates interference received by a receiver of a selected Earth 

station, operating with geostationary satellites, caused by transmitting terrestrial stations 

in the fixed service, above 1GHz, located inside a circular area around the selected Earth 

station using recommendation ITU-R P.452, by consideration of antennas pattern and 

NFD (Net Filter Discrimination). Choosing this item opens a dialogue box enabling the 

user to choose the receiving earth station. The tree view structure of the Earth stations 

database allows selection of an Earth station through the relevant: notice ID, Beam ID, 

Group ID or, directly, Frequency by a double click on the concerned level. Selection of a 

notice ID means selection of all relevant beams; selection of a beam means selection of all 
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groups under the selected beam and so on. These data have to be imported from the BR 

IFIC (Space Services) database or have to be entered into the SMS4DC package directly. 

Figure 3.200a displays the dialogue box for selecting an Earth station. 

Once the Earth station has been selected, values for the calculation parameters have to be 

set in the next dialogue box. The calculation parameters dialogue box includes: radius of 

circular searching area, frequency range above and below the selected frequency in which 

the frequency of transmitting fixed stations is located, polarization discrimination, user-

defined maximum permissible interference level (dBW) and the ITU-R P.452 parameter 

set. The parameters related to the ITU-R P.452 recommendation are explained in 

Table 3.3 and polarization discrimination will be considered by SMS4DC if the 

polarization of victim earth station and interferer fixed station antennas are orthogonal. 

The dialogue box for data entry of these parameters is shown in Figure 3.200b. 

The User has the option to set the parameter “User-Defined Maximum Permissible 

Interference Level” or to leave it for the software to decide. SMS4DC extracts this 

parameter from recommendation ITU-R SF.1006. The calculation will be started by 

pushing the OK button in the parameters dialogue box. After the progress bar closes, the 

calculation results will be displayed in a dialogue box containing two separate 

spreadsheets. Figure 3.202 displays this interference calculation result window. 

 

Figure 3.202. Calculation result of caused interference by a 

 transmitting terrestrial fixed station on receiving earth station 

  
 

The upper spreadsheet of the result window lists all selected victim frequencies; while, for 

each frequency, the individual interference calculation is shown in the lower spreadsheet. 

A blank result spreadsheet means no interference case for the selected frequency in the 

upper spreadsheet. For each case studied, the following information is given: TD 

(reference threshold degradation in dB), I (interference value at the location of victim 

receiver in dBW), Pr (maximum permissible interference level in dBW) and type of 

interfering emission path.  The positive values for I – Pr in the column “I – Pr” indicate an 

interference case and a red background identifies them visually from other values in this 

column. 

The “Report” button at the bottom of the result dialogue box can be used to generate, 

store and display an HTML report of the interference calculation results. 
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3.4.2.14. Monitoring menu of DEM view 

One of the important parts of a Spectrum Management System is the monitoring sub-

system which acts as the eyes of the total system. With the cooperation of Rohde and 

Schwarz and THALES Companies, it is now possible for SMS4DC to interact with 

ARGUS (R&S monitoring software) and ESMERALDA (THALES monitoring software) 

and communicate bidirectionally. Also a general interface between SMS4DC and 

monitoring softwares is available under "Others" submenue. 

The first essential step in connecting SMS4DC with ARGUS ,ESMERALDA and other 

monitoring softwares is the correct setup of the ARGUS.TXT ,THALES.TXT and 

OTHERS.TXT files respectively which are located in the TEXTS folder of SMS4DC 

installation. The lines of the text file correspond to the path of INBOX and OUTBOX 

folders of monitoring systems respectively. The monitoring software might be installed on 

the same PC having SMS4DC. In this case the path to local INBOX and OUTBOX of 

monitoring system should be placed in the *.TXT files. If monitoring software is located 

on another PC, then the SMS4DC PC and monitoring PC should be connected to 

eachother through a network (LAN or WAN). 

 

3.4.2.14.1. ARGUS menu  

This menu item groups all the functionalities needed for communication with ARGUS 

software. The data exchange between SMS4DC and ARGUS is done through two kinds 

of orders: 

- SMDI - Spectrum Management Data Interface: ARGUS requests data from SMS4DC. 

- ORM - Order Report Module: SMS4DC requests measurements from ARGUS. 

 

3.4.2.14.1.1. Respond to Order sub-menu of ARGUS menu 

Activation of this menu (Figure 3.203), makes SMS4DC ready to listen to the SMDI 

orders issued by ARGUS system and as soon as it receives an order, prepares the 

requested information and sends for the ARGUS system. The orders are created in 

ARGUS by "File/Import/Data from Database" menu (Figure 3.204). Currently it is 

possible to request "Transmitter List", "Frequency List of Occupied Frequencies" and 

"Frequency List of Unassigned Frequencies" (Figure 3.205). Removing the check mark of 

this item disables this link from ARGUS to SMS4DC. 

For more information about creating orders in ARGUS, consult the user's manual of 

ARGUS system. 
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Figure 3.203. "Respond to Order" menu item 

 
 
 

Figure 3.204. Menu item in ARGUS for requesting information from SMS4DC 
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Figure 3.205 Two sample screen shots for requesting Transmitter and Frequency Lists 

    

 

3.4.2.14.1.2. GSP Order sub-menu of ARGUS menu 

SMS4DC should know the system configuration of the measurement devices connected to 

ARGUS system. Otherwise it is not possible to issue a precise measurement order. In order to 

know this configuration, the SMS4DC requests those specifications from ARGUS by a Get 

System Parameters (GSP) order. By selection of this menu item, a GSP order will be sent to 

ARGUS and normally after a few seconds, the specifications will be sent back to SMS4DC. If 

any problem happens in sending the order or receiving the results, an error message will appear 

as shown in Figure 3.206. 

Figure 3.206. Messages regarding different statuses of the responds to a GSP order 
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3.4.2.14.1.3. ORM Order sub-menu of ARGUS menu 

After successful execution of the "GSP Order" sub-menu, it is now possible to create an ORM 

measurement order by selection of "ORM Order" menu. By selection of this menu, SMS4DC 

looks for the latest result of the GSP orders which shows the latest known configuration of the 

measurement system. If a result is found then it is loaded and the date of it will be displayed on 

the screen. In the displayed screen, there are 3 tab dialogs called "General Setting", "Date and 

Time Setting" and "Result Setting" which are shown in Figure 3.208, Figure 3.209 and Figure 

3.210 respectively. 

In these screens there are some items which are inactive by default. Each of these items may get 

active based on the values of other items. For example the "Frequency List" combo box on the 

lower right corner of "General Setting" screen may be active only for "Frequency List Scan" 

measurement. The first essential step in creation of a measurement order is the selection of the 

measurement device. This can be done by double clicking on a listed device in the small window 

on the top-right side of the screen. By this selecition, the related parameter limitations and 

settings will be applied to the combo boxes of the screen. In the General Setting of the 

measurement order (Figure 3.208), there are so many technical parameters which some of them 

are described here and more detailed technical information may be found in the users manual of 

ARGUS.  

- Execution Type: 

o Automatic: This type of order will be processed by ARGUS automatically and 

the results will be prepared and sent back to SMS4DC. 

o Manual: This order needs to be processed by the ARGUS operator and the 

measurement results should be attached together manually to form the result. 

- Order Task: Currently the following types of measurements are available 

o Frequency List Scan 

o Transmitter List Scan 

o Scan 

o DScan 

o FFM (Fixed Frequency Measurement) 

o Sweep 

- Measurement Parameter: At most four of these parameters can be measured 

simultaneously with the exception of "Location" which should be measured alone. 

o Level 

o Offset  

o Frequency 

o IF 

o Audio 

o AM 
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o FM 

o PM 

o BandWidth 

o Bearing 

o Sub Audio Tone 

o Program 

o PI Code 

o Sound ID 

o Location 

- Frequency, Transmitter and Suppress List Drop Down lists 

The first two are only active for "Frequency List Scan" and "Transmitter List Scan" 

respectively and the third one is active for "Scan", "DScan" and "Sweep" 

measurements. It is possible to create user defined lists and store them in the system. 

First of all a unique name should be written in the Drop-Down Box. Then the 

corresponding button above that box should be pressed and one of the screens shown 

in Figure 3.207 will be displayed. 

Figure 3.207. Screens for definition of Frequency, Suppress, and Transmitter Lists 

    

  

 

 

 

A special DB button is visible in these screens. This button enables the user to create 

the list based on the existing information in the SMS4DC database. 
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Figure 3.208. General Setting of a measurement order 

 

 

Figure 3.209. Date and Time Setting of a measurement order  

 

In the "Date and Time Setting" screen it is possible to create a one-time measurement which is 

defined using the items on the top of the screen or a periodic measurement using the items in the 
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centre of the screen. And also using the items at the bottom of the page, the continuity of the 

measurement in the defined time span or period, can be defined.  

Figure 3.210. Result Setting of a measurement order 

 

 

In the final screen for (Figure 3.210) creation of an ORM, the following selections are available: 

- Measurement Result: All Measurement results are stored. 

- MaxHold: For each frequency only the maximum measured value is stored. 

- Compressed Measurement Result: Compression interval per adjusted becomes for 

each measuring parameter (so far as possible) a result of measurement (Average, 

Standard deviation, Minimum, Maximum) stored. Storage always takes place to the 

full minute. 

- Measurement Result during an Alarm: All measured values are stored during an 

alarm. Measured values outside of the alarm are not stored. 

- Begin and End of an Alarm: The time at the beginning and time at the end of the 

alarm arisen last are only stored. The result of measurement contains the additional 

column status with the values start and stop. Measured values are not stored. 

- Measurement Result during and Compressed Measurement Result outside and Alarm: 

All measured values are stored during an alarm. Measured values outside the alarm 

are stored compressed (see Compressed Measurement Result). 
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3.4.2.14.1.4. Order Status sub-menu of ARGUS menu 

By this facility, it is possible to see the status of all existing orders in the INBOX folder of 

ARGUS system. The states might be one of the following: 

- Open: When SMS4DC places a new order in the INBOX of the ARGUS system, 

which shall execute the order, the state of the order is „Open“. The state of the sub-

orders is also „Open“. 

- In Process: ARGUS sets the state of the sub-order to „In Process“ and executes the 

automatic measurement. The state of the order is also set to „In Process“ by ARGUS. 

- Finished: After measurement, ARGUS creates the report with the measurement results 

and additional information and sets the state of the sub order to „Finished“. 

- Forwarded: In case another control unit shall execute the sub-order of the order, 

ARGUS passes on a copy of the order. The state of the order changes to „Forwarded“. 

 

Figure 3.211. The screen showing the status of all existing orders in the INBOX folder of ARGUS 

 

3.4.2.14.1.5. Stop Order sub-menu of ARGUS menu 

By selection of this menu, a list of all running or pending ORM orders will be displayed (Figure 

3.212) and one of them can be selected and stopped by pressing the "Create Stop Order" button. 
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Figure 3.212. The screen showing all running or pending orders ready to be stopped 

 

3.4.2.14.1.6. Draw Output sub-menu of ARGUS menu 

After successful completion of measurement of an ORM order, it is possible to visualise 

the results in either ARGUS or SMS4DC. By selection of "Draw Output" menu, the 

screen shown in Figure 3.213 is displayed and by selection of File->Open, the result XML 

file should be selected from the OUTBOX folder of ARGUS system. 

 

Figure 3.213. The toolbar of the screen showing the results of a measurement 

 
 

If a result file for a manual order is opened then before displaying the containing result, 

the system shows the following dialog box which displays a warning message about the 

possible incompatibility of the order and the results, the comments of order and the result 

file and also a list of attached files, if any (Figure 3.214). 

 

Figure 3.214. The screen showing the warning message before displaying the results of a manual measurement 

 
 

3.4.2.14.1.7. Toolbar of ARGUS Monitoring Results view 

The following buttons are provided in the toolbar of the draw output screen to facilitate 

manipulation of the main functions: 
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Toolbar 

Buttons 
Name Description 

 
Bar 

Chart 

This button acts the same as Tools->Mode->Bar Chart menu and displays the resulted values 

as a bar chart. The following figure is a sample screen shot of a bar chart display of 

measurement results. 

 

 

Line This button acts the same as Tools->Mode->Line menu and displays the resulted values as a 

bar chart. The following figure is a sample screen shot of a line display of measurement results. 
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3D 

View 

This button acts the same as Tools->3D (Frequency, Time, Value) and displays the resulted 

values as a 3D chart. The following figure is a sample screen shot of a 3D display of 

measurement results. 

 

 

 

2D 

(Freq., 

Value) 

This button acts the same as Tools->2D (Frequency, Value) and displays the resulted values as 

a 2D chart. The following figure is a sample screen shot of a 2D display of measurement 

results, having Frequency as X-axis and Level as Y-axis. 
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2D 

(Time, 

Value) 

This button acts the same as Tools->2D (Time, Value) and displays the resulted values as a 2D 

chart. The following figure is a sample screen shot of a 2D display of measurement results, 

having Time as X-axis and Level as Y-axis.  

 

 

 

Water 

fall 

This button acts the same as Tools->2D (Water Fall) and displays the resulted values as a 2D 

chart having Frequency as X-axis and Time as Y-axis. The following figure is a sample screen 

shot of a 2D Water Fall display of measurement results. 
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Grid This button acts the same as Tools->Grid or Ctrl+G keyboard shortcut and displays a 10 by 10 

grid over X-Y plane of the existing chart. The following figure is a sample screen shot of a 2D 

chart display of measurement results with the grid. 

 

 
Data 

Export 

This button acts the same as File->Export Data As… and exports the measurement data as a 

Comma Separated Values (CSV) file. The following figure is a sample screen shot of the 

export screen. 
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This button is active only when a bearing measurement result is loaded. This result may 

contain different Level and Quality values for each direction, each frequency (if measured for a 

frequency range or list) and at different sampling times. In the screen it is possible to select 

between Level and Quality values, view each measured data alone or a group of measured data 

for each frequency. 

 

 
Legend This button acts the same as Ctrl+L keyboard shortcut or Tools->Legend 

menu item and displays the legend of colors used to depict values in the chart 

for measurement data. 
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This button acts the same as Ctrl+M keyboard shortcut or Tools->Measurement Setting 

Information menu item and displays the parameters of the order corresponding to the displayed 

result. 

 

 

As described in section 3.4.2.14.1.3, the result may contain the measurement results for up to 

four parameters. In this case it is possible to choose the desired parameter to show its 

measurement results. All possible submenu items of the Tools->Value menu is shown in the 

following table. Based on the type of measurement and availability of the results, only some of 

them might be active. Selection of statistical (e.g. Mean Value) values for some of the parameters 

might be possible only for Compressed Measurement Result (CMR) files which are described in 

section 3.4.2.14.1.3. 

 

Measured Parameter Value 

Level Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Frequency Offset Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Modulation  Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 
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Band Width Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Bearing->Quality Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Bearing->Direction Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Sub Audio Tone Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Program  

PI Code  

Sound ID  

Occupancy  

Number  

 

 

3.4.2.14.2. ESMERALDA menu  

This menu item groups all the functionalities needed for communication with 

ESMERALDA monitoring software. The data exchange between SMS4DC and 

ESMERALDA is done through creation of different special files which are listed below: 

- *.REQ: Request files. Created by the monitoring system and submitted to the 

SMS4DC to create a check file based on that. 

- *.CHK: Check files. Measurement orders created by SMS4DC to be submitted to the 

monitoring system. 

- *.RES: Result files 

- *.ATR: Results of ATR measurement 
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3.4.2.14.2.1. Check-list Generation/Mission Creation sub-menu of ESMERALDA 
menu 

By selection of this menu item, it is possible to create measurement missions (orders) to 

be submitted to the ESMERALDA monitoring software. Figure 3.215 shows the first 

screen. 

 

Figure 3.215 The screen for measurement mission creation 

 
 

The monitoring functions are listed below: 

-FBF: Frequency Band occupancy with Fast scanning 

-FBM: Frequency Band occupancy with Measurement 

-FSM: Frequency Scanning occupancy with Measurement 

-FSF: Frequency Scanning occupancy with Fast scanning 

  These missions are used to determine: 

  1. with a one-minute minimum resolution, the occupancy rate for a list of discrete  

  frequencies over one or several days. 
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  2. the occupancy rate of a band with the scanning pitch resolution on a sub-band,  

  over one or several days. 

  A. Frequency Occupancy Rate with Frequency band Scanning 

  ·FBM: determination of the continuous frequency sub-band occupancy rate  

  (maximum 20 sub bands)associated with measurement of transmitter parameters. 

  ·FBF: determination of the continuous frequency sub-band occupancy rate without 

  measurement of transmitter parameters. 

  B. Frequency Occupancy Rate with Frequency Scanning 

  ·FSM: determination of the discrete frequency list occupancy rate with   

  measurement of transmitter parameters. 

  ·FSF: determination of the discrete frequency list occupancy rate without   

  measurement of transmitter parameters. 

 -SCT: Systematic Control of Transmitters. This mission is used to verify the compliance 

 of known transmitters to the expected values and to obtain information items about the 

 unknown transmitters encountered. 

-SFS: Specific Frequencies Scanning. This type is used to monitor the activity on selected 

frequencies. 

 -TOR: Transmitter Occupancy Rate. This mission is used to determine, with a one-

 minute minimum resolution, the occupancy rate of a transmitter over one or several days. 

-USS: Unknown transmitters Scanning Searching 

-UBS: Unknown transmitters Band Searching 

 These missions intend to detect the presence of signals the source transmitter of 

 which is not referenced in the management data base. 

 These missions are carried out 

 ·either in frequency band scanning mode: (UBS) 

 ·or in frequency scanning mode: (USS). 

 -ATR: Field strength measurements along a route. An “Along the Route” mission is 

 used to determine the coverage area of one or more transmitters along a route. It enables, 

 in a mobile measurement station, to associate a level of energy with a GPS position. 

 -CAM: Channel Analysis and Measurements. A "channel analysis" mission allows to 

 analyze, display and store the transmitter characteristics on a given channel (fixed 

 frequency). It tries to split the activity of a frequency into several communications (a 

 succession of measurements above the detection threshold is identified as a 

 communication). 

-TVM: TV Measurements 

The purpose of a “TV Measurements ” mission is to: 

·check the characteristics of a transmitter by measuring the various frequencies: image, 

sound, chrominance, attenuated band sub-carriers, 

·perform a protection measurement between a given transmitter (1st transmitter of 

mission file) and possible spurious transmitter (2nd transmitter of the mission file). 

 

After selection of the desired mission type then there will be four more screens for further 

parameters as shown in Figure 3.216 to Figure 3.219.  
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Figure 3.216. Step 1 of the parameter definition for the missions  
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Figure 3.217. Step 2 of the parameter definition for the missions. Date and Time settings 
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Figure 3.218. Step 3 of the parameter definition for the missions 
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Figure 3.219. Step 4 of the parameter definition for the missions 

 
 

3.4.2.14.2.2. Check-list Generation/Requests sub-menu of ESMERALDA menu 

This functionality is used when there are request files coming from the monitoring 

system. On the screen (Figure 3.220) the desired *.REQ file should be selected by 

pressing Load button and by pressing Create Check File button the corresponding check 

file will be created and submitted to the monitoring system. 

 

 



 
228 

Figure 3.220. Screen for creation of a Check file based on a Request file 

 
 

3.4.2.14.2.3. Check-list Generation/Requests (Automatic) sub-menu of 
ESMERALDA menu 

Activation of this menu (Figure 3.221), makes SMS4DC ready to listen to the requests 

issued by ESMERALDA monitoring system and as soon as it receives a request, 

processes the information and creates a check file and sends back to ESMERALDA 

monitoring software.  

 

Figure 3.221. Menu for activation of automatic processing of incoming requests 
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3.4.2.14.2.4. View/Check-list sub-menu of ESMERALDA menu 

This menu item is used for displaying the content of check files. (Figure 3.222) shows an 

example of a check file for SCT mission. It is possible to display contents of check files, 

result files and occupancy files simultanously. 

Figure 3.222. Contents of a sample SCT Check file 

 
 

3.4.2.14.2.5. View/Results sub-menu of ESMERALDA menu 

This menu item is used for displaying the content of result files. (Figure 3.223) shows an 

example of a result file for SCT mission. It is possible to display contents of check files, 

result files and occupancy files simultanously. 

 

Figure 3.223 Contents of a sample Result file of a SCT mission  
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3.4.2.14.2.6. View/Occupancy Rate sub-menu of ESMERALDA menu 

This menu item is used for displaying the content of occupancy files. Figure 3.224 shows 

an example of an occupancy file for TOR mission. It is possible to display contents of 

check files, result files and occupancy files simultanously. 

 

Figure 3.224. Contents of a sample Occupancy Rate result for a TOR mission 

 
 

3.4.2.14.2.7. View/Requests sub-menu of ESMERALDA menu 

This menu item is used for displaying the content of request files. (Figure 3.225) shows 

an example of a request file for SCT mission. It is possible to display contents of check 

files, result files and occupancy files simultanously. 

 

Figure 3.225. Contents of a sample Request file for a SCT mission 

 
 

3.4.2.14.2.8. Draw Output sub-menu of ESMERALDA menu 

After successful completion of a measurement, it is possible to visualize some the results 

in SMS4DC. It should be noted that only some of the results of ESMERALDA 

monitoring software are graphically visible but it is possible to view all the text results by 

the functionality which is described in section 3.4.2.14.2.5. By selection of the "Draw 
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Output" under ESMERALDA menu, the screen shown in (Figure 3.226) is displayed and 

by selection of File->Open, the result file should be selected from the OUTBOX folder of 

ESMERALDA system. 

 

 

Figure 3.226. The screen for graphically displaying the measurement results of ESMERALDA monitoring 

system  

 
The toolbar buttons are already described in section 3.4.2.14.1.7. The following picture 

shows an example of the results for a UBS measurement. 

 

Figure 3.227. Graphical display of the measurement results of a UBS mission 

 
While displaying the results of Direction-Level measurement (), it is possible to export the results to be 

viewed in Google Earth. 
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Figure 3. 228. Screen for displaying and/or exporting the results of a direction measurement 

 

 

By pressing "Google Earth Export/Display" button, the signal direction is displayed on the 

Google Earth screen (for this capability, the Google Earth application must be installed). 
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Figure 3.229. Screen for displaying the results of a direction measurement on Google Earth 

 

It is also possible to load and display different measurement files. This might be useful for 

finding the location of a transmitter by having at least three direction-finding results of three 

different monitoring stations. 

 

Figure 3.230. Screen for displaying the results of two direction measurements on Google Earth 
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3.4.2.14.2.9. Show ATR sub-menu of ESMERALDA menu 

This menu item is used for displaying the content of result files. (Figure 3.231) shows an 

example of a result file for ATR mission. It is possible to display contents of check files, 

result files and occupancy files simultanously. 

 

Figure 3.231. Screen for displaying and/or converting the results of an ATR mission 

 
 By pressing "Save as" button the results could be saved in SMS4DC Vectors (*.txt) or 

Google Files (*.kml) formats. 

 

Figure 3.232. Screen for saving and/or showing the results of an ATR mission 

 

 

 

 

 

 

 

 

 

 

 

 

 

By putting check mark in "Show" check box and then pushing "Save" button the results will be 

shown in Google Earth. 
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Figure 3.233. Example for showing an ATR mission on Google Earth 

 

3.4.2.14.3. Others menu  

Document 1C/120-E dated 17 September 2010 from Director of the BDT provides the 

necessary information required for General Interface Between SMS4DC and Monitoring 

Systems. 

This menu item groups all the functionalities needed for communication with other 

monitoring software. The data exchange between SMS4DC and monitoring software is 

done through two kinds of orders: 

- M2S - Interface for sending requests from monitoring system to the SMS4DC. 

- S2M - Interface for sending requests from the SMS4DC to monitoring  systems. 

 

3.4.2.14.3.1. Respond to M2S Order sub-menu of Others menu 

Activation of this menu (Figure 3.234), makes SMS4DC ready to listen to the M2S orders 

issued by monitoring system and as soon as it receives an order, prepares the requested 

information and sends to the monitoring system. Removing the check mark of this item 

disables this link from monitoring system to SMS4DC. 

For more information about creating orders in the monitoring system, consult the user's 

manual of relevant monitoring system. 

Figure 3.234. "Respond to M2S Order" menu item 

   
 

3.4.2.14.3.2. S2M Order sub-menu of Others menu 

By this function it is possible to create an S2M measurement order by selection of "S2M Order" 

menu. By selection of this menu, Order Report screen will appear. In the displayed screen, there 
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are 3 tab dialogs called "General Setting", "Date and Time Setting" and "Result Setting" which 

are shown in Figure 3.236, Figure 3.237 and Figure 3.238 respectively. 

In these screens there are some items which are inactive by default. Each of these items may get 

active based on the values of other items. For example the "Frequency List" combo box of 

"General Setting" screen may be active only for "Frequency List Scan" measurement. In the 

General Setting of the measurement order (Figure 3.236), there are so many technical parameters 

which some of them are described here and more detailed technical information may be found in 

the user's manual of monitoring software.  

 

- Order Task: Currently the following types of measurements are available 

o Frequency List Scan 

o Transmitter List Scan 

o Scan 

o DScan 

o FFM (Fixed Frequency Measurement) 

o Sweep 

- Measurement Parameter: At most four of these parameters can be measured 

simultaneously with the exception of "Location" which should be measured alone. 

o Level 

o Offset  

o Frequency 

o IF 

o Audio 

o AM 

o FM 

o PM 

o BandWidth 

o Bearing 

o Sub Audio Tone 

o Program 

o PI Code 

o Sound ID 

o Location 

- Frequency, Transmitter and Suppress List Drop Down lists 
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The first two are only active for "Frequency List Scan" and "Transmitter List Scan" 

respectively and the third one is active for "Scan", "DScan" and "Sweep" 

measurements. It is possible to create user defined lists and store them in the system. 

First of all a unique name should be written in the Drop-Down Box. Then the 

corresponding button in front of that box should be pressed and one of the screens 

shown in Figure 3.235 will be displayed. 

 

Figure 3.235. Screens for definition of Frequency, Suppress, and Transmitter Lists 

   

  

 

 

 

 

 

 

 

 

A special DB button is visible in these screens. This button enables the user to create 

the list based on the existing information in the SMS4DC database. 
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Figure 3.236. General Setting of a measurement order 

 

 

Figure 3.237. Date and Time Setting of a measurement order  

 

In the "Date and Time Setting" screen it is possible to create a one-time measurement which is 

defined using the items on the top of the screen or a periodic measurement using the items in the 

centre of the screen. And also using the items at the bottom of the page, the continuity of the 

measurement in the defined time span or period, can be defined.  
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Figure 3.238. Result Setting of a measurement order 

 

 

In the final screen for (Figure 3.238) creation of an S2M, the following selections are available: 

- Measurement Result: All Measurement results are stored. 

- MaxHold: For each frequency only the maximum measured value is stored. 

- Compressed Measurement Result: Compression interval per adjusted becomes for 

each measuring parameter (so far as possible) a result of measurement (Average, 

Standard deviation, Minimum, Maximum) stored. Storage always takes place to the 

full minute. 

- Measurement Result during an Alarm: All measured values are stored during an 

alarm. Measured values outside of the alarm are not stored. 

- Begin and End of an Alarm: The time at the beginning and time at the end of the 

alarm arisen last are only stored. The result of measurement contains the additional 

column status with the values start and stop. Measured values are not stored. 

- Measurement Result during and Compressed Measurement Result outside and Alarm: 

All measured values are stored during an alarm. Measured values outside the alarm 

are stored compressed (see Compressed Measurement Result). 

 

3.4.2.14.3.3. Order Status sub-menu of Others menu 

By this facility, it is possible to see the status of all existing orders in the INBOX folder of 

monitoring system. The states might be one of the following: 

- Open: When SMS4DC places a new order in the INBOX of the monitoring system, 

which shall execute the order, the state of the order is „Open“. The state of the sub-

orders is also „Open“. 
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- In Process: monitoring system sets the state of the sub-order to „In Process“ and 

executes the automatic measurement. The state of the order is also set to „In Process“ 

by monitoring system. 

-  Finished: After measurement, monitoring system creates the report with the 

measurement results and additional information and sets the state of the sub order to 

„Finished“. 

Figure 3.239. The screen showing the status of all existing orders in the INBOX folder of monitoring system  

 

 

3.4.2.14.3.4. Stop Order sub-menu of Others menu 

By selection of this menu, a list of all running or pending S2M orders will be displayed (Figure 

3.240) and one of them can be selected and stopped by pressing the "Create Stop Order" button. 

 

Figure 3.240. The screen showing all running or pending orders ready to be stopped 

 

 

3.4.2.14.3.5. Draw Output sub-menu of Others menu 

After successful completion of measurement of a S2M order, it is possible to visualise the 

results in either monitoring system or SMS4DC. By selection of "Draw Output" menu, the 

screen shown in Figure 3.241 is displayed and by selection of File->Open, the result XML 

file should be selected from the OUTBOX folder of monitoring system. 
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Figure 3.241. The toolbar of the screen showing the results of a measurement 

 
 

3.4.2.14.3.6. Toolbar of Others Monitoring Results view 

The following buttons are provided in the toolbar of the draw output screen to facilitate 

manipulation of the main functions: 

 

Toolbar 

Buttons 
Name Description 

 
Bar 

Chart 

This button acts the same as Tools->Mode->Bar Chart menu and displays the resulted values 

as a bar chart. The following figure is a sample screen shot of a bar chart display of 

measurement results. 

 

 

Line This button acts the same as Tools->Mode->Line menu and displays the resulted values as a 

bar chart. The following figure is a sample screen shot of a line display of measurement results. 
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3D 

View 

This button acts the same as Tools->3D (Frequency, Time, Value) and displays the resulted 

values as a 3D chart. The following figure is a sample screen shot of a 3D display of 

measurement results. 

 
 

 

2D 

(Freq., 

Value) 

This button acts the same as Tools->2D (Frequency, Value) and displays the resulted values as 

a 2D chart. The following figure is a sample screen shot of a 2D display of measurement 

results, having Frequency as X-axis and Level as Y-axis. 
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2D 

(Time, 

Value) 

This button acts the same as Tools->2D (Time, Value) and displays the resulted values as a 2D 

chart. The following figure is a sample screen shot of a 2D display of measurement results, 

having Time as X-axis and Level as Y-axis.  

 

 

Water 

fall 

This button acts the same as Tools->2D (Water Fall) and displays the resulted values as a 2D 

chart having Frequency as X-axis and Time as Y-axis. The following figure is a sample screen 

shot of a 2D Water Fall display of measurement results. 
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Grid This button acts the same as Tools->Grid or Ctrl+G keyboard shortcut and displays a 10 by 10 

grid over X-Y plane of the existing chart. The following figure is a sample screen shot of a 2D 

chart display of measurement results with the grid. 

 

 
Data 

Export 

This button acts the same as File->Export Data As… and exports the measurement data as a 

Comma Separated Values (CSV) file. The following figure is a sample screen shot of the 

export screen. 
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This button is active only when a bearing measurement result is loaded. This result may 

contain different Level and Quality values for each direction, each frequency (if measured for a 

frequency range or list) and at different sampling times. In the screen it is possible to select 

between Level and Quality values, view each measured data alone or a group of measured data 

for each frequency. 
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Legend This button acts the same as Ctrl+L keyboard shortcut or Tools->Legend 

menu item and displays the legend of colours used to depict values in the 

chart for measurement data. 
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This button acts the same as Ctrl+M keyboard shortcut or Tools->Measurement Setting 

Information menu item and displays the parameters of the order corresponding to the displayed 

result. 

 

 

As described in section 3.4.2.14.3.2, the result may contain the measurement results for up to 

four parameters. In this case it is possible to choose the desired parameter to show its 

measurement results. All possible submenu items of the Tools->Value menu is shown in the 

following table. Based on the type of measurement and availability of the results, only some of 

them might be active. Selection of statistical (e.g. Mean Value) values for some of the parameters 

might be possible only for Compressed Measurement Result (CMR) files which are described in 

section 3.4.2.14.3.2. 

 

Measured Parameter Value 

Level Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 
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Frequency Offset Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Modulation  Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Band Width Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Bearing->Quality Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Bearing->Direction Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Sub Audio Tone Value 

Mean Value 

Standard Deviation 

Maximum Value 

Minimum Value 

Program  

PI Code  

Sound ID  

Occupancy  

Number  
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Chapter 4. Administrative functions of SMS4DC 
 

 

 

 

General 

SMS4DC is powered by a database with a relational structure that starts from the license-

ownership and proceeds to the detailed specification of radiocommunication stations in the Fixed, 

Land Mobile and Broadcasting (sound and TV) services and also for Earth stations in the space 

services. A tree-view representation method is used that provides the user with tools for the: 

 Administration of licensees’ information, 

 Establishment, modification and expansion of radiocommunication networks, 

 Issuing and modification of radio licenses, 

 Invoicing of spectrum fees and recording the payment history of users, 

 ITU BR procedures for notification of frequency assignments and allotments, 

 Tracking of licensing work flow, 

 Archiving of licenses, and, 

 Navigation registered frequency assignments to radiocommunication stations and 

reporting 

  

Modification and addition of any information in the licensing part is conditional on having a User 

ID and Password in the categories of “Supervisor”, “Licensing” or "Data entry". A mouse click 

or arrow keys may be used for the selection of table fields. The Enter key must be pushed before 

accessing the edit mode of the parameter fields and, again, after the edit mode to save the data or 

the parameter selected.  Modification or deleting of the information of a granted radio license is 

not permitted. 

 

4.1. Hierarchical administrative levels 

Choosing the “Licensing” item in the “Database” menu of the DEM View opens the 

“Administrative” window. The “Administrative” window consists of two Sections; a tree view of 

administrative data in the left panel and content of selected item in the right panel. Navigating 

through different levels of administrative data is similar to navigating through folders in 

“Windows Explorer” and the same navigational keys and shortcut keys have the same function: 

(i.e. arrow keys, PgUp, PgDn, Home, End, +, -, keypad * and letters). Figure 4.1 displays the 

levels of Administrative Data. Each level is explained briefly here and completely in later 

Sections: 
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Figure 4.1. Levels of Administrative Data 
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 Root: The expandable/collapsible highest level in the tree view of “Administrative Data”. 

By expanding root, three types of permanent folders “Anonymous Stations”, “Active 

Licenses” and “Archived Licenses” will be displayed as sub-levels. 

 Anonymous Stations: A folder containing all anonymous stations which have been 

created previously outside the Administrative window of SMS4DC and can be moved to a 

License folder of an Owner in the folder of Active Licenses. 

 Active Licenses: A folder holding all active and granted licenses. This folder contains all 

active Owners with their information in lower hierarchical levels. Creation of new 

administrative information is done inside this folder. 

 Owner: A spectrum user who may have several radio Licenses. Each radio License, in 

turn, could embrace several Stations, where each Station, in lower hierarchical levels, 

could have several Equipments, Frequencies, Receivers or microwave Links. 

 Archived Licenses: A folder which holds all cancelled granted licenses. The structure of 

information under this Archive is identical to the structure of valid information under the 

“Owner” folders (introduced in the previous item). 

 License: The level immediately after Owner, containing general information about a radio 

license in a given radiocommunication service. Each radio license could hold several 

radio communication stations in a service type identical to the permitted type in radio 

license. 

 ES Station: A radiocommunication transmitting or receiving Earth station at a 

predetermined location and an inherent radiocommunication service under a radio license, 

capable of containing several beams. 

 Station: A radiocommunication transmitting or receiving station at a predetermined 

location and an inherent radiocommunication service under a radio license capable of 

containing several equipments.  

 Billing History: The list of all invoices and payments for the corresponding license. 

 Beam: A space radiocommunication uplink or downlink radiation beam of a given Earth 

station which could consist of a group of emissions. 

 Equipment: Radiocommunication equipment installed in a station and capable of 

transmitting or receiving radiocommunication signals. Any equipment could use several 

frequencies and antennas. 

 Group: A group of emissions, which have different frequencies and probably different 

classes of emission.  Each group has been assigned to an uplink or downlink radiation 

beam. 

 Frequency & Antenna: Frequency(s) and antenna(s) registered for the corresponding 

radiocommunication equipment. 

 Receiver: Corresponding receiving information for a transmitting frequency in one of the 

Point, Polygon, Circle or Zone types. 

 

Logically, at the time of SMS4DC installation, no predefined owners, license or stations exist. 
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4.2. The level of Administrative Data 

As shown in Figure 4.2, by double clicking on the level of Administrative Data (root) in the tree 

view, three types of sub-folders “Anonymous Stations”, “Active Licenses” and “Archived 

Licenses” are displayed.  

 

Figure 4.2. The highest level of tree view in Administrative window 

 
 

4.2.1. Context menu in the level of Administrative Data 

A right click on the level name opens a context menu containing the items below: 

 New Owner: This item enables the user to enter the owners personal and contact 

information in the table of Owner Information. The Table of Owner Information is created 

in right panel and the tree view in the left panel will be grayed by choosing this item. Three 

push buttons “Modify”, “Cancel” and “Save” are available above the table. A mouse click 

or arrow keys can be used for the selection of table fields. Pushing the Enter key is 

necessary to enter the edit mode of each field. The Enter key must be pushed again to save 

the entered value in the field; otherwise the information entered in the fields will be lost. 

Mandatory fields in the table are distinguished by bold fieldnames and the New Owner 

information will be saved and inserted into the tree view if these bold fields have valid data 

entered and the “Save” button is pressed, otherwise a warning message requests the user to 

complete all mandatory fields. Figure 4.3 illustrates the entry table for Owner Information. 

Table 4.2 describes the fields of the Owner Information grid. 

 New Allotment: This item enables user to enter digital broadcasting frequency allotment 

information.  A Table of Allotment Information is created in the right panel and the tree 

view in the left panel will be grayed by choosing this item. Three push buttons “Modify”, 

“Cancel” and “Save” are available above the table. Figure 4.4 illustrates the entry table for 

the Allotment Information. Table 4.2 describes the fields of the Allotment Information grid. 

 Delete Selection: In the tree view, there is a check box beside each tree item. These boxes 

allow the user to select those stations/allotments that are no longer needed and delete them 

in one operation. This feature is normally required after data import from BR-IFIC. 

 Refresh: In some cases, the contents of the data tree may be changed when the tree view is 

open (e.g. in network operation of the system when the data is changed from another 

workstation, on the same workstation but from the technical part). In this case, this menu 

item is selected to have the latest changes applied. 
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Figure 4.3. Owner information entry table 

 
Figure 4.4. Allotment information entry table 

 
SMS4DC leaves the session without further action by pushing “Cancel” button. 
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Table 4.1. Description of fields in the table of Owner Information (1) 

Field name Type Description 

Owner name M Name of spectrum user, unique. This name is displayed in front of the 

word Owner in tree view 

Owner Address M Avenue, Street and No. of user address 

City M City of owner 

Country M Combo box to select the country of owner address 

Telephone, Telex, 

Fax, Email 

O Quick contact information of owner 

Remark O Any informative text for the administrator 

Security category O A user defined security classification of owner information 

Address code M A code allocated by the BR to uniquely identify a correspondence address 

of an Administration (field 12b in BR database). 

Code of Operating 

Agency 

M The code used to identify an Operator. The Code is assigned to the 

Operator by the BR (field 12a in BR database). 

Billing Name M The name which the owner prefers to be used for billing purpose. 

Billing Address M The address where the billing letters have to be sent by Administration. 

(1) : M: Mandatory, O: Optional 

 

Table 4.2. Description of fields in the table of Allotment Information (1) 

Field name Type Description 

Allotment name M Name of Allotment, which should be unique. This name is displayed in 

front of the word Allotment in tree view 

Geographical area O Geographical area code 

No. of sub-areas O Number of sub-areas (contours) of this allotment (read only) 

Notice Type M Notice type (GS2 or GT2) 

Fragment M Fragment (GE06D) 

Plan entry code M Plan Entry Code (1, 2, 3, 4 or 5) 

SFN ID O Single Frequency Network ID 

Ref. Plan Config. M Reference Plan Configuration (1, 2, 3, 4 or 5) 

Frequency M Frequency (MHz) 

Admin. Ref. ID M Administration Reference ID 

Country M Country Code. 

Class of station O Class of station (BC or BT) 

Polarization M Polarization type (H, V, M or U) 

Reference Network O Reference Network  (1, 2, 3 or 4) 

Spectrum mask O 1, 2, 3, N or S 

Offset O  

TV channel O  

(1) : M: Mandatory, O: Optional 
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 Reports->Expired Licenses: This menu item displays a report listing the expired licenses. 

 

 

 Reports->Total Stations: This menu item displays two graphs concerning licensed and 

unlicensed stations grouped by their class of station. 
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 Reports->Custom Report: This menu item displays a dialog box in which some criteria can 

be defined. Based on these defined criteria a report in MS Access format created and shown. 
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4.3. The level of Owner 

The Level of Owner is placed under either the Administrative Data or Archive levels. Selection 

of an existing Owner in the tree view by a mouse click or other action, displays a table of 

corresponding Owner Information in the right panel of the Administrative window. The content 

of the Information table can be modified, saved or any action cancelled using the “Modify”, 

“Save” or “Cancel” push buttons above the table. For a “Modify” action, the tree view in the left 

panel of the Administrative window will be locked (grayed). For a successful “Save” action, 

mandatory fields (field name in bold) must not be left blank. The content of Owner Information 

table is described in Table 4.3. Each Owner has a unique name and could have unlimited number 

of radio licenses.  

 

4.3.1. Context menu in the level of Owner 

A right click on the level name opens a context menu containing the items “Modify Owner”, 

“Delete Owner” and “New License”. These items are explained below: 

 Modify Owner: This item modifies the content of the Owner Information table if it has no 

license granted. In this case, the tree view in the left panel of Administrative window will 

be locked and to save any modifications successfully, mandatory fields (bold field names) 

in the information table must not be left blank. Content of Owner Information table is 

described in Table 4.3. 

 Delete Owner: This item deletes the Owner information and all other attached information 

in the lower levels of tree view if has no license granted. The owners who have been 

granted licenses cannot be deleted. 

 New License: This item creates a new license platform and attaches it to the 

corresponding owner. Choosing this item creates the table of license information in the 

right panel of the Administrative window and locks the tree view. Three push buttons 

“Modify”, “Cancel” and “Save” are available above the table. At the time of creation of a 

license, the “Modify” push button is disabled. To save a new license successfully, 

mandatory fields (field names in bold), must not be left blank. The saved License, with its 

license number, is inserted under the corresponding license in the tree view. Figure 4.5 

illustrates the entry table for License Information. Table 4.3 describes the fields in 

License Information entry table. 

 

Figure 4.5. License information entry table 
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Table 4.3. Description of fields in the entry table of License Information (1) 

Field name Type Description 

License No M Number of license, unique among licenses of an Owner.  

Beginning of Use 
M 

License beginning date which is license creation date by default. A date picker is attached 

to this field to enable the user to select another date. 

Expiration Date 
M 

License expiration date, which is, by default, one year after the license creation date. A 

date picker is attached to this field to enable the user to select another date. 

Status 

M 

A combo box to select one of following status values: 

 Data entry. The default status of license. 

 Data entry complete. Manually selectable status if all data entered 

 Technical investigation. Manually selectable status when a license is at the 

technical investigation level. 

 Assignment complete. Manually selectable status when relevant frequencies are 

assigned 

 Coordination complete. Manually selectable status when the coordination is 

completed 

 Technically OK. Manually selectable status when the technical investigation is 

completed 

 First invoice unpaid. This status will be selected by SMS4DC automatically after 

the first invoice is issued.  

 Financially OK. Manually selectable status if the owner has no debit in its billing 

history. Otherwise it will stay in the “First invoice unpaid” status. 

 Granted. Manually selectable status on condition of being in the status 

“Financially OK” 

 Rejected. Manually selectable status which means rejection of a license. 

Service ID 

M 

One of the codes describing type of terrestrial or space services. For the terrestrial stations 

the codes F, B or MT are used for Fixed, Broadcasting (sound and TV) and Land Mobile 

services respectively. For the Earth stations, thirteen different codes used, starting with the 

letter “S”. The relevant table is available in Annex 1. This code must be selected at the 

time of license creation and cannot be modified if any station attached to the license, even 

if no license is granted. 

Invoice Period 

M 

Period of invoice generation. One of the selections “Monthly”, “Bi-monthly”, “Quarterly” 

and “Annually”. When the selected period has ended, an invoice will be added to the 

Billing History of relevant granted License. 

Initial Fee M The initial fee to be paid for obtaining a radio license. 

(1) : M: Mandatory,  O: Optional 

 

4.4. The level of License 

The level of license comes between the owner level and the station level. Each license may 

consist of several stations in same radiocommunication service. The station service type has to be 

determined at the license level. Selection of a license in tree view by a mouse click or other 

action, displays an entry table of corresponding License Information in the right panel of the 

Administrative window. The content of the License Information entry table can be modified, 

saved or cancelled using the “Modify” and “Save” or “Cancel” buttons above the table. A 

“Modify” action locks the tree view in the left panel of the Administrative window. For a 
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successful “Modify” action, mandatory fields (bold field names) must not be left blank. 

Modification of service type is not permitted if there are stations attached to the license. Content 

of License Information entry table is described in Table 4.3. Each License under the specific 

Owner has a unique name and could have an unlimited number of stations. Moreover, the billing 

history of each license is connected permanently to the level of the corresponding License. 

 

4.4.1. Context menu in the level of License 

A right click on the level name opens a context menu that always contains the following items: 

“Modify”, “Delete”, “Copy to Archive”, “Cancel License”, “Move Anonymous Station”, “Print 

License” and “Print Summary”. Other items may appear which are dependent on the type of the 

selected radiocommunication service. The permanent and type-dependent items are described 

below: 

 Modify: This item modifies the content of the License Information table if has not been 

granted already. The service ID in the entry table of License Information is locked if any 

station is attached to the license. At the time of modification, the tree view in the left 

panel of the Administrative window will be locked and for modifications to be saved 

successfully, mandatory fields (field names in bold) in the information entry table must 

not be left blank. The content of License Information entry table is described in Table 4.3. 

 Delete: This item deletes the License information and all other attached information in the 

lower levels of tree view, if has not been granted already. Granted licenses cannot be 

deleted.  

 Copy to Archive: This item saves a duplicate copy of the selected License in the archive. 

After performing this item, the tree view will be refreshed and archive level will show the 

new license inserted into the tree view under the corresponding Owner level. This item 

not only duplicates the selected license but also regenerates all attached information in the 

lower levels, except attached receivers. The content of License Information entry table is 

described in Table 4.3. 

 Cancel License: This item cancels a granted license from the Owner information. The 

cancelled License Information, together with all corresponding information in the higher 

and lower levels, will be moved to the “Archived Stations”. 

 Add Fixed Station: This item adds a station in the Fixed radiocommunication service to 

the selected License. This item is included in context menu if the parent license was 

created in the Fixed service (F for service ID). Selecting this item opens a blank 

“Fixed/Base Station Information” entry table in the right panel of the Administrative 

window and locks the tree view. Three push buttons “Modify”, “Cancel” and “Save” are 

available above the table. To save successfully, mandatory fields (field names in bold) 

must not be left blank. The saved station, with its name, is inserted under the 

corresponding license in tree view. Figure 4.6 displays this entry table and its content is 

described in Table 4.4. 
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Figure 4.6. Fixed/Base Station Information entry table 

 
 

Table 4.4. Description of fields in the entry table of Fixed/Base Station Information (1) 

Field name Type Description 

Admin Ref. ID O A unique identification number assigned by Administration and is used in BR 

Notices. 

Site ID M An alphanumeric unique ID, specific for station identification in corresponding 

license. 

Station Name M Name of station  

Call Sign O Assigned call sign, in accordance with the RR Article 19 (BR Notice item 3a) 

Class of Station M A combo box for determination of class of station, as classified in Preface to BR 

IFIC. For Fixed stations, only FX is available. 

Station Type O A combo box to select either Fixed, Base, Mounted or Handheld. In the example,  

this field entry is Fixed. 

ITU Region M A combo box to select the ITU Region where station is located. 

Latitude M Latitude of station in the format ±DDMMSS.SS, in the range -90 to +90. Optional 

for Typical stations. 

Longitude M Longitude of station in the format ±DDDMMSS.SS, in the range -180 to +180. 

Optional for Typical stations. 

Country M A combo box to select the country code. 

Radius of Service O The maximum range of radio communication. 

Height ASL M Station height above sea level, (measured at the base of the antenna). 
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Provision M Related provision in ITU RR under which the notification should be made. 

Area of Trans. O Area wherein transmission is going to be made (Preface to BR IFIC, Chapter IV) 

Network ID O A common ID for all stations in same network under the parent license. 

Target Latitude O Target Latitude when notifying a Modification of the placement of the station 

Target Longitude O Target Longitude when notifying a Modification of the placement of the station 

Type of Notice M T11, T14, G11 or G14 for FX station and T12, T14, G12 or G14 for FB station 

(1) : M: Mandatory,  O: Optional 

 

 Add Base Station: This item adds a base station in Land Mobile radiocommunication 

service to the selected License. This item is included in context menu if the parent license 

was created in the Land Mobile service (MT for service ID). Selecting this item opens a 

blank “Fixed/Base Station Information” entry table in the right panel of the 

Administrative window and locks the tree view. Three push buttons “Modify”, “Cancel” 

and “Save” are available above the table. At the time of creation of a Base station, the 

“Modify” push button is disabled. For a successful save, mandatory fields (bold field 

names) must not be left blank. The saved station, with its name, is inserted under the 

corresponding license in tree view. Figure 4.6 displays this entry table and its content is 

described in Table 4.4. 

 Add Mobile Station: This item adds a mobile station in the Land Mobile 

radiocommunication service to the selected License. This item is included in the context 

menu if the parent license was created in the Land Mobile service (MT for service ID). 

Selecting this item opens a blank “Mobile Station Information” entry table in the right 

panel of the Administrative window and locks the tree view. Three push buttons 

“Modify”, “Cancel” and “Save” are available above the entry table. At the time of 

creation of a mobile station, the “Modify” push button is disabled. For a successful save, 

mandatory fields (field names in bold) must not be left blank. The saved mobile station, 

with its name, is inserted under the corresponding license in tree view. Figure 4.7 displays 

this entry table and its content is described in Table 4.5. 
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Figure 4.7. Mobile Station Information entry table 

 
 

Table 4.5. Description of fields in the entry table of Mobile Station Information (1) 

Field name Type Description 

Admin Ref. ID O A unique identification number assigned by Administration and is used in BR 

Notices. 

Mobile ID M An alphanumeric unique ID, specific for station identification in 

corresponding license. 

Mobile Name M Name of mobile station  

Call Sign O Assigned call sign, in accordance with the RR Article 19 (BR Notice item 3a) 

Class of Station M A combo box for determination of class of station, as classified in Preface to 

BR IFIC. For a mobile station, only ML is available. 

Station Type O A combo box to select either Mounted or Handheld. 

ITU Region M A combo box to select the ITU Region where the station is located. 

Latitude M Latitude of corresponding base station in the format ±DDMMSS.SS, in the 

range -90 to +90. Optional for Typical station. 

Longitude M Longitude of corresponding base station in the format ±DDDMMSS.SS, in 

the range -180 to +180. Optional for Typical station. 

Country M A combo box to select the country code. 

Radius of Service O The maximum range of radio communication. 

Area of Trans. O Area wherein transmission is going to be made (Preface to BR IFIC, Chapter 

IV) 

Number of Sets O Number of mobile sets 

Provision M Related provision in ITU RR under which the notification should be made. 

Network ID O A common ID for all stations in same network under the parent license. 

Vehicle Model O Model of vehicle 

Vehicle Plate O Plate number of vehicle 

Vehicle Colour O Colour of vehicle 

Type of Notice M T13 or G13 
(1) : M: Mandatory,  O: Optional 
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 Add Broadcasting Station: This item adds a sound or TV broadcasting station in 

Broadcasting radiocommunication service to the selected License. This item is included in 

the context menu if the parent license was created in the broadcasting service (B for 

service ID). Selecting this item opens a blank “Broadcasting Station Information” entry 

table in right panel of Administrative window and locks the tree view. Three push buttons 

“Modify”, “Cancel” and “Save” are available above the table. At the time of creation of a 

broadcasting station, the “Modify” push button is disabled. For a successful save, 

mandatory fields (bold field names) must not be left blank. The saved broadcasting 

station, with its name, is inserted under the corresponding license in tree view. Figure 4.8 

displays this entry table and its contents are described in Table 4.6. 

 

Figure 4.8. Broadcasting Station Information entry table 
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Table 4.6. Description of fields in the entry table of Broadcasting Station Information (1) 

Field name Type Description 

Admin Ref. ID O A unique identification number assigned by the Administration and is used 

in BR Notices. 

Site ID M An alphanumeric unique ID, specific for station identification in 

corresponding license. 

Station Name M Name of broadcast station  

Call Sign O Assigned call sign, in accordance with the RR Article 19 (BR Notice item 

3a) 

Class of Station M A combo box for determination of class of station, as classified in Preface 

to BR IFIC. For broadcasting, only, BC and BT are available. 

Station Type O "Fixed" 

ITU Region M A combo box to select the ITU Region where station is located. 

Latitude M Latitude of station in the format ±DDMMSS.SS, in the range -90 to +90 

Longitude M Longitude of station in the format ±DDDMMSS.SS, in the range -180 to 

+180 

Country M A combo box to select the country code. 

Radius of Service O The maximum range of radio communication. 

Height ASL M Station height above sea level (measured at the base of the antenna). 

Provision M Related provision in ITU RR under which the notification should be made. 

Plan O A combo box to select one of GE84, GE89, GE06 or ST61 reference plan 

in which frequency assignment is to be made. 

Target Latitude O Target Latitude when notifying a Modification of the placement of the 

station 

Target Longitude O Target Longitude when notifying a Modification of the placement of the 

station 

Plan Entry Code O  

Assignment Code O  

Assoc. Allot. ID O Associated Allotment ID 

Assoc Allot SFN ID O Associated Allotment SFN ID 

SFN ID O Single Frequency Network ID 

Conditions Met O Are conditions met? 

Signed Commitment O Has signed commitment? 

Type of Notice M T01, T02, GS1, GT1, G02 and GB1 

(1) : M: Mandatory,  O: Optional 

 

 Add Earth Station: This item adds an Earth station in a space radiocommunication service 

to the selected License. This item is included in context menu if the parent license was 

created in the space services (with service IDs started with the letter “S” such as SA, SB, 

SF, etc). Selecting this item opens a blank “Earth Station Information” entry table in the 

right panel of the Administrative window and locks the tree view. Three push buttons 

“Modify”, “Cancel” and “Save” are available above the table. At the time of creation of 

an Earth station, the “Modify” push button is disabled. For a successful save, mandatory 

fields (field names in bold) must not be left blank. The saved station with its name, is 
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inserted under the corresponding license in the tree view. Figure 4.9 displays this entry 

table and its content is described in Table 4.7. 

Figure 4.9. Earth Station Information entry table 
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Table 4.7. Description of fields in the entry table of Earth Station Information (1) 

Field name Type Description 

Typical or Specific 

Station 

M A code specifying the type of Earth station, “S” for specific or “T” for 

Typical 

Earth Station Name M Name of Earth station operating with geo-stationary satellites 

Country M A code specifying administration code 

Associated space 

station 

M The name of the geo-stationary space station communicating with Earth 

station 

Nominal longitude 

of space station 

O Orbital position of associated geo-stationary space station in degrees 

Minimum elevation 

angle 

M The minimum elevation angle of Earth station, in degrees, to reach space 

and overcome surrounding terrain 

Operating Azimuthal 

Angle (from) 

M Starting azimuthal angle of earth station antenna beam in degrees 

Operating Azimuthal 

Angle (to) 

M The highest azimuthal angle of earth station antenna beam in degrees. This 

value will be identical with the value of “Operating Azimuthal Angle 

(from)”, in case fixed beam. 

Altitude of the earth 

station antenna 

M The height of Earth station antenna centre with respect to the ground level 

in metres 

Latitude M Latitude of station in the format ±DDMMSS.SS, in the range -90 to +90 

Longitude M Longitude of station in the format ±DDDMMSS.SS, in the range -180 to 

+180 

(1) : M: Mandatory,  O: Optional 

 

 Add Allotment: This item adds a GE06 allotment in the broadcasting service to the 

selected License. This item is included in the context menu if the parent license was 

created in the broadcasting service (with service ID equal to “B”). Selecting this item 

opens a blank “GE06 Allotment Information” entry table in the right panel of the 

Administrative window and locks the tree view. Three push buttons “Modify”, “Cancel” 

and “Save” are available above the table. At the time of creation of an Allotment, the 

“Modify” push button is disabled. For a successful save, mandatory fields (field names in 

bold) must not be left blank. The saved allotment, with its name, is inserted under the 

corresponding license in tree view. Figure 4.9 displays this entry table and its contents are 

described in Table 4.2. 

  Move Anonymous Station: This item moves a station from the folder of “Anonymous 

Stations” to the active license. By choosing this item, all stations inside the folder 

“Anonymous Stations”, with consistent service type of license, are tabulated in a 

spreadsheet for user selection. A mouse left click can be used for the selection of stations 

from the spreadsheet. The service type of the listed anonymous stations is determined in 

the service ID of the parent license information table. Pushing OK button under the 

spreadsheet inserts a selected station under the corresponding license in tree view. 

 Move Anonymous Allotment: This item moves an allotment from the folder of 

“Anonymous Stations” to the active license. By choosing this item, all allotments inside 

the folder “Anonymous Stations", are tabulated in a spreadsheet for user selection. A 

mouse left click can be used for the selection of allotments from the spreadsheet. Pushing 
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the OK button under the spreadsheet inserts a selected allotment under the corresponding 

license in tree view. 

 Print License: This item generates and displays a printable radio license in HTML format, 

using a customizable template. SMS4DC asks the user to specify the folder where the 

generated HTML file, with the name “LIClicense_no.HTM”, is to be saved. The 

appearance and content of the printable file can be easily customized by modifying the 

relevant template file with a suitable editor, i.e. “Front Page”. Template files are stored in 

the folder “Reports”. 

 Print Summary: This item generates and displays an indented text file containing all the 

information under the corresponding license. SMS4DC asks user for the folder where the 

generated text file, with the name “license_noSUMMARY.TXT”, is to be saved. Then the 

text file will be opened by Notepad. Figure 4.10 displays a license summary file. 

 

Figure 4.10. A license summary file 

 
 

4.5. The level of Earth Station 

The level of Earth station is placed between the license level and the beam level. Each Earth 

station may consist of several beams in the same space radiocommunication service. The content 

of the Beam Information table depends on the type of beam. Selection of an Earth station in tree 

view by a mouse click or other action, displays a table of corresponding Earth Station 

Information in the right panel of Administrative window (see Figure 4.9). The content of 
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Information table can be modified, saved or any action cancelled using “Modify” and “Save” or 

“Cancel” push buttons above the table, if relevant license has not been granted. In case of 

modification, the tree view in the left panel of the Administrative window will be locked and, to 

save modifications successfully, mandatory fields (field names in bold) must not be left blank. 

The content of the Earth Station Information table is described in Table 4.7. Each Earth Station 

under a specific License has a unique name and could have an unlimited number of beams. 

 

4.5.1. Context menu in the level of Earth Station 

A right click on the level name opens a context menu containing “Modify”, “Delete”, “Add Beam 

(Up)”, “Add Beam (Down)”, “Horizontal Elev. Angles”, “Minimum Elev. Angles” and “Notice” 

items.  These items are described below: 

 Modify: This item modifies the content of the Earth Station Information table. At the time 

of modification, the tree view in the left panel of the Administrative window will be 

locked and, to save a modification successfully, mandatory fields (field names in bold) in 

the information entry table must not be left blank. The content of the Earth Station 

Information table is described in Table 4.7. 

 Delete: This item deletes the Earth Station and all other attached information in the lower 

levels of tree view if it has not been included in any granted license.  

 Add Beam (up): This item defines an uplink beam and chooses or creates its pattern from 

the antenna beam library for the current Earth station. Selecting this item creates a blank 

“Earth station antenna information” entry table in the right panel of the Administrative 

window and locks the tree view. Five push buttons “Modify”, “Cancel”, “Save”, 

“Library” and “Patt. Values” are available above the table. At the time of creation of a 

beam, the “Modify” push button is disabled. For a successful save, mandatory fields (field 

names in bold) must not be left blank. The saved station, with its name, is inserted under 

the corresponding Earth station in tree view. Figure 4.11 displays this entry table and its 

content is described in Table 4.8. 

 The push buttons “Library” and “Patt. Values” are designed to enter the characteristics of 

Earth station antenna. The user is able to choose a ready-to-use antenna from the library 

(Figure 4.12) or to define an antenna pattern directly by entering its gain values at 

different offset angles (Figure 4.13).  
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Figure 4.11. Earth Station Antenna Information entry table 

 

Table 4.8. Description of fields in the entry table of Earth Station Antenna Information (1) 

Field name Type Description 

Transmitting or 

receiving 

M A letter specifying type of beam, “E” for uplink and “R” for downlink. 

SMS4DC sets this flag automatically, depending on the chosen item of 

context menu it cannot be modified directly. Read-only. 

Beam designation M A textual information for designation of beam 

Beamwidth M Beamwidth of Earth station antenna beam in degrees 

Maximum isotropic 

gain 

M The maximum isotropic gain of Earth station antenna along the beam in 

dBi 

Antenna diameter O Diameter of parabolic antenna in metres, if specified 

Reference pattern O Textual information about the reference antenna pattern used. This 

information will be imported from the earth station antenna library and 

cannot be modified directly from here. 

CoefA to CoefD O Numerical coefficients of antenna pattern in dB. This information will be 

imported from the earth station antenna library and cannot be modified 

directly from here. 

PHI1 O A numerical coefficient of antenna pattern in degree. This information will 

be imported from the earth station antenna library and cannot be modified 

directly from here. 

(1) : M: Mandatory,  O: Optional 

 

By using the “Library” push button, a library of Earth station antenna patterns is opened 

and the user may select an existing antenna or define a new pattern, using the push button 

“New Pattern”. A new antenna pattern will be characterized by a set of new coefficients 

and, after definition, will be added to the library for selection. Figure 4.12 and Figure 4.13 

show the library of Earth station antennas and the entry mask for coefficients for new 

antenna patterns. 
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Figure 4.12. Library of antenna patterns of earth station 

 

Figure 4.13. Entry mask of coefficients for a new antenna pattern 

 
 

In case of having no reference coefficients for earth station antenna pattern, the antenna 

gain values for different offset angles with respect to the antenna main beam direction 

may be entered directly into the SMS4DC database. Figure 4.14 displays the Earth station 

antenna pattern definition entry table which will opened if the “Patt. Values” button is 

pressed. 
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Figure 4.14. The earth station antenna pattern definition entry table 

 
 

Four push buttons are provided at the top of the “Antenna Pattern” table: for addition of 

new record, for deleting the existing record, to save the table and to exit from mask, 

respectively. Blank rows are deemed as zero. 

 Horizon Elevation: This item enters the azimuth and elevation angle to the horizon and its 

distance to the earth station around the earth station in different azimuths. As displayed in 

Figure 4.15, choosing this item opens an entry table consisting of three columns: 

“Azimuth”, “Elevation Angle” and “Distance” (in km) to save this information. 

 

Figure 4.15. Entry table to provide an earth station the horizon elevation angles in different azimuths 

 

 

 Minimum Elev. angles: This item enters the minimum elevation angle of earth station 

antenna at different azimuths. As displayed in Figure 4.16, choosing this item opens an 

entry table consisting of two columns to save this information. 

 

 Figure 4.16. Entry table to provide the minimum elevation angle of earth station antenna 
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Notice: This item generates a BR electronic notice, ready for submission to ITU BR. By 

selection of this item, a dialogue box is opened for the user to complete the remaining 

general information of earth station. Figure 4.17 displays the BR Notice dialogue box. 

 

Figure 4.17. Notice dialogue box 

 
 

Data items of Notice dialogue box explained in Table 4.9. 

 

Table 4.9. Data items of Notice dialogue box 

Item name Description 

Admin Ref. ID Reference ID of administration 

Notice Date The date of Notice generation or other date which the user selects from the 

associated calendar 

Provision Combo box to select one of the applicable provisions of the RR 

Old Notice ID The notice ID of the old Notice, in case of resubmission 

Action Combo box to select one of A, M or S which are for Add, Modification 

and Suppress 

Notifying 

Administration 

The ITU code of the Administration notifying this notice. This code is 

automatically detected by the software but the user is able to change it. 

Submission A combo box to select either F or R, standing for First and Re-submission 

of Notice 

 

The extracted BR electronic notice can be saved as an “mdb” database file using the 

“Save” push button, once this dialogue box entry is and no mandatory fields of Earth 

station remain blank, as in other information tables. The saved “mdb” file may be 

imported into the BR “Space Capture” tool for a double check. 

 

4.6. The level of Beam 

The level of beam is placed between the Earth station level and the group level. Each beam may 

consist of several groups under the same radiation beam. The content of a Group Information 
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table depends on the type of beam defined in Earth station level. Selecting a beam in tree view by 

a mouse click or any other action, displays a table of the corresponding Earth Station’s Antenna 

Information table in the right panel of the Administrative window. The content of the Information 

table can be modified and then saved or cancelled using the “Modify” and “Save” or “Cancel” 

push buttons above the table, if relevant license has not been granted. In the case of modification, 

the tree view in the left panel of the Administrative window will be locked and, for the 

modifications to be saved successfully, the mandatory fields (field names in bold) must not be 

left blank. Modification of the type of beam is not permitted if groups were attached to the beam. 

The content of the Earth Station Antenna Information table for different types of beams is 

described in Table 4.7. Any beam under a specific Earth station has a unique name and may have 

unlimited number of groups. 

 

4.6.1. Context menu in the level of Beam 

A right click on the level name opens a context menu containing “Delete”, “Add Group” and 

“Show Pattern” items. Two, slightly different, tables of group information have been developed 

for different types of beam. These items are described below: 

 Delete: This item delete the Earth Station Antenna Information and all other attached 

information in the lower levels of tree view, if it has not been included in any granted 

license. Granted licenses cannot be deleted.  

 Add Group: This item adds to the selected License a group of emissions under a beam to 

an earth station, operating with geo-stationary satellites, in a space radiocommunication 

service. Selecting this item opens a blank “Group Information” entry table in the right 

panel of the Administrative window and locks the tree view. The priority of the field in 

this information table is partially dependent on the type of selected beam. Three push 

buttons “Modify”, “Cancel” and “Save” are available above the table. At the time of 

creation of a group, the “Modify” push button is disabled. To save a table, mandatory 

fields (field name in bold) must not be left blank. The saved group, with its name, is 

inserted under the corresponding beam in tree view. Figure 4.18 shows this entry table 

and its content is described in Table 4.10. 
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Figure 4.18. Group Information entry table 

  

Table 4.10. Description of fields in the entry table of Group Information (1) 

Field name Type Description 

Responsible 

administration 

M A combo box to select the organization responsible for the emission 

previously registered with the ITU (Listed in Preface to BR IFIC (Space 

Services). The word “Other” could be selected in the case of an 

unregistered organization name 

Assigned frequency 

bandwidth 

M The bandwidth of the assigned frequency in kHz 

Data of bringing into 

use 

M The date on which the emission will begin operation 

Noise temperature O/M Receiving system noise temperature. This item is mandatory for downlink. 

Operating agency M A combo box to select the operating organization previously registered 

with the ITU (Listed in Preface to BR IFIC (Space Services). The word 

“Other” could be selected in case of an unregistered organization name 

Polarization type M A combo box to select the polarization of emission. 

Polarization angle O The angle of slant polarization if the type L999 selected for polarization 

type 

Remarks O Any remark 

Maximum aggregate 

power 

M/O The maximum value of the peak envelope power supplied to the input of 

the Earth Station Antenna in the Assignment Coordination Group's 

Bandwidth. Mandatory in case of uplink. 

Minimum frequency M Minimum frequency of a group. Automatically calculated when the 

assigned frequencies are entered. 

Maximum frequency M Maximum frequency of a group Automatically calculated when the 

assigned frequencies are entered. 

(1) : M: Mandatory,  O: Optional 

 

 Show Pattern: This item displays the radiation pattern of the antenna (symmetrical with 

respect to the bore sight) assigned to the relevant Earth station in the direction of uplink or 
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downlink, depending on the type of beam. The default antenna pattern will be displayed if 

no antenna assigned or a non-standard antenna assigned to the earth station. The default 

antenna pattern is extracted from Recommendation ITU-R S.465. 

 

Figure 4.19. An example of earth station antenna pattern 

 
 

 

4.7. The level of Group 

The level of group is placed under the beam level. However, each group could consist of several 

emissions and frequencies. The content of the emission entry table depends partially on the type 

of beam defined in earth station level. Selecting a group in tree view by a mouse click or other 

action, displays a table of corresponding Group Information table in the right panel of the 

Administrative window. The content of the Information table can be modified, saved or the 

action cancelled using the “Modify” and “Save” or “Cancel” push buttons above the table, if 

relevant license has not been granted. In case of a modification, the tree view in the left panel of 

the Administrative window will be locked and a warning message displayed if the user tries to 

save the table with mandatory fields that are left blank. The content of the Group Information 

table for different types of beams is described in Table 4.10. Any group under the specific beam 

of earth station has a unique name and could have several emissions and frequencies. 

 

4.7.1. Context menu in the level of Group 

A right click on the level name opens a context menu containing “Emissions”, “Frequency 

Assignments”, “Special Section”, “Coordination”, “Class of Station”, “Filter” and “Delete” 

items. The following is a description of these items: 

 Emissions: This item provides a list of emissions in the downlink and uplink directions. 

Selecting this item opens an entry table to define a multiple emission specification. At the 

top of table there are three push buttons to add new emissions, to delete registered 

emissions in the table and to save entered emissions into the database. The content of the 
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table is different for uplink and downlink directions.  Figure 4.20 shows the entry tables 

and Table 4.11 explains the table fields. 

 

 Figure 4.20. Entry tables to provide list of emissions for a) downlink and b) for up link 

 

 

 

 

 

 
 

(a) for downlink     (b) for uplink 

Table 4.11. Description of fields in the entry table of Emission Information 

Field name Description Up Down 

Designation of 

emission 

Combination of class of station and necessary bandwidth, as explained 

in ITU RR App.1 
X X 

C/N The quality threshold level for the Carrier-to-Noise ratio, set in 

the appropriate ITU-R Recommendations, for the full Earth 

Station Antenna/Space Station/Earth Station Antenna path under 

clear sky propagation conditions (-10 to 25). 

 X 

Total peak power 

(dBW) 

The total peak envelope power supplied to the input of the antenna in 

the Assignment Coordination Group's Bandwidth (-10 to 40). In case of 

an individual carrier, this field will receive the maximum peak power. 

X  

Maximum power 

density (dBW/Hz) 

The maximum power density in the worst 4 kHz (below 15 GHz) or 1 

MHz (above 15 GHz) in the Assignment Coordination Group's 

Bandwidth supplied to the input of the antenna averaged over 4 kHz 

(below 15 GHz) or 1 MHz (above 15 GHz) (-120 to 00) 

X  

Minimum peak power 

to antenna (dBW) 

The minimum value of the peak envelope power supplied to the input 

of the antenna for an individual ACG Frequency  
X  

Minimum power 

density (dBW/Hz) 

The minimum power density in the worst 4 kHz (below 15 GHz) or 1 

MHz (above 15 GHz) supplied to the input of the antenna of an 

individual ACG Frequency averaged over 4 kHz (below 15 GHz) or 1 

MHz (above 15 GHz) (-120 to 00) 

X  

 

 Frequency Assignments: This item assigns a frequency to a group of emissions. Selecting 

this item opens an entry table to register multiple frequencies in MHz. At the top of table 

there are three push buttons to add new frequencies, to delete registered frequencies in the 

table and to save entered frequencies into the database. Figure 4.21 shows this entry table.  
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Figure 4.21. Entry table of assigned frequencies to a group of emissions 

 
 

 Special Section: This item sets the BR publication reference for a given group of 

emissions. Selecting this item opens an entry table to set multiple references. At the top of 

table there are three push buttons to add a new reference, to delete an existing reference in 

table and to save entered information into the database. Figure 4.22 displays this entry 

table.  

 

Figure 4.22. Entry mask to store ITU BR publication reference 

 
 

 Coordination: This item stores a list of administrations for which coordination has to be 

initiated under the specified provisions. Selecting this item opens an entry table to provide 

a list of administrations with the related coordination provision. At the top of the table 

there are three push buttons to add a new case, to delete an existing case in the table and 

to save entered information into the database. Figure 4.23 displays this entry table.  
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Figure 4.23. Entry table of list of administration to which coordination has to be initiated 

 
 

 Class of Station: This item sets class of stations and nature of services applicable to the 

group of beams. Selecting this item opens an entry table to define class of stations and 

nature of services using the relevant combo box. At the top of table there are three push 

buttons to add a new case, to delete an existing case in the table and to save entered 

information into the database. Figure 4.24 displays this entry table.  

 

Figure 4.24. Entry table to set class of stations and nature of services 

 
 

 Filter: This item defines the emission mask of the uplink or downlink signals of a given 

group. Selecting this item opens a dialogue box (Figure 4.25) to enter emission mask 

attenuation data in up to 20 off-centre frequencies. Prior to the display of this dialogue 

box, a warning message will be generated to remind the user that the emission mask is 

lacking and no emission mask has been defined previously. Attenuation values in the 

table must be positive and the refresh button is necessary to reflect any value change to 

the picture of the mask in the right panel. Using the Save button assigns the defined 

emission mask to the concerned emission. 
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Figure 4.25. Dialogue box for definition of transmitting frequency emission mask 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Delete: This item deletes the Group Information and all other attached information if it 

has not been included in any granted license. Granted licenses cannot be deleted.  

 

 

4.8. The level of Station 

The level of station is placed between the License level and the Equipment level. Each station 

may consist of several equipments in the same radiocommunication service. The content of the 

equipment information table depends on the class of station defined in the station level. Selection 

of a station in tree view by a mouse click or other action, displays a table of the corresponding 

Station Information in the right panel of the Administrative window. The content of the 

Information table can be modified, saved or any action cancelled using “Modify”, “Save” or 

“Cancel” buttons above the table, if the relevant license has not been granted. For modification, 

the tree view in the left panel of the Administrative window will be locked and a warning will be 

displayed if the user tries to save a modified table with mandatory fields (bold field names) 

containing invalid data or left blank. Modification of class of station is not permitted if there is 

some equipment attached to the station. The contents of the Station Information table for different 

classes of station are described in Table 4.4 to Table 4.6. 

Each Station under the specific License has a unique name and could have an unlimited number 

of equipments. 

 

4.8.1. Context menu in the level of Station 

A right click on the Level name opens a context menu containing “Modify”, “Delete”, “New 

Equipment” and “Electronic Notice” items. Different tables of equipments have been developed 

for different classes of stations. The following is a description of these items: 

 Modify: This item modifies the content of the Station Information table if has not been 

included previously in any granted license. Modification of the class of station is not 

permitted if there has been equipment(s) attached to the station. At the time of 

modification, the tree view in the left panel of the Administrative window will be locked 

and a warning will be displayed if the user tries to save a modified table with mandatory 
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fields (bold field names) that contain invalid data or are left blank. The contents of a 

Station Information table for different classes of stations are described in Table 4.4 to 

Table 4.6. 

 Delete: this item deletes the station information and all other attached information in the 

lower levels of tree view, if has not been included in any granted license. Granted licenses 

cannot be deleted.  

 New Equipment: This item defines new equipment or loads it from the equipment 

catalogue library to the current station. Selecting this item creates a blank “Equipment 

Information” entry table in the right panel of the Administrative window and locks the 

tree view. Content of Equipment Information table depends on the class of station defined 

in the higher (station) level. 

Table 4.12 describes the fields used in the entry table of Equipment Information for different 

classes of stations.  

 

Table 4.12. Description of fields in the table of equipment information for different class of stations (1) 

Field name Type Field Description 
Class of Station 

FX FB ML BC BT 

Equipment 

Name 

M Name of equipment given by manufacturer. 
X X X X X 

Power to 

Antenna 

M Transmitter power, in W, provided at transmitting antenna 

port. 
X X X X X 

Power Type M A combo box to select one of the letters X, Y or Z in 

accordance with the Preface to BR IFIC, Chapter IV, Section 

7 

X X X X X 

Radiated 

Power 

M Transmitter radiated power in W in the direction of antenna 

maximum gain. 
X X X   

Type of Rad. 

Power 

M One of the type of radiation power E, I or M for e.r.p., e.i.r.p. 

or e.m.r.p. (RR No.s 1.161 to 1.163) 
X X X   

Manufacturer O Manufacturer of equipment X X X X X 

Model O A code to identify the model of manufactured equipment X X X X X 

Serial no. O Serial number of equipment X X X X X 

Vision Carr. 

Freq. Offset 

(/12 line) 

O Displacement of the vision carrier nominal frequency, 

expressed as multiples of 1/12 of the line frequency. Allowed 

values for offset expressed as a fraction of the Line 

Frequency of the television system are 0 or integer in the 

range from -399 to +399. Following table explains the 

allowed codes (Item 1e in BR database): 

CodeMeaning  Code Meaning 

0 0    

+1 + 1/12  –1 – 1/12 

+2 + 2/12  –2 – 2/12 

+3 + 3/12  –3 – 3/12 

~ ~  ~ ~ 

+399 + 399/12  –399 – 399/12 
 

NOTE - The Regional Agreements ST61 and GE89 and the 

original notice forms only allowed the use of offset expressed 

in 1/12th of line frequency. However, it is noted that whole 

ITU Regions outside the ST61 and GE89 planning areas 

usually express these offsets in kHz, and that for digital 

    X 
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television, offsets in kHz will be the only possibility. 

Therefore, form T02 allows a choice between these two 

expressions of the same physical information. 

Vision Carr. 

Freq. Offset 

(kHz) 

O Same as previous item, except presented in kHz Values are 

between -500 and +500 and may contain decimals. Item 1e in 

BR database 

    X 

Sound Carr. 

Freq. Offset 

(/12 line) 

O Displacement of sound carrier nominal frequency, expressed 

as multiples of 1/12 of line frequency. If the Frequency offset 

stability indicator is "Normal" or "Precision", the value of the 

sound carrier frequency offset code is equal to the value of 

the vision carrier frequency offset Code. This item is optional 

if frequency stability is “Normal” or “Precision” for actions 

ADD and MODIFY and these fields must not be notified in 

other cases. They will be ignored if the frequency stability is 

“Relaxed”. 

By default, if the frequency stability is “Normal” or 

“Precision” the value is equal to the vision frequency offset. 

The same rule as for vision frequency offset apply. 

    X 

Sound Carr. 

Freq. Offset 

(kHz) 

O Same as previous item, except presented as a frequency in the 

range of –500.000 to 500.000 kHz.     X 

TV System M TV system as defined in the Preface to BR IFIC, Chapter 8, 

Section IV  
    X 

Colour System M One of the TV colour systems: NTSC, PAL or SECAM. Item 

7c2 in BR database. Item 7c1 in BR database 
    X 

FM 

Transmission 

code 

M The code to identify the type of the FM radio transmission 

and the maximum frequency deviation used. Used for FM 

sound broadcasting only (Item 7d in BR database). 

Code                 Meaning 

  1     Monophonic (maximum frequency deviation ± 75 kHz). 

  2    Monophonic (maximum frequency deviation ± 50 kHz). 

  3 Stereophonic, polar modulation system (maximum 

frequency deviation ± 50 kHz). 

  4  Stereophonic, pilot-tone system (maximum frequency 

deviation ± 75 kHz). 

  5  Stereophonic, pilot-tone system (maximum frequency 

deviation ± 50 kHz). 

   X  

Max. erp of the 

horz. Polarized 

comp. 

M The product of the power supplied to the Antenna and the 

Transmitting Antenna's Maximum Gain for the horizontally 

polarized component. Item 8bh in BR database 

   X X 

Max. erp of the 

vert. Polarized 

comp. 

M The product of the power supplied to the Antenna and the 

Transmitting Antenna's Maximum Gain for the vertically 

polarized component. Item 8bv in BR database 

   X X 

Power Ratio O The power ratio (dB) between the effective radiated power of 

the vision carrier and the effective radiated power of the 

primary sound carrier. This information is mandatory for 

analogue television notices for actions ADD and MODIFY 

and must not be notified in the other cases. Recommendation 

ITU-R BT.470 gives acceptable values of vision to sound 

power ratio for different television systems. Item 8d in BR 

database 

    X 

Field Strength 

Ref. 

O Reference usable field strength, obtained from plan 
   X X 
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Sensitivity M Receiver sensitivity in dBµV/m X  X   

Energy 

Dispersal 

O A textual description of the energy dispersal systems 

characteristics. Typically this would include the frequency 

deviation, the sweep frequency and the shape of the waveform 

added to the baseband signal prior to the FM modulator to 

prevent high levels of energy concentration on the Reference 

(Carrier) Frequency during periods of no, or small levels of 

modulation signal (Item 7f in BR database). 

X     

Frequency 

Stability 

M Acceptable values are RELAXED, NORMAL and 

PRECISION on electronic notices, abbreviated as R, N or P 

for paper notices. Relaxed corresponds to the minimum 

frequency stability in Appendix 2 of the Radio Regulations. If 

the frequency stability is NORMAL, non-precision offset is 

possible, and if the frequency stability is PRECISION, 

precision offset is possible. See Recommendation ITU-R 

BT.655. Under GE89 Agreement, the frequency stability 

must be Normal or Precision; Under ST61 Agreement, the 

frequency stability must be Normal or Precision if the 

effective radiated power is equal to or more than 30dBW for 

bands below 470 MHz, or if the effective radiated power is 

equal to or more than 40dBW for bands above 470 MHz. BR 

Notice item 7a1 

    X 

Noise Factor O  X     

System Type 1 

And 

System Type 2 

M (GE06) 

X X X   

Ref. Plan. 

Config. 

M Reference Planning Configuration (GE06) 
   X X 

System Variant M (GE06)     X 

RX Mode M (GE06)     X 

Maximum 

Power Density 

O The maximum power density at the output of the transmitter 

for each carrier type and averaged over the worst 4 kHz for 

carriers below 15 GHz and for each carrier type averaged 

over the worst 1 MHz for carriers above 15 GHz, supplied to 

the antenna transmission line. Item 8ab in BR database 

X X X X X 

(1): M: Mandatory,  O: Optional 



 
282 

Four buttons “Modify”, “Cancel”, “Save” and “Library” are available above the table. At the 

time of entering new equipment or selecting from library, the “Modify” push button is 

disabled. Mandatory fields in the entry table of Equipment Information (field names in bold) 

must not be left blank, otherwise a warning message is displayed. Figure 4.26 shows the 

table of Equipment catalogue. After pushing the save button, a message box gives the user 

the option to overwrite the corresponding equipment information in the equipment catalogue 

or to create a new equipment type. The new equipment created in the equipment catalogue 

will be available for all stations in the same class of station. 

 

Figure 4.26. Spreadsheet of Equipment catalogue 

 
 

The saved equipment, with its name, is inserted under the corresponding station in tree view.  

 Electronic Notice: This item generates, stores and displays an electronic notice to notify the 

ITU BR of the assigned frequency(s) or administrative modification(s). As required in the 

specification, SMS4DC is able to generate T01, T02, T11, T12, T13, T14, TB1, TB2, TB3, 

TB4, TB5, G11, G12, G13, G14, GS1, GT1, G02 and GB1 electronic notices. Depending on 

the notice type, SMS4DC determines the type of electronic notice applicable to the case and 

provides options in the relevant dialogue box (Figure 4.27a and Figure 4.27b). No notice 

form will be generated if the mandatory fields in the consequent levels of the tree view are 

incomplete and an error message will be displayed. Therefore, users must complete all 

mandatory information, including: frequency(s), receiver information and antenna 

characteristics; to generate a complete notice form. Figure 4.27c shows an example of a 

generated G11 notice. The default date of the notice will be the date of notice generation. 

However, this may be customized by using the integrated date picker 
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Figure 4.27. a) Notice option dialogue box,  

b) applicable actions for each service type, and c) a sample G11 BR Notice 

 

 

 

 

 

 

 

 
 
 

                       (a) Notice option dialogue box 

 

Action 

Service Type 

Fix

ed 

Mob

ile 

Broadcasti

ng 

 ADD X X X 

 ADMINID   X 

 CONFORM   X 

 COORDINATION   X 

 MODIFY X X X 

 PARTB   X 

 SUPPRESS X X X 

 WITHDRAW X X X 

         (b) Envisaged actions for each service type       (c) A sample G11 BR Notice 

 

4.9. The level of Billing History 

SMS4DC provides the user with a procedure for regular frequency-fee payment management. Once 

the data entry of a license is finished, the Administrator may issue the first invoice letter and require 

the license owner to pay for being granted the corresponding radio license. When the first payment 

is settled, the license may be granted and regular invoices will be issued automatically by the 

software; one invoice record for each time period (determined in the combo box “Invoice Period” in 

License Information entry table).  

The level of billing history is placed below the level of license (with no lower levels). As displayed 

in Figure 4.28, each license has an individual billing history which is created by SMS4DC at the 

same time that the relevant license was created. Selection of a Billing History in tree view, by a 

mouse click or other action, displays a list of issued invoices and registered payments for the 

corresponding license in the right panel of Administrative window. A print button at the top of the 

table has been implemented to print the selected invoice or receipt of payment. By pushing “print” 

button, the location to save the generated html invoice file is requested, and then the generated file is 

opened. Figure 4.28 displays the Billing Information table and its content is explained in Table 4.13. 
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Figure 4.28. Billing Information table 

 
 

Table 4.13. Description of Billing Information table items 

Column name Description 

Bill no. Record ID. For payments it is entered manually while for invoices it is 

generated automatically. 

Date The date of creation of record or defined date 

Description Type of transaction, invoice or payment 

Debit Amount payable for the time period starting from last invoice to the date 

of current invoice if description presents an invoice or zero if description 

presents a payment. 

Credit Amount in owners account prior to paying the current payment, if  an 

invoice is presented. 

Balance The balance in the account. A negative sign means payment is necessary, 

while positive means the owner still has credit. 

 

4.9.1. Context menu in the level of Billing History 

A right click on the level name opens a context menu containing: “First Invoice” and “New 

Payment” items. The following is a description of these items: 

 First Invoice: This item issues the first invoice which owner has to pay including the initial 

fee (determined in the entry table of License Information) for obtaining a radio license. 

Selecting this item adds the first invoice record to the Billing History Information table of 

active license. The consequent invoices will be issued automatically for any previous time 

period (selected in the combo box Invoice Period of entry table of License Information). The 

Print button for a selected invoice record, generates, saves and displays an HTML invoice 

letter file. Figure 4.29 displays an invoice. 
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Figure 4.29. An example of issued invoice 

 
 

 New Payment: This item registers the payment and considers it in the Billing History of 

owner of the active license. Selecting this item opens a dialogue box to enter payment 

details. Figure 4.30 shows this dialogue box. The Print button, for a selected payment record, 

generates, saves and displays an HTML receipt letter file. 

 

Figure 4.30. Dialogue box of payment registration in Billing History Information table of a License 

 
 

4.10. The level of Equipment 

The level of equipment is placed between the terrestrial station level and the Frequency and Antenna 

level. Each equipment may have several frequencies and antennas. Selection of an equipment in tree 

view by a mouse click or other action, displays the corresponding Equipment Information table in 

the right panel of the Administrative window. The content of the Information table can be modified, 

saved or any action cancelled using “Modify”, “Library” and “Save” or “Cancel” push buttons 

above the table, if the relevant license has not been granted. In case of modification, the tree view in 

the left panel of the Administrative window will be locked and mandatory fields (field name in bold) 

must be not left blank, otherwise a warning is displayed. The content of the equipment table is 

different for different classes of station and is described in Table 4.12. Each equipment under the 

specific station has a unique name and may have an unlimited number of frequencies and antennas. 

New equipment can be defined using the “New Equipment” item of context menu in station level. 
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4.10.1. Context menu in the level of Equipment 

A right click on the level name opens a context menu containing the items: “Modify”, “Delete”, 

“New Antenna” and “New Frequency”. The following is a description of these items: 

 Modify: This item modifies the content of the Equipment Information table if it has not been 

already included in any granted license. At the time of modification, the tree view in the left 

panel of the Administrative window will be locked and mandatory fields (field names in 

bold) must not be left blank, otherwise a warning is displayed. The content of the Equipment 

Information table for different classes of stations is described in Table 4.12. 

 Delete: This item deletes the equipment information and all other attached information in the 

lower levels of tree view, if has not been included in any granted license.  Granted licenses 

cannot be deleted. 

 New Antenna: This item defines a new antenna or loads it from the antenna catalogue library 

to the current equipment. Selecting this item creates a blank “Antenna Information” entry 

table in the right panel of the Administrative window and locks the tree view. The content of 

Antenna Information entry table has slight variations for different classes of stations. Figure 

4.31 illustrates entry table for Antenna Information for the fixed service and Table 4.14 

describes the fields used in the Antenna Information entry table. 
 

Figure 4.31. Table of Antenna Information 
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Table 4.14. Description the fields of Antenna information entry table 

Field name Type Description 

Station 

Type 

FX others 

Azimuth of Max. 

Radiation 

M The angle of the direction of the Antenna's Maximum Gain, measured in the horizontal plane from True North in a 

clockwise direction. In case of rotational antenna the angle of the direction of the Antenna's Maximum Gain at the 

left hand edge of the Operational Sector swept by the rotational antenna beam. 

X X 

Rot. Azimuth (to) O The angle of the direction of the Antenna's Maximum Gain at the right hand edge of the Operational Sector swept 

by the rotational antenna beam, measured in the horizontal plane from True North in a clockwise direction. 
X  

Elevation M The angle measured in the vertical plane between the direction of the Antenna Maximum Gain and the horizontal 

plane. For orientation below horizon the angle will be negative. 
X X 

Antenna Height 

AGL 

M Height of antenna centre above ground level. Summation of this value and site height (ASL) must reach to the 

antenna 
X X 

Antenna Name M Name of antenna X X 

Class of Antenna M A combo box for selecting one of the T, R or C for TX, RX or TX/RX Antenna respectively X X 

Antenna Type O Type of antenna X X 

Polarization M The code for representing the polarization of antenna. Select from the following table: 

CL Left hand circular or indirect: the electric field vector rotates anti-clockwise. 

CR Right hand circular or direct: the electric field vector rotates clockwise. 

D Dual: when substantially equal-amplitude vertically and horizontally polarized components are radiated 

without particular control of the phase relation between them. Typically, the vertically and 

horizontally polarized sources may be displaced one from the other so that the resultant polarization varies 

between circular and slant, according to azimuth angle. 

H Horizontal linear: the electric field vector is in the horizontal plane. 

M Mixed: the collective term applied when both vertical and horizontal components are radiated, embracing 

slant, circular and dual polarization. 

SL Left hand slant: the electric field vector is in the plane rotated 45 degrees anti-clockwise from the vertical 

plane. 

SR Right hand slant: the electric field vector is in the plane rotated 45 degrees clockwise from the vertical plane. 

V Vertical linear: the electric field vector is in the vertical plane. 

L999 The electric field vector, observed in any fixed plane, normal to the beam axis, whilst looking in direction of 

propagation, remains in the direction specified by the angle measured anti-clockwise from a line parallel to 

the equatorial plane; the value of this angle follows the symbol L and is expressed in degrees from 0 to 359. 

X Other than above 

X X 

Antenna Gain M The ratio of the power required at the input of a loss-free reference antenna (gain reference antenna) to the power 

supplied to the input of the Antenna to produce, in the direction of maximum radiation, the same field strength, or 

the same power flux-density at the same distance. The gain may be considered for a specified polarization. 

X X 

Antenna Gain Type O Whether the Maximum Gain is relative to a dipole, an isotropic or a short vertical Antenna is determined by the X X 
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type of reference Antenna (e.g., dipole) used to determine the relative value of Antenna gain. A combo box to 

select one of following codes: 

I In case of dBi, respect to the isotropic antenna 

D In case dBd, gain respect to dipole antenna 

V In case of gain relative to the short dipole 

Antenna Directivity M A combo box to select one of the D, N or X representing directional, non-directional or revolving directional 

antenna respectively. 
X X 

Hor. Beam Width M The angular width of the main lobe of radiation in degrees, measured in the horizontal plane containing the 

direction of the Antenna's Maximum Gain, within which the off-axis gain in any direction does not fall more than 3 

dB below the value of the Antenna's Maximum Gain. 

X X 

Ver. Beam Width O The angular width of the main lobe of radiation in degrees, measured in the vertical plane containing the direction 

of the Antenna's Maximum Gain, within which the off-axis gain in any direction does not fall more than 3 dB 

below the value of the Antenna's Maximum Gain. 

X X 

Reference Antenna O The Code identifying a standard description of Antenna off-axis radiation characteristics. This information is 

optional and furnished when used as a basis to effect coordination with another administration. The information to 

be given in item should be the exact reference of the antenna appearing in the CCIR Book "Antenna Diagrams" 

(CCIR/78 or CCIR/84). For example one of the following: 

 Antenna Gain Equation (ref: 0642a): one or more mathematical expression(s) that define the gain 

characteristics of the antenna e.g., Radio Relay systems 1-40 GHz in Recommendation ITU-R  F.699-2; 

Equation; 

 Antenna Gain Polar Diagram (ref: 0642b): the graphical representation in polar form of an Antenna's gain 

against off-axis angle; Diagram; 

 ITU-R  Antenna Characteristic Code (ref: 0642c): a code identifying a standard description of antenna 

characteristics, e.g., in Recommendations ITU-R  BS.705-1 and ITU-R  BS.1195; Up to 10 characters; 

 Gain Value (ref: 0642d): the value of gain at the specified Off-axis Angle; Decimal (in the range 5.0 to 

50.0) to 1 decimal place in dB; and 

 Off-axis Angle (ref: 0642e): angle of the direction of the Gain Value, measured in the specified plane, from 

the direction of maximum gain in a clockwise direction; Integer (in the range 0 to 350 in multiples of 10) in 

degrees. 

X X 

Frequency range 

(from) 

O Antenna working frequency band lower edge 
X X 

Frequency range 

(to) 

O Antenna working frequency band upper edge 
X X 

Cross-polar 

discrimination 

O XPD value of antenna as defined in ITU-R P.310 
X X 

Insertion Loss O Summation of cable loss, branching loss and any other loss between the RF Sections and antenna. X X 
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As shown on Figure 4.31, some of the fields (e.g. Antenna Name, Polarization) are gray 

which means they are read only. This is done intentionally to prevent the data for antennas to 

be changed by mistake, because this information is very critical for all of the calculations in 

the system. 

As displayed in Figure 4.31, five push buttons “Modify”, “Cancel”, “Save”, “Library” and 

“Add to lib.” are available above the table. At the time of entering a new antenna or selecting 

from the library, the “Modify” push button is disabled. Mandatory fields (field names in 

bold) in the table of Antenna Information, must not be left blank otherwise an error message 

is displayed. Figure 4.32 shows the table of the Antenna catalogue (library). 

The “Add to lib.” button adds new antennas from “*.ant” files that are created by the 

technical module. After an antenna has been added to the library, it becomes available for 

selection in other data entry screens (e.g. new station). 

 

Figure 4.32. Spreadsheet of Antenna catalogue 

 
 

 New Frequency: This item defines a new frequency. Selecting this item creates a blank 

“Frequency Information” entry table in the right panel of the Administrative window and 

locks the tree view. The content of the Frequency Information entry table depends on the 

class of station defined in the higher (station) level. Table 4.15 displays the fields used in the 

entry table of Frequency Information for different classes of stations. Figure 4.33 illustrates 

the entry table for Frequency Information. 
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Table 4.15. Description the fields of Frequency Information entry table 

Field name Type Description 
Class of station 

FX BT FB BC ML 

Assigned Frequency M As defined in RR no. 1.148, the centre of the frequency band assigned to a station. X X X X X 

Vision Carr. Frequency M Vision carrier frequency of a TV signal in accordance with the plan  X    

Sound Carr. Frequency M Sound carrier frequency of a TV signal in accordance with the plan  X    

Response Frequency 
M 

The frequency paired with assigned frequency. Different frequencies mean duplex transmission 

while identical frequencies represent single-frequency radiocommunication. 
X    X 

Reference Frequency 
O 

As defined in RR no. 1.150, a frequency having a fixed and specified position with respect to 

the assigned frequency. 
X  X  X 

Frequency Range O The frequency range of radiocommunication equipment operation.   X  X 

Frequency Deviation 

O 

For any type of modulation, as applicable: the peak-to-peak frequency deviation (MHz). (See 

Recommendations ITU-R F.276-2 and ITU-R F.405-1, ITU-R F.275-3, ITU-R F.404-2 and 

ITU-R S.464-2). 

X     

Class of Emission 
M 

The set of characteristics of an emission, designated by standard symbols, as defined in RR no. 

1.139 and explained in RR Ap.1 
X X X X X 

Band Width M The necessary bandwidth of signal as defined in RR no. 1.152 X X X X X 

Channel Separation O Frequency distance between adjacent frequency channels X X X X X 

Channel no. O Channel number in frequency plan, if applicable X X X X X 

Traffic O Estimated minutes of channel use in day, if applicable X X X X X 

Peak Hour O The hour, or a time period within the operational period, having peak traffic X X X X X 

Season O A combo box to identify calendar  time period of operation X X X X X 

Nature of Service 

M 

A combo box to select the code indicating the purpose of the Radiocommunication Service as 

identified in Class Of Station and defined in the Radio Regulations in accordance with Preface 

to BR IFIC chapter IV, Section 6 

X X X X X 

Op. Hour (From) 

   & 

Op. Hour (to) 

M 

The time of day measured in UTC at which the transmission of the Signal usually commences 

and ends. Where a Start Time (Stop Time) is the same time (or later (earlier) time of day) as the 

Stop Time (Start Time), then the Stop Time is considered to be on the next calendar day, 

immediately following the Start Time. For the 24 hour operation use:  00:00   23:59 

X X X X X 

Frequency Fee M The fee that must be paid for use of the assigned frequency (usually for a given period of time) X X X X X 

Target Frequency O Required if the assigned frequency is to be modified and will be notified. X X X X X 

Type of Spectrum Mask O   X  X  

Frequency Offset O   X  X  
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As displayed in Figure 4.34, four buttons “Modify”, “Cancel”, “Save” and “Add Receiver” 

are available above the table. At the time of entering a new frequency, the “Modify” and 

“Add Receiver” push buttons are disabled. Mandatory fields (field names in bold) in the 

entry table of Frequency Information, must not be left blank, otherwise an error message will 

be displayed. 

 

Figure 4.33. Frequency Information entry table in case station in Fixed service 

 
 

Once the new frequency has been saved, the “Modify” and “Add Receiver” push buttons 

become active. However, for the “Add Receiver” push button to function, at least a 

transmitting antenna (the code “T” for Class of Antenna combo box in the relevant antenna 

information entry table) must have been created previously under the same Equipment. 

Then, by pushing “Add Receiver” button the “Add Receiver/Receiving area” dialogue box 

appears, which enables the user to choose the method of receiving and a transmitting antenna 

if more than one transmitting antenna exists for the corresponding Equipment. Figure 4.34 

shows this dialogue box. 
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Figure 4.34. Add Receiver/Receiving Area dialogue box to define method of receiving 

 
 

As illustrated in Figure 4.34, after selection of a transmitter antenna from the “Transmitting 

Antenna” table, one of the three receiving methods: POINT, MULTIPOINT or CIRCLE 

must be selected according to the following description: 

- POINT: A method to define a point–to–point radiocommunication link from the 

transmitter of the selected frequency to one of the available receiving stations listed 

in the table POINT. The listed stations are those receiving stations (stations with the 

code “R” or “C” for their Class of Antenna combo box in Antenna Information entry 

table) created under the active license; 

- MULTIPOINT: A method to define the shape of receiving area using a polygon 

with up to six vertexes. The coordinates of the polygon vertexes can be entered into 

the corresponding table of MULTIPOINT Section; 

- CIRCLE: A method to define a circular receiving area with a given radius. The 

coordinates of the centre of the circular receiving area are relaxed to permit the user 

to define an off-station coverage area. 

- ZONE: A method to define a zone as receiving area.  

Upon pressing OK button of this dialogue box, SMS4DC creates a “Receiver 

Information” table in the right panel of the Administrative window which is not editable. 
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The content of the Receiver Information table depends on the receiving method selected 

in the “Add Receiver/Receiving area” dialogue box. Table 4.16 describes the fields 

displayed in the table of Receiving Information. Figure 4.34 shows these tables. 

 

Table 4.16. Description the fields of Receiver Information entry table (1) , (2) 

Field name Type Description 
Method 

P M C Z 

Station Name M Name of receiving station X    

GeoType O POINT, MULTIPOINT, CIRCLE, ZONE X    

Latitude M Latitude of receiving station X    

Longitude M Longitude of receiving station X    

Country O Country where the station is situated X    

Equipment Name O Name of receiving equipment X    

Frequency M Receiving frequency  X    

Long. And Lat. 

Of up to 6 points 
M 

Longitude and latitude for a maximum of six 

points to construct a polygon 

 X   

Centre Latitude M Latitude of centre of circular receiving area   X  

Centre Longitude M Longitude of centre of circular receiving area   X  

Radius M Radius of circular receiving area in km   X  

Zone M Code of Zone    X 

(1): M: Mandatory,  O: Optional,  P: Point – to – point,  M: Multipoint,  C: Circle, Z: Zone 

 

Figure 4.35. Receiver Information table in three different kinds 

 

 

 

 

 

 

 

              (b) Circular receiving area 
                   (a) Table of point receiver information 

 

 

 

 

 

 

 

                                                          (c) Multipoint receiving area 
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For definition of point–to–multipoint radiocommunication systems, a multiple receiver can 

be added to a transmitting frequency, using POINT receiver option in “A Receiver/Receiving 

Area” dialogue box. 

 

4.11. The level of Frequency 

The level of Frequency is placed between the equipment level and the Receiver level. Each 

frequency may be used by several receivers. Selection of a frequency in tree view, by a mouse click 

or other action, displays the corresponding Frequency Information table in the right panel of the 

Administrative window. The content of the Information table can be modified, saved or and action 

cancelled using the “Modify”, “Save” or “Cancel” push buttons above the table, if the relevant 

license has not been granted. During a modification, the tree view in the left panel of the 

Administrative window will be locked and, when saving a modified table, mandatory fields (field 

names in bold) must not be left blank, otherwise an error message is displayed. The content of the 

frequency table is different for different classes of station and is described in Table 4.15. Each 

frequency under a specific equipment has a unique value and could have an unlimited number of 

receivers. 

The “Add Receiver” button above the Frequency Information entry table enables the user to attach 

additional receivers to the concerned transmitting frequency. The use of this button is explained in 

Section 4.6.1. A new frequency for the concerned equipment can be defined through the “New 

Frequency” item of the context menu in Equipment level (Section 4.6.1). 

 

4.11.1. Context menu in the level of Frequency 

A right click on the level name opens a context menu containing: “Modify”, “Delete”, “TX Filter”, 

“RX Filter” and "Coordination" items. The following is a description of these items: 

 Modify: This item modifies the content of the Frequency Information table, if has not been 

included previously in any granted license.  During a modification, the tree view in the left 

panel of the Administrative window will be locked and, when saving a modified table, 

mandatory fields (field names in bold) must not be left blank, otherwise an error message 

will be displayed. The content of the Frequency Information table for different classes of 

stations is described in Table 4.15. 

 Delete: This item deletes the frequency information and all other attached information in the 

lower level of the tree view, if has not been included in any granted license. Granted licenses 

cannot be deleted.  

 TX Filter: This item displays or defines a transmitting emission mask for the concerned 

transmitting frequency. Selecting this item opens a dialogue box for entering emission mask 

attenuation data in up to 20 off-centre frequencies. Prior to displaying the dialogue box, a 

warning message will be generated to remind the user that an emission mask is lacking and 

an emission mask has not been defined previously. The shape dialogue box is identical to 

Figure 4.36 except blue is used as the fill-colour inside the emission mask. Attenuation 

values in the table must be positive and the refresh button is necessary to reflect any change 

of values to the mask picture in the right panel. Using the Save button assigns the defined 

emission mask to the concerned transmitting frequency. 

 RX Filter: This item displays or defines a receiving emission mask for the concerned 

receiving frequency. Selecting this item opens a dialogue box to enter emission mask 

attenuation data in up to 20 off-centre frequencies. Prior to displaying the dialogue box, a 
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warning message will be generated to remind the user that an emission mask is lacking and 

an emission mask has not been defined previously. Figure 4.36 displays the relevant dialogue 

box. Attenuation values in the table must be positive and the refresh button is necessary to 

reflect any change of values to the mask picture in the right panel. Using the Save button 

assigns the defined emission mask to the concerned receiving frequency. 

 Coordination: This item displays or defines the list of country/administration codes which 

are under process of coordination, together with the results of the coordination. 

 

Figure 4.36. Dialogue box for definition of transmitting frequency emission mask 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

4.12. The level of Antenna 

The level of Antenna is placed below the level of equipment and there are no lower levels. Each 

antenna can be chosen for the transmitting or receiving of frequencies assigned to the same 

equipment by using “Add Receiver/Receiving Area” dialogue box, as explained in Section 4.6.1. 

Selection of an antenna in the tree view, by a mouse click or other action, displays the corresponding 

Antenna Information entry table in the right panel of the Administrative window. The content of the 

Information table can be modified, saved or any action cancelled using the “Modify” and “Save” or 

“Cancel” buttons above the table, if the relevant license has not been granted. In the case of 

modification, the tree view in the left panel of the Administrative window will be locked and 

mandatory fields (field names in bold) must not be left blank, otherwise a warning message will be 

displayed. The content of the antenna table is described in Table 4.14. 

The “Library” push button above the Antenna Information entry table enables user to use the library 

to attach an antenna to the corresponding equipment. Using of this button is explained in Section 

4.6.1. The New antenna for the concerned equipment can be defined through the “New Antenna” 

item of the context menu in Equipment level (Section 4.6.1).  

 

4.12.1. Context menu in the level of Antenna 

A right click on the level name opens a context menu containing the “Modify”, “Delete” and 

“Antenna Pattern” items. The following is a description of these items: 

 Modify: This item modifies the content of the Antenna Information table if has not been 

included previously in any granted license. During a modification, the tree view in the left 
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panel of the Administrative window will be locked and, when saving a modified table, 

mandatory fields (field names in bold) must not be left blank, otherwise an error message 

will be displayed. The content of the Antenna Information entry table for different classes of 

stations is described in Table 4.14. 

 Delete: This item deletes the antenna information, if has not been included in any granted 

license. Granted licenses cannot be deleted.  

 Antenna Pattern: This item displays antenna 2D radiation patterns in vertical and horizontal 

planes for horizontally or vertically polarized antennas and two horizontal planes for mixed-

polarized antennas. Figure 4.37 illustrates the 2D radiation pattern of a directional antenna. 

 

Figure 4.37. The 2D radiation pattern of a directional antenna in the vertical and horizontal plans 
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4.13. The level of Receiver 

The level of Receiver is placed below the frequency level and is the lowest level. The method of 

receiving can be determined for a given transmitting frequency in same License by using the “Add 

Receiver/Receiving Area” dialogue box, as explained in Section 4.6.1. Modification of the Receiver 

Information table is not possible directly from the Receiver level and the user has to redefine the 

method of receiving in frequency level using the “Add Receiver” button for the corresponding 

Frequency Information table. The relevant procedure is explained in Section 4.6.1. 

 

4.13.1. Context menu in the level of Receiver 

A right click on the level name opens a context menu containing only the item “Delete”. This item 

deletes the receiving method information. The content of the Receiver Information table for 

different classes of stations is described in Table 4.16. 

 

4.14. The level of Allotment 

The level of allotment is placed between the license level and the contour level. Each allotment may 

consist of several contours as sub-areas.  Selection of an allotment in the tree view by a mouse click 

or other action, displays a table of the corresponding Allotment Information in the right panel of the 

Administrative window. The content of the Information table can be modified, saved or any action 

cancelled using the “Modify” and “Save” or “Cancel” buttons above the table. During a 

modification, the tree view in the left panel of the Administrative window will be locked and, when 

saving a modified table, mandatory fields (field names in bold) must not be left blank, otherwise an 

error message is displayed. The contents of the allotment Information table are described in 

Table 4.2. Each allotment has a unique name and could have an unlimited number of contours. 

 

4.14.1. Context menu in the level of Allotment 

A right click on the level name opens a context menu containing the items: “Modify”, “Delete”, 

“New Contour”, "Attach Contour" and “Electronic Notice”. The following is a description of these 

items: 

 Modify: This item modifies the content of an Allotment Information table.  During a 

modification, the tree view in the left panel of the Administrative window will be locked 

and, when saving a modified table, mandatory fields (field names in bold) must not be left 

blank, otherwise an error message is displayed. The content of the Allotment Information 

table is described in Table 4.2. 

 Delete: This item deletes the allotment and all other attached information in the lower levels 

of the tree view.  

 New Contour: This item defines a new sub-area and attaches it to the current allotment. 

Selection of this item creates a blank “GE06 contour information” entry table in the right 

panel of the Administrative window and locks the tree view. Figure 4.38 illustrates the entry 

table of contour information and Table 4.17 shows the fields used in the table.  
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Figure 4.38. GE06 contour information entry table 

 

 

Table 4.17. Description of fields in the table of Contour Information 

Field name Type Description 

Administration M Administration Code 

Country M Country Code 

No. of points M Number of points in the contour 

Remarks O  

(1) : M: Mandatory, O: Optional 

 

 Attach Contour: This item selects a contour from the list of existing contours in the system 

and attaches it to the selected allotment. By performing this item all contours are tabulated in 

a spreadsheet for user selection. A mouse left click can be used for selection of contours 

from the spreadsheet. Pressing the OK button under the spreadsheet inserts the selected 

contour under the corresponding allotment in tree view. 

 Electronic Notice: This item generates, saves and displays the appropriate electronic notice 

to notify the allotments to ITU BR. As required by the specification, SMS4DC is able to 

generate GS2 and GT2 electronic notices for allotments. Depending on the notice type, 

SMS4DC displays the appropriate type electronic notice and provides options in the relevant 

dialogue box. The user must complete all the mandatory fields in the consequent levels of 

the tree view otherwise, the notice form will not be generated and an error message will be 

displayed.  

 

4.15. The level of Contour 

The level of contour is placed below the level of allotment. Each contour may consist of several 

points as a sub-area.  Selection of a contour in the tree view by a mouse click or other action, 

displays a table of the corresponding contour information in the right panel of the Administrative 

window. The content of the Information table can be modified, saved or cancelled using the 

“Modify” and “Save” or “Cancel” buttons above the table. During a modification, the tree view in 

the left panel of the Administrative window will be locked and, when saving a modified table, 

mandatory fields (field names in bold) must not be left blank, otherwise an error message is 

displayed. The contents of the contour information table are described in Table 4.17. Each allotment 

has a unique ID and could have an unlimited number of points. 
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4.15.1. Context menu in the level of Contour 

A right click on the level name opens a context menu containing the items: “Modify”, “Delete”, 

“New Contour”, "Attach Contour" and “Electronic Notice”. The following is a description these 

items: 

 Modify: This item modifies the content of the contour information table.  During a 

modification, the tree view in the left panel of the Administrative window will be locked 

and, when saving a modified table, mandatory fields (field names in bold) must not be left 

blank, otherwise an error message is displayed. The content of the contour information table 

is described in Table 4.17. 

 Delete: This item detaches the contour from this allotment. This item does not delete the 

contour from database so it remains accessible for attachment to other allotments.  

 Contour Points: This item views or defines all of the points for this new sub-area.  

 Electronic Notice: This item generates, saves and displays an appropriate electronic notice to 

notify the sub-areas to the ITU BR. As required by the specification, SMS4DC is able to 

generate GA1 electronic notice for contours. The user must complete all the mandatory 

fields in the consequent levels of tree view, otherwise the notice form will not be generated 

and an error message will be displayed. 
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Chapter 5. Technical Reference of SMS4DC 
 

 

 

 

5.1. BC to BC interference calculation procedure 

Figure 5.1.  displays the configuration used in the item “Interference->BC2BC” (Section 3.4.2.13) 

for calculation of interference from an unwanted sound broadcasting stations to a typical receiver of 

a wanted sound broadcasting station. 

 

Figure 5.1. Configuration used for calculation 

 of interference from an unwanted BC stations to a typical receiver of a wanted BC station 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The nuisance field strength of the ith interfering broadcasting station, , is calculated taking into 

account several factors using the formula:  

  dB 

Where: 

 The field strength value ith interfering broadcasting station in dB(V/m), based on 

recommendation ITU-R P.1546 and normalized to the e.r.p. of 1 kW, exceeded 

during T percent of time  

 e.r.p. (in dB(1 kW)) of the ith interfering broadcasting station in the direction of test 

point receiver 

 Radio frequency protection ratio (in dB) given in recommendation ITU-R BS.412-9 

 Discrimination factor of the receiving antenna given in recommendation ITU-R 

BS.599  

iSE

PriitiS DAAEPE 

itE

P

iA

rA

Interferer 

BC station 

Wanted 

BC station 

Interferer 

BC station 

 

Interferer 

BC station 

 

Test 

Poi

nt 

Typical 

receiver 



 
301 

 Polarization discrimination which will be taken into account if polarization of the 

wanted station and interferer station antennas are orthogonal 

 

Appropriate account can be taken of the effect of multiple interferers by the use of the simplified 

multiplication method, as a statistical computation method, or the power sum method as a non-

statistical computation method. For more information see Report 945-2. 

 

5.2. BT to BT interference calculation procedure 

The item “Interference->BT2BT” (Section 3.4.2.13) is designed for the calculation of the aggregate 

interference level of interfering BT stations on a directional receiver of a wanted BT station. 

Figure 5.2 displays the configuration used for the calculation of interference from an unwanted 

sound broadcasting stations to a typical receiver of a wanted sound broadcasting station. 

 

Figure 5.2. Configuration used for calculation 

 of interference from unwanted BT stations to a typical receiver of a wanted BT station 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

The nuisance field strength of the ith interfering broadcasting station,  is calculated, taking into 

account several factors, using the formula: 

  dB 

Where: 

 The field strength value of the ith interfering broadcasting station in dB(V/m), based 

on ITU-R P.1546 recommendation and normalized to the e.r.p. of 1 kW, exceeded 

during T percent of time  

 e.r.p. (in dB(1 kW)) of the ith interfering broadcasting station in the direction of test 

point receiver 

 Radio frequency protection ratio (in dB) given in recommendation ITU-R BT.655-7 

for the case of co-channel and upper/lower adjacent channels 
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 Discrimination factor of the receiving antenna given in ITU-R BT.419-3 

recommendation  

 Polarization discrimination which will be taken into account if polarization of wanted 

station and interferer station antennas are orthogonal 

 

Appropriate account can be taken of the effect of multiple interferers by the use of the simplified 

multiplication method as a statistical computation method, or the power sum method as a non-

statistical computation method. For more information see Report 945-2. 

 

5.3. Interference between stations in the Fixed and Land mobile services 

The sub item “FXM->Interference to (Free Space and P.1546)” in the “Interference” menu (Section 

3.4.2.13.1) has been implemented for the calculation of interference produced/experienced by 

stations in the land mobile service (any frequency) and the fixed service (below 1GHz) on each 

other by consideration of receiving antenna radiation pattern. For all cases, the configuration 

displayed in Figure 5.3 is used for the interference calculation. 

 

Figure 5.3. Configuration used for the calculation 

 of interference between a wanted and an interferer station in the fixed and mobile services  

 

 

 

 

 

 

The field strength level E of an interferer station on a wanted receiving station, is calculated by 

either the Free Space (ITU-R P.525) or ITU-R P.1546 propagation models. A station may be 

considered as having interference if E is greater than the reference field strength value  where 

 is: 

  dB 

Where: 

 Maximum permissible interference field strength 

 Receiver antenna gain 

 Discrimination factor of the receiving antenna (positive value) 

C 2.1 for e.i.r.p power type otherwise is zero 

 The correction factor for the permissible interference field strength at different 

nominal frequencies based on the Berlin Agreement, Annex 3A 

 

5.4. Interference between stations in the Fixed service above 1 GHz 

The item “Interference->FX2FX” (Section 3.4.2.13) has been implemented to calculate interference 

between fixed above 1GHz in accordance with recommendation ITU-R P.452 by consideration of 

the antenna patterns and the Net Filter Discrimination (NFD). The configuration used for the 
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interference calculation is displayed in Figure 5.3 above. The interference level I caused by an 

interfering fixed station is calculated using: 

  dB 

 

where: 

 Propagation loss calculated based on Rec. P. 452 in dB 

 Transmitter antenna gain in direction of receiver in dB 

 Receiver antenna gain in direction of transmitter in dB 

NFD Net Filter Discrimination in dB, calculated using TX and RX emission masks 

 Transmitter power 

N Noise power ( ) 

 Polarization Discrimination in dB which will be taken into account when polarization 

of wanted and interferer station antennas are orthogonal  

 

In addition to the interference level I , caused by an interfering fixed station, which may be 

compared with a reference acceptable interference level; the permissible Threshold Degradation of a 

receiver could be used to identify an occurrence of interference. The Threshold Degradation of the 

victim receiver can be calculated as follow: 

 

Where symbols I and N are defined above. 

A station may be considered as having interference if the Threshold Degradation is greater than 

Permissible Threshold Degradation. 
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Chapter 6. Functional Reference of SMS4DC 
 

 

6.1. Establishing a station 

As explained in Section 3.5, in terms of SMS4DC notation and irrespective of the kind of 

radiocommunication service, a radiocommunication station may be classified into one of the types: 

anonymous, active or archived. Anonymous stations are those created visually, on a map display, by 

using a mouse and the toolbar buttons, as explained in Section 3.4.1. Stations created in this way 

may be transferred to active licenses, as explained in Section 4.4.1. Figure 3.41 and Figure 3.48 

provide the relevant entry masks. Furthermore, if a license has been created, the user may also 

employ the Administrative Section of SMS4DC to establish a station. Establishing 

radiocommunication stations under active licenses is explained in Section 3.4.1. 

Stations of cancelled licenses are those stations covered by archived licenses. Information about 

archived stations may be reviewed but without any functionality (read only). 

 

6.2. Finding a station 

The capabilities provided by the items of the “Database” menu enable the user to find anonymous 

and active stations in the following cases: 

 Finding stations by name: the user may use items “Display Selected Station(s)” and 

“Station(s) in Desktop” to find and display station(s) by name. Further explanation is given 

in Section 3.4.2.8. 

 Finding stations by location and/or frequency condition: the sub-items “Search Station->By 

Location”, “Search Station->By Location and Frequency” and “Search Station->List of 

Listed  Station(s)” of “Database” menu provide a range of facilities to search for a station or 

group of specific stations. 

   

6.3. Changing the DEM map 

In addition to the integrated vector maps and Globe DEM installed with SMS4DC, users are 

able to define two additional user-defined DEMs through the sub-items “Tools->Map 

Layers->UserMap1” and “Tools->Map Layers->UserMap2”. Each DEM consists of a “layer 

description text file” and a folder containing the files of the digital map tiles. These 

explanatory text files have the reserved names: Globe.txt, UserMap1.txt and UserMap2.txt. 

They are responsible for the layer description of maps used in the three sub-items and are 

stored in the folder “…\SMS4DC\Texts”. The format of these files is explained in Annex 1. 

An example for the numbering of map-tile files is shown in Figure 1.3. 

 

6.4. Restoring the database from a backup 

 On a regular basis, the local database of SMS4DC should be saved in the folder 

“…\SMS4DC\DB”. The command “Database->Backup” generates a single backup mdb file 

with the name SMS-Newyyymmdd.mdb. This file is saved in a user-defined location, or, into 

the path “…\SMS4DC\BackUp” by default. The following instructions explain the procedure 

for restoring backup database file: 

1. Delete “yyymmdd” part of the backup filename; 
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2. Copy mdb file into the folder “…\SMS4DC\DB” 

 

6.5. Path profile extraction 

SMS4DS can display path profiles along straight lines or polylines following a direct command or 

indirectly, in the context of other functions, such as field strength calculations: 

a) Draw a line or polyline using one of the toolbar buttons “Draw Line”, “Draw Polyline” or 

“Draw Line from Database” as explained in Section 3.4.1. 

b) Use the “Draw Profile” button (Section 3.4.1) or one of the items provided in the “Profile” 

menu, as explained in Section 3.4.2.7. 

 

6.6. New antenna definition 

The item “Tools->Antenna Editor”, described in Section 3.4.2.5.1, provides an interface to define 

the radiation pattern and characteristics of a new antenna. Also, changing an existing antenna name 

to a new name and saving it, will create a new antenna. Therefore, users may create a new antenna 

by modification of characteristics of an existing antenna with similar characteristics. Information 

about each antenna is stored in a file in the folder “…\SMS4DC\Antenna” and the format of file is 

explained in the Annex 2. 

 

6.7. User account management 

The nature of spectrum management implies that different users will need to be given different 

levels of access permission to the SMS4DC features and database. Therefore, six different access 

levels are provided for the SMS4DC software and these are explained in Section 3.2. Among these 

six different access levels, only the system supervisor, as administrator, is allowed to define and 

cancel User-ID and Passwords for other users through the “Database–>Users” item. Figure 3.2 

displays the menu of User-ID and Password management. Full description of user accounts is 

explained in Section 3.2. Moreover, the history of the actions taken by different users is logged by 

an audit-trail system which can be reviewed through the item: “Database->Audit Trail” (Section 

3.4.2.8).  

 

6.8. Importing information published by the ITU-BR 

Information of two types of periodic BR-Publications can be imported into the local database of 

SMS4DC. The items: “Database->Import from BR IFIC (Terrestrial Services)” and “Database-

>Import from BR IFIC (Space Services)” (Section 3.4.2.8) are able to query the information on the 

BR-IFIC terrestrial database and space BR-IFIC database, respectively. The BR-IFIC Terrestrial 

database contains a list of notified terrestrial stations and the BR-IFIC /space BR-IFIC contains a list 

of notified earth stations. If either of these databases is to be available for SMS4DC use, they must 

be installed prior to the installation of SMS4DC.  

 

6.9. Field strength calculation 

This item in the menu “Propagation Models” (Section 3.4.2.9) enables the user to calculate field-

strength along a line, poly-line, inside a selected rectangular area and at end-points of a link. The 

field strength calculation may use free-space, LOS (line of sight), ITU-R recommendation P.1546, 

ITU-R recommendation P.370, Okumura-Hata, ITU-R recommendation P.526 (considering both 

diffraction and smooth earth models separately), ITU-R recommendation P.452 and ITU-R 
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recommendation P.530 propagation models. Two types of network processing sub-items have 

developed under the free-space, ITU-R recommendation P.370, ITU-R recommendation P.1546 and 

Okumura-Hata propagation models. Moreover, in this menu, an item is available for calculation of 

the Earth-space path loss, using the ITU-R recommendation P.618 propagation model. The sub-

items implemented for these propagation models are summarized in Table 3.2. 

 

6.10. Modification of a frequency allocation 

The Frequency Allocations menu (Section 3.4.2.11) provides the user with the regional and national 

frequency allocations table (FAT), frequency allocations chart, national frequency assignment plans 

and frequency assignment utility. 

The “Frequency Allocations->Draw Chart” “Edit” menu provides three powerful items: “Plan”, 

“Service Table” and “Footnotes” to edit the content of the frequency allocations table and change 

chart colours. Using the “Plan” item, the user is able to browse and edit the content of integrated 

FATs, with up to six primary services and up to six secondary services. Figure 3.87 shows the 

relevant dialogue box and browsing toolbar. A full description of the implemented features is 

available in Section 3.4.2.11. 

 

6.11. Addition of footnotes 

All footnotes to the tables of frequency allocations are accessible through the item “Frequency 

Allocations->Draw Chart->Edit->Footnote”. This item provides the user with a facility for footnote 

modification or definition. Figure 3.89 displays the footnote editor dialogue box. The user may type 

free-form footnote text in any one of the Windows supported languages. 

Furthermore, users are able to add more footnotes to the footnote list of the active FAT. A 

description of the browsing toolbar, integrated with the footnote editor dialogue box, is given in 

Table 3.4. The new footnotes can be assigned to the sub-bands of FAT using the item “Frequency 

Allocations->Edit->Plan” (see Figure 3.87). A full description of the implemented features is 

available in Section 3.4.2.11. 

 

6.12. Definition and modification of frequency arrangements 

SMS4DC is able to accept all types of frequency arrangements. The item “Frequency Allocations-

>Frequency Arrangement” enables users to browse, define and print a report of national frequency 

arrangement plans. These plans may have one of three formats; homogeneous, uniform and non-

uniform. A full description of the implemented features is available in Section 3.4.2.11. 

Moreover, a complete list of all assignable frequencies, from all the frequency arrangement plans, 

can be viewed using the item “Frequency Allocations->Frequency Table”. 

 

6.13. Frequency assignment 

SMS4DC is powered by an advanced method of frequency assignment to a concerned station (in the 

Fixed, Land Mobile or Broadcasting services), based on interference calculations to/from any other 

stations (in these services) in a given frequency band inside a circular search area. This procedure is 

implemented in the item “Frequency Allocations->Frequency Assignment” and is started by 

choosing a national station to which a frequency is to be assigned and terminates by selecting one of 

the frequencies that, after comprehensive interference analysis, has been suggested as suitable for 

assignment. These frequencies are listed in a table of assignable frequencies (Figure 3.92) that meet 
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the overall user–defined assignment conditions. Multiple frequency assignment is supported for a 

single station. A full description of procedures implemented is available in Section 3.4.2.11. 

In addition to the feature described above, there are other parts of SMS4DC software which, 

indirectly, assist in the task of frequency assignment. For example, items provided in the 

“Coordination” menu permit the user to assess the availability of a frequency with respect to the 

other stations in neighbouring counties, in accordance with the procedures of a regional plan. 

Section 3.4.2.12 describes the implementation of procedures for regional plans in the 

“Coordination” menu.  

The Interference menu is also another powerful tool provided by SMS4DC for the calculation of 

interference between terrestrial (Fixed, Land Mobile or Broadcasting) services and between 

terrestrial services and Earth stations in the space radiocommunication service. Section 3.4.2.13 

explains the relevant items. 

 

6.14. Interference calculation 

Interference calculations of SMS4DC are implemented in the “Interference” menu for several types 

of wanted-victim stations configuration (Section 3.4.2.13). Interference calculation procedures are 

provided in this menu for the following situations: BC - BC (FM sound broadcasting stations), BT - 

BT (TV broadcasting stations), FX – FX (point to point hops), FX – FX (fixed stations on each 

other), ES - ES (earth stations), ES - FX and FX – ES. 

 

6.15. Billing in SMS4DC 

Since no harmonized procedure for frequency fee calculation has been adopted yet by the ITU 

member administrations, SMS4DC provides the user with a procedure for the management of 

regular payments of frequency-fees. As shown in Figure 4.28, for each radiocommunication license, 

the “Billing History” level in the administrative hierarchy deals with frequency fees. Section 4.9 

explains the method for keeping a billing history of licenses. 

 

6.16. Importing a vector file and depicting on map 

The item “Vectors->Draw from File” is designed to load a vector file from memory and display it on 

the DEM. The format of vectors in SMS4DC is explained in Annex 2. By selection of this item 

SMS4DC requests the user to select a vector file from the relevant folder on the hard disk. Then, 

vector colour and fill style must be defined using the displayed dialogue box. Further description of 

this item is presented in Section 3.4.2.10. Additional vector functions are available in “Vectors” 

menu. 

 

6.17. Production of BR electronic notices 

The item “Notice” in the context menu of level of Earth Station and the item “Electronic Notice” in 

the context menu of level of Station are designed to generate ITU-BR electronic notice forms. If the 

user has completed all the mandatory fields of these notices, they will be ready for submission to the 

ITU. Section 4.5.1 and Section 4.8.1 explains the procedures for producing electronic notices for 

Earth stations and terrestrial stations respectively. For terrestrial stations, the following notice forms 

may be generated: T01, T02, TB1, TB2, TB3, TB4, TB5, T11, T12, T13, T14, G11, G12, G13, G14, 

GA1, GB1, GS1, GS2, GT1, GT2 and G02. 

 



 
308 

6.18. Customization of SMS4DC 

In line with the ITU recommendations, publication circulars, SMS4DC requirements and experience 

gained globally; SMS4DC software has been developed to fulfil the daily needs of administrations 

in performing the technical and administrative tasks of spectrum management. Therefore, it is 

deemed to comply with the professional objectives of a Spectrum Management System for 

developing countries. However, technical staff of the ITU may provide the following customization 

services at the request of administrations: 

o Migration of an existing national electronic database of frequency assignment into 

the local database of SMS4DC; 

o Developing national reports and radio frequency license  printouts; 

o Integration of the national frequency allocations table (N-FAT); 

o Development of more administrative / technical features by individual request; 

o Personal training of local experts in the application and administration of SMS4DC. 
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Annex 1 - Database Manager 

 

Entering the existing data to SMS4DC is usually a time consuming and error prone job. In order to 

facilitate this process, a tool is provided separately to the SMS4DC package to the users requiring it. 

As each user has its own unique data structure and format, a database container in Microsoft Access 

format is defined and in which the user should put his data in the defined format. This container 

database is called ImportTemplate.mdb and can be found in the DB folder of the SMS4DC 

installation. It contains five tables which are linked together with some key data items (Following 

Figure). 
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As shown in the structure of the container, there are so many data items in those five tables. There 

are two fields named “Flag” and “Status” which are common in all tables. These two fields should 

be left empty by the user as the import tool uses these fields to communicate the import result and 

problems with the user. All other fields should be filled according to the requirements in the 

following table: 

Table Field Type Description 

Owner 

ID Long integer Unique ID of each Owner 

AdmName Text Name of the Owner authority 

Address Text Address of the Owner authority 

City Text City of the Owner authority 

Country Text Country code of the Owner authority (Annex 1) 

Telephone Text Telephone of the Owner authority 

Fax Text Fax of the Owner authority 

Email Text Email of the Owner authority 

AddrCode Text  

BillName Text Name of the Owner billing authority 

BillAddress Text Address of the Owner billing authority 

License 

LicID Long integer Unique ID of each License 

AdmID Long integer The ID of its corresponding owner in the Owner 

table 

LicNo Text Number of license given by the Administration 

OpDate Date Date of beginning of operation of this license 

ExpDate Date Expiring date of this license 

SrvID Text Code of the radiocommunication service of this 

license (one of these values): 

- B: broadcasting 

- F: fixed 

- MT: land mobile 

InvPeriod Text Invoicing period (one of these values): 
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- Monthly 

- Bi-monthly 

- Quarterly 

- Annually 

InitFee Long integer Licensing fee 

Station 

StID Long integer Unique ID of the station 

LicID Long integer ID of its corresponding license in the License table 

AdmRefID Text ID given to this assignment by the Administration 

SiteName Text Station name 

ClassStation Text Class of station (one of these values): 

- BC: sound broadcasting station (broadcasting 

service) 

- BT: television broadcasting station 

(broadcasting station) 

- FB: fixed base station (land mobile service) 

- FX: fixed station (fixed service) 

- ML: mobile station (land mobile service) 

ITURegion Integer ITU-R region code (one of these values): 

1 

2 

3 

GeoLat Double Latitude of the geographical coordinates 

GeoLon Double Longitude of the geographical coordinates 

Country Text Administration code (Annex 1) 

Radius Long integer Radius of the service area (in kilometers) 

HeightASL Long integer Height of the station above sea level (in meters) 

VehModel Text Model of the vehicle having mobile station 

VehPlate Text Plate number of the vehicle having mobile station 

VehColor Text Color of the vehicle having mobile station 

Plan Text Fragment or Plan of the frequency assignment 
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- Article 11 

- Geneva 1984 

- Geneva 1989 

- Geneva 2006A 

- Geneva 2006D 

- Geneva 2006L 

PlanEntry Integer Plan Entry Code (refer to Geneva 2006 Plan) 

AssignCode Text Assignment Code (refer to Geneva 2006 Plan) 

AssocAllotID Text Associated Allotment ID (refer to Geneva 2006 Plan) 

AssocAllotSFN Text Associated Allotment SFN (refer to Geneva 2006 

Plan) 

SFNID Text SFN ID (refer to Geneva 2006 Plan) 

Transmitter 

ID Long integer Unique ID of the record 

TXID Long integer ID of the related station in the Station table 

EqName Text Equipment Name 

Pwr2Ant Double Power to Antenna 

PowerType Text Power Type 

RadPwr Double Radiated Power 

RadPowerType Text Type of Rad. Power 

MaxPowDens Double Maximum Power Density 

MadeBy Text Manufacturer 

Model Text Model 

SerialNo Text Serial no. 

OsetV12 Long integer Vision Carr. Freq. Offset 

OsetV Long integer Vision Carr. Freq. Offset (kHz) 

OsetS12 Long integer Sound Carr. Freq. Offset 

OsetS Long integer Sound Carr. Freq. Offset (kHz) 
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TranSys Integer FM transmission system 

TVSys Text TV System 

ColorSys Text Color System 

ERP_h_dbw Double Max. erp of the horiz. polarized component 

ERP_v_dbw Double Max. erp of the vert. polarized component 

ERP_dbw Double Max. Overall erp in horiz. plane 

PwrRatio Double Power Ratio 

Sensitivity Double Sensitivity 

FreqStabl Text Frequency stability 

RefPlanCfg Text  

SysVar Text  

RXMode Text  

ERPTilt Double ERP Beam Tilt dbw 

SystemType1 Text  

SystemType2 Text  

Frequency Double Assigned Frequency 

RespFreq Double Response Frequency 

EmissionCl Text Class of Emission 

BandWidth Double Band Width kHz 

NatServ Text Nature of Service 

HourFrom Text Op. Hour (From) 

HourTo Text Op. Hour (To) 

AntName Text Antenna Name 

Azimuth Double Azimuth of Maximum Radiation 
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AzimTo Double Rot. Azimuth (to) 

Elevation Double Elevation 

AntHeightAGL Double Antenna Height AGL 

Receiver 

ReceiverID Long integer Unique ID of the receiver 

GeoType  Type of geographic area (POINT, CIRCLE, 

MULTIPOINT or ZONE) 

TXID  ID of the related transmitter in the Transmitter table 

RXID  Reserved for future use 

RecLat  Latitude of the receiver (decimal) 

RecLon  Longitude of the receiver (decimal) 

Radius  Radius of the receiving area (km) 

Country  Country code of the receiver 

Lat1  Latitude of the first vertex of the receiving polygon 

Lon1  Longitude of the first vertex of the receiving polygon 

Lat2  Latitude of the second vertex of the receiving 

polygon 

Lon2  Longitude of the second vertex of the receiving 

polygon 

Lat3  Latitude of the third vertex of the receiving polygon 

Lon3  Longitude of the third vertex of the receiving 

polygon 

Lat4  Latitude of the fourth vertex of the receiving polygon 

Lon4  Longitude of the fourth vertex of the receiving 

polygon 

Lat5  Latitude of the fifth vertex of the receiving polygon 

Lon5  Longitude of the fifth vertex of the receiving polygon 
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Lat6  Latitude of the sixth vertex of the receiving polygon 

Lon6  Longitude of the sixth vertex of the receiving 

polygon 

NoiseTemp  Noise temperature (degree Kelvin) 

Zone  3 letter code of the receiving zone 

 

In order to begin the import process, it is recommended to copy the ImportTemplate.mdb to another 

folder and fill this copied database file (e.g. Import.mdb) with the data that you wish to import. By 

doing this you will keep the original ImportTemplate.mdb untouched and you can use it again for 

your future import tasks. It is very important to create the antenna file for each antenna used in the 

Transmitter table. These antenna files should be created by SMS4DC and be copied in the Antenna 

folder of the SMS4DC installation. 

When the data is completely and correctly placed in the Import.mdb then you need to execute the 

DBManager.exe which can be found in the BIN folder of the SMS4DC installation. The following 

screen may appear after the execution of this tool. 

 

You may press the “Data Import” button and the following screen will appear. 
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Now the database containing the import data should be selected (Import.mdb in our example). By 

pressing the “Validate the data” button the validity of the database and the data entered in each table 

and each record is checked and a report will be shown on the screen. Of course the Flag and Status 

fields in each table will show the reason for possible validation errors. 

There might be major or minor errors in the data. In case of major errors, the validation check will 

be aborted and it is not possible to import the data. The problems should be solved externally and 

the validation check should be performed again. The following screen shows an example of such 

situation. 
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In case of minor errors, a warning message will be shown but it is possible to continue importing the 

validated information. The following shows an example of this situation. 
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After successful validation of the data, by pressing “Begin Import” the import process will begin. 

Related to the number of records in the import database, this process may be lengthy and needs 

several minutes to finish. When finished, an activity report will be shown on the screen as shown 

below. 
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The import tool will not let importing the data twice. The following message will be shown if an 

already imported database is chosen. 
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This tool makes a backup copy of the main database of SMS4DC in the BACKUP folder of the 

SMS4DC installation directory, before each import. In case you need to revert the import changes 

back, please refer to the BACKUP folder and check the time and date stamp of the database files for 

the desired backup version. Then you simply need to copy the backed up file to the DB folder and 

rename it to SMS-NEW.mdb. 
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Annex 2 - Formats 

 

Map formats 

The key information of 3D digital raster map tiles, integrated into the SMS4DC software by default, 

is stored in the file Globe.txt. The content of this information file is as following: 

 

Item in file Description Example in Globe.txt 

FilesPath  Location of tiles file C:\bdt_soft\SMS4DC\globe\ 

FilesPerfix  Prefix used to save tiles, i.e. globe_01_01.dat globe 

Lower_left_x  Longitude of lower left of whole map (tile 

01_01) in degrees 
-179.995833333333334 

Lower_left_y  Latitude of lower left of whole map (tile 

01_01) in degrees 
-89.995833333333334 

Resolution_x  Resolution along equator in degrees 0.00833333333334 

Resolution_y  Resolution along meridians in degrees 0.00833333333334 

Number_pixel_x  Number of pixels along x of each tile 600 

Number_pixel_y  Number of pixels along y of each tile 600 

AreaExtendX  Not used 0 

AreaExtendY  Not used 0 

Nxmax  Number of tiles along x (parallel to the 

equator) 
72 

Nymax  Number of tiles along y (parallel to the 

meridians) 
36 

NoDara  Void pixels -500 

Precision  Number of bits used for saving each value in 

files 
int16 

MachineFormat  The format applied to the precision for saving 

values 
L 

MapType  Type of map Topo 

 

Vector file formats 

The format of vectors in SMS4DC is a simple two column table, saved in ASCII format in the txt 

files. Each row of the table, represents the longitude and latitude of each vertex of vector and the 

consequent vertexes appear in consequent rows of the table. The end point of vectors is 

distinguished by the row “NaN NaN”, otherwise consequent rows will be connected together. 
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Antenna file formats 

Antenna radiation patterns are held in text files (ASCII files with *.ant file name) containing 

following information: 

 

Item Description Example 

Name Antenna name V886_dat 

Gain_dBi Antenna gain in dBi 15.000000 

BeamWidth_H Horizontal 3dB beamwidth of antenna 36.000000 

BeamWidth_V Vertical 3dB beamwidth of antenna 39.000000 

Frq_Lo Lower edge of antenna working frequency band 886.000000 

Frq_Hi Upper edge of antenna working frequency band 896.000000 

Frq_unit A code presenting frequency unit MHz 

Polarization A code to indicate the polarization of antenna. V 

Pattern A 360x3 matrix containing attenuation values (in dB) of 

2D patterns in horizontal and vertical planes. First 

column is the angle for which the attenuation values are 

given in the second/third columns for the horizontal and 

vertical planes. 

0      0.0162   20.424 
1      0.0813   20.719 
 :       :                  : 
359  0.0166   20.542 
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Annex 3 - References 
 

ITU–R Recommendations 

BS.412-9: Planning standards for terrestrial FM sound broadcasting at VHF 

BS.599: Directivity of antennas for the reception of sound broadcasting in band 8 

(VHF) 

BS.1195: Transmitting antenna characteristics at VHF and UHF 

BT.419-3: Directivity and polarization discrimination of antennas in the reception of 

television broadcasting 

BT.470: Conventional analogue television systems 

BT.655: Radio-frequency protection ratios for AM vestigial sideband terrestrial 

television systems interfered with by unwanted analogue vision signals and 

their associated sound signals 

F.699: Reference radiation patterns for fixed wireless system antennas for use in 

coordination studies and interference assessment in the frequency range from 

100 MHz to about 70 GHz 

P.310: Definitions of terms relating to propagation in non-ionized media 

P.370-7: VHF and UHF propagation curves for the frequency range from 30 MHz to 

1 000 MHz 

P.452-15: Prediction procedure for the evaluation of interference between stations on the 

surface of the Earth at frequencies above about 0.1 GHz 

P.453-9: The radio refractive index: its formula and refractivity data 

P.525-2: Calculation of free-space attenuation 

P.526-8: Propagation by diffraction 

P.527-3: Electrical characteristics of the surface of the Earth 

P.529-3: Prediction methods for the terrestrials land mobile service in the VHF and 

UHF bands 

P.530-15: Propagation data and prediction methods required for the design of terrestrial 

line-of-sight systems 

P.618: Propagation data and prediction methods required for the design of Earth-

space telecommunication systems 

P.676-5: Attenuation by atmospheric gases 

P.836-3: Water vapour: surface density and total columnar content 

P.837-4: Characteristics of precipitation for propagation modelling 

P.838-2: Specific attenuation model for rain for use in prediction methods 

P.841-4: Conversion of annual statistics to worst-month statistics 

P.1546-5: Method for point-to-area predictions for terrestrial services in the frequency 

range 30 MHz to 3 000 MHz 

P.1812-3 A path-specific propagation prediction method for point-to-area terrestrial 

services in the VHF and UHF bands 
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S.456: Reference Earth-Station Radiation Pattern for use in Coordination and 

Interference Assessment in the Frequency Range from 2 to about 30 GHz 

SF.1006: Determination of the Interference Potential between Earth Stations of the 

Fixed-Satellite Service and Stations in the Fixed Service 

SM.1048: Design guidelines for a basic automated spectrum management system 

(BASMS) 

SM.1049-1: A  Method  of  Spectrum  Management  to  be  used  for  Aiding Frequency 

Assignment  for  Terrestrial  Services  in  Border  Areas 

SM.1370-1: Design guidelines for developing advanced automated spectrum management 

systems 

SM.1413-1: Radiocommunication Data Dictionary for notification and coordination 

purposes (2003 & Oct. 2004) 

SM.1448: Determination of the Coordination Area around an Earth Station in the 

Frequency Bands Between 100 MHz and 105 GHz 

SM.1604: Guidelines for an upgraded spectrum management system for developing 

countries (2003) 

 

BR Circular Letters 

CR/120: Forms of notice and formats for electronic notification of VHF/UHF 

television and VHF sound broadcasting assignments 

CR/118: Forms of notice and file formats for electronic notification of frequency 

assignments to stations in the fixed, mobile and other terrestrial services 

(excepting the broadcasting service in the LF/MF and VHF/UHF bands) 

CR/261: File formats for submission of electronic notices related to assignments of 

terrestrial services other than broadcasting in the planning area and bands 

governed by the Regional Agreement relating to the planning of the digital 

terrestrial broadcasting service in Region 1 (parts of Region 1 situated to the 

west of meridian 170E and to the north of parallel 40S, except the territory of 

Mongolia) and in the Islamic Republic of Iran, in the frequency bands 174 

230 MHz and 470-862 MHz 

CR/262: File formats for submission of electronic notices related to analogue and 

digital broadcasting assignments/allotments for the application of Articles 4 

and 5 of the Regional Agreement GE06 

CR/264: Updates regarding the contents of the BR International Frequency Information 

Circular (BR IFIC) for Terrestrial Services 

CR/270: Guidelines for submission of electronic notices related to assignments of 

terrestrial services other than broadcasting in the planning area and bands 

governed by the Regional Agreement Geneva 2006 
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Regional agreements 

Berlin Agreement: Agreement between the Administrations of Austria, Belgium, the Czech 

Republic, Germany, France, Hungary, the Netherlands, Croatia, Italy, 

Liechtenstein, Lithuania, Luxembourg, Poland, Romania, the Slovak 

Republic, Slovenia and Switzerland on the co-ordination of frequencies 

between 29.7 MHz and 39.5 GHz for the fixed service and the land mobile 

service. Berlin, 28 November 2003 

ST61: Regional agreement for the European broadcasting area 

GE84: Regional Agreement relating to the Use of the Band 87.5 – 108 MHz for FM 

Sound Broadcasting (Region 1 and part of Region 3) (revised 2006) 

GE89: Regional Agreement (Geneva, 1989) Relating to the Planning of VHF/UHF 

Television Broadcasting in the African Broadcasting Area and Neighbouring 

Countries (revised 2006) 

GE06: Regional Radiocommunication Agreement (Geneva, 2006) for planning of the 

digital terrestrial broadcasting service in parts of Regions 1 and 3, in the 

frequency bands 174-230 MHz and 470-862 MHz 

 

Other documents 

Preface to the BR International Frequency Information Circular (Terrestrial Services), 

English Edition BR IFIC 2609 

 

Description of the ORM-Interface, Monitoring Software R&S ARGUS, Version 5.3 

3030.6512.42 

 

Description of the SMDI-Interface, Monitoring Software R&S ARGUS, Version 5.2 

3030.6529.42 

 

Spectrum Monitoring Interface Specifications, ESMERALDA, Version 46 250 391 10 - 506 
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After Sale Service 

 

 In order to facilitate the SMS4DC operations, ITU provides backstopping to the SMS4DC 

licensees. This support service includes: 

 Answers/solutions to questions/problems with respect to installation, operation and 

maintenance of the SMS4DC.  

 Provision of SMS4DC's new versions/patches (free of charge)  

 Assistance for integration of high resolution maps provided by concerned users, to the 

SMS4DC. 

 

In this connection ITU has established an expert group team which can be reached through phone 

call/e-mail and if needed by undertaking ITU missions to the requested countries.  

 

 

For further questions and inquiries please contact: 

  

  

 E-mail: SMS4DC@itu.int 

 


